




Introduction (English)
This Concise User’s Guide introduces the main features
of your computer. The English version of this guide be-
gins on page 1. The expanded User’s Manual is on the
Device Drivers & Utilities + User’s Manual CD-ROM.

Einführung (Deutsch)
Dieses Ausführliche Benutzerhandbuch führt Sie in die
Hauptfunktionen des Notebooks ein. Die deutsche Versi-
on des Handbuchs beginnt auf Seite 43. Das erweiterte
Benutzerhandbuch finden Sie auf der CD-ROM für die
Gerätetreiber und Hilfsprogramme (CD-ROM Device
Drivers & Utilities + User's Manual).

Présentation (Français)
Ce Guide Utilisateur Concis présente les fonctionnalités
principales de votre ordinateur. La version française de
ce guide commence à la page 85. Le Manuel de l'Utilisa-
teur étendu se trouve sur le CD-ROM de Pilotes & Utili-
taires + Manuel de l'Utilisateur (CD-ROM Device
Drivers & Utilities + User's Manual).

Introducción (Español)
Esta Guía del Usuario Concisa le presenta las caracterís-
ticas principales de su ordenador. La versión española de
esta guía comienza en la página 127. El Manual del usua-
rio completo se encuentra en el CD-ROM de Controla-
dores del dispositivo y Utilidades + Manual del usuario
(CD-ROM Device Drivers & Utilities + User's Manual).

Introduzione (Italiano)
La presente Guida Rapida per l'Utente introduce le carat-
teristiche principali del computer. La versione italiana di
questa guida inizia da pagina 169. Il Manuale utente
completo si trova nel CD contenente driver e utilità +
Manuale utente (CD-ROM Device Drivers & Utilities +
User's Manual).
I
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Notice
The company reserves the right to revise this publication or to change its contents without notice. Information con-
tained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any sub-
sequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this
publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this pub-
lication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted
or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this pub-
lication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks
of their respective companies. They are mentioned for identification purposes only and are not intended as an endorse-
ment of that product or its manufacturer.
© March 2008

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents
and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copy-
right protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited
viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is
prohibited.

Intel, Celeron and Intel Core are trademarks/registered trademarks of Intel Corporation.
Notice - 1
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About this Concise User Guide
This quick guide is a brief introduction to getting your system started. This is a supplement, and not a substitute for
the expanded English language User’s Manual in Adobe Acrobat format on the Device Drivers & Utilities + User’s
Manual CD-ROM supplied with your computer. This CD-ROM also contains the drivers and utilities necessary for
the proper operation of the computer. 

Some or all of the computer’s features may already have been setup. If they aren’t, or you are planning to re-configure
(or re-install) portions of the system, refer to the expanded User’s Manual. The Device Drivers & Utilities + User’s
Manual CD-ROM does not contain an operating system.

Regulatory Information
Regulatory notices and information are contained in the expanded User’s Manual on the Device Drivers & Utilities
+ User’s Manual CD-ROM.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the Wireless LAN, Blue-
tooth and 3.5G modules are OFF if you are using the computer aboard aircraft.
2 -  About this Concise User Guide
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Instructions for Care and Operation
The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

• Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
• Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. 

This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
• Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong mag-

netic fields. These can hinder proper performance and damage your data.
• Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to 

save your work. Remember to periodically save your data as data may be lost.
• Take care when using peripheral devices.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the com-
puter to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power sup-
ply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord is damaged or frayed.
• If the computer has been exposed to any liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
Instructions for Care and Operation - 3
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Power Safety
The computer has specific power requirements:

• Only use an AC/DC adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. 

If you are unsure of your local power specifications, consult your service representative or local power company.
• The AC/DC adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety fea-

ture; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies.

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. Do not use volatile (petroleum distillates) or
abrasive cleaners on any part of the computer.

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals
and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the ma-
chine on.

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a note-
book which is powered on in a travel bag may cause the vent(s) to be blocked. To prevent your computer from overheating make
sure nothing blocks the vent(s) while the computer is in use.
4 -  Instructions for Care and Operation
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. 

Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may pos-
sibly result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under
various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid
waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the man-
ufacturer. Discard used battery according to the manufacturer’s instructions.
Instructions for Care and Operation - 5
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Model Differences
This notebook series includes four different model types (each model includes different design styles). The exact out-
ward appearance and some of the Hot-Key buttons may appear slightly different from those illustrated in this manual,
however all the ports, components and functions etc. are the same for each design style. The models differ as indicated
in the table below.

Table 1 - Model Differences

Feature Model A Model B Model C Model D

Core Logic SiS M672 + SiS968 SiS M671DX + SiS968

Video Adapter SiS Integrated Video (Internal On Chip) NVIDIA Discrete Video (External On Board)

AC/DC Adapter 65W (DC Output 19V, 3.42A or 18.5V, 3.5A) 90W (DC Output 19V, 4.74A)

LCD Type 14.1" WXGA/ WXGA+ 
Glare Type TFT LCD

15.4" WXGA/ WXGA+/ 
WSXGA + Glare Type 

TFT LCD

14.1" WXGA/ WXGA+ 
Glare Type TFT LCD

15.4" WXGA/ WXGA+/ 
WSXGA + Glare Type 

TFT LCD

Fingerprint 
Reader No No Option Option
6 -  Instructions for Care and Operation
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and 

connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other hand (as 

illustrated in Figure 1) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
6. Press the power button to turn the computer “on”.

Figure 1 - Openning the Lid/LCD/Computer with AC/DC Adapter Plugged-In

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the Lock
Button Menu in Windows Vista. This will help prevent hard disk or system problems.
System Startup - 7
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System Software
Your computer may already come with system software
pre-installed. Where this is not the case, or where you are
re-configuring your computer for a different system, you
will find this manual refers to the Microsoft Windows
Vista operating system. Further information on installing
the drivers and utilities is available in Chapters 4 & 7 of
the expanded User’s Manual on the Device Drivers &
Utilities + User’s Manual CD-ROM.

Operating Systems Supported

Not Included
Operating Systems (e.g. Windows Vista/Windows XP)
and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please
consult the appropriate manuals.

Drivers

If you are installing/re-installing new system software, you
will need to install the appropriate drivers. Drivers are pro-
grams which act as an interface between the computer and
a hardware component e.g. a wireless network module. It is
very important that you install the drivers in the order listed
in Table 6 on page 22. You will be unable to use most ad-
vanced controls until the necessary drivers and utilities are
properly installed.

Operating 
System Note

Windows XP 
(Home Edition or 

Professional)

For information on the Windows XP 
OS see the Device Drivers & Utilities + 
User’s Manual CD-ROM.

Windows Vista 
with Service 

Pack 1 (64-bit)
Home Basic/

Home Premium/
Business/
Enterprise/

Ultimate Editions

Make sure you install Windows Vista 
Service Pack 1 (or a Windows Vista 
version which includes Service Pack 1) 
before installing any drivers. Go to 
the Microsoft website for download 
details, or contact your service center.

In order to run Windows Vista without 
limitations or decreased performance, 
your computer requires a minimum 
1GB of system memory (RAM).
8 -  System Software
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System Map: Front View with LCD Panel 
Open - Models A & C

Figure 2
Front View with LCD 

Panel Open
(Models A & C)

1. Built-In PC Camera 
(Optional)

2. LCD
3. Speakers
4. Power Button
5. Hot-Key Buttons
6. Keyboard
7. Built-In Microphone
8. Touchpad & Buttons
9. Fingerprint Module 

(Optional for Models 
C & D Only)

10. LED Indicators

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard air-
craft is usually prohibited. Make
sure the wireless modules are
OFF if you are using the com-
puter aboard aircraft.

Use the key combinations to tog-
gle power to the 3.5G/WLAN/
Bluetooth modules, and check
the LED indicator icon to see if the
modules are powered on or not
(see Table 5 on page 13/
Table 3 on page 11).

2

5

1

7

8

4

6

9

33

10 10
System Map: Front View with LCD Panel Open - Models A & C - 9
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System Map: Front View with LCD Panel 
Open - Models B & D

Figure 3
Front View with LCD 

Panel Open
(Models B & D)

1. Built-In PC Camera 
(Optional)

2. LCD
3. Speakers
4. Power Button
5. Hot-Key Buttons
6. Keyboard
7. Built-In Microphone
8. Touchpad & Buttons
9. Fingerprint Module 

(Optional for Models 
C & D Only)

10. LED Indicators

Wireless Device 
Operation Aboard Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually prohib-
ited. Make sure the wireless
modules are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the 3.5G/
WLAN/Bluetooth modules,
and check the LED indicator
icon to see if the modules are
powered on or not (see Table 5
on page 13/ Table 3 on
page 11).

2

5

1

7

8

4

6

9

33

10 10
10 -  System Map: Front View with LCD Panel Open - Models B & D
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LED Indicators
The two sets of LED indicators (LED Status Indicators
and LED Power & Communication Indicators) on the
computer display helpful information about the current
status of the computer.

Table 2 - LED Status Indicators Table 3 - LED Power & Communication Indicators

Icon Color Description

Green Hard Disk Activity

Green Number Lock (Numeric Keypad) 
Activated

Green Caps Lock Activated

Green Scroll Lock Activated

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Green The (optional) Wireless LAN 
Module is Powered On

Orange The (optional) Bluetooth 
Module is Powered On
LED Indicators - 11
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Hot-Key Buttons & Keyboard
The Hot-Key buttons give instant access to the default In-
ternet browser and e-mail program, and allow you to tog-
gle the Silent Mode on/off with one quick button press.

Table 4 - Hot-Key Buttons

*When enabled, Silent Mode will reduce fan noise and
save power consumption. Note this may reduce computer
performance.

The keyboard has a numeric keypad for easy numeric

data input, and features function keys to allow you to
change operational features instantly.

Figure 4 - Keyboard

Hot-Key Button Function

Activate the Default E-Mail Browser

 Activate the Default Internet Program

Toggle *Silent Mode (for power sav-
ing)

KeypadFunction Keys

Numeric Keypad

Fn Key

NumLk & 

3.5G 
ScrLk

Module
Power
Toggle

Special Characters

Some software applications allow the number-keys to be
used with Alt to produce special characters. These special
characters can only be produced by using the numeric key-
pad. Regular number keys (in the upper row of the key-
board) will not work. Make sure that NumLk is on.
12 -  Hot-Key Buttons & Keyboard
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the hot key utility is in-
stalled (see “Hot-Key” on page 23). After installing the driver an icon  will appear in the taskbar.

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F8/F9 Brightness 
Decrease/Increase

Fn +  3.5G Module 
Power Toggle Fn + F10 PC Camera Power 

Toggle

Fn + F1 TouchPad Toggle Fn + F11 WLAN Module 
Power Toggle

Fn + F2 Turn LCD Backlight Off (Press a key to or use 
TouchPad to turn on) Fn + F12 Bluetooth Module 

Power Toggle

Fn + F3 Mute Toggle Fn + NumLk Number Lock (Numeric Keypad) Toggle

Fn + F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle

Fn +
F5/F6

Volume Decrease/
Increase Silent Mode Toggle

Fn + F7 Display Toggle Table 5 - Function Keys & Visual Indicators
Hot-Key Buttons & Keyboard - 13
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System Map: Front & Left ViewsFigure 5
Front & Left Views

1. LED Indicators
2. DC-In Jack
3. External Monitor Port
4. RJ-45 LAN Jack
5. Vent
6. 2 * USB 2.0 Ports
7. ExpressCard/54(34) 

Slot
8. 7-in-1 Card Reader

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / 

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

1

2 54
6

3
76 8

Front

Left
14 -  System Map: Front & Left Views
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System Map: Right & Rear Views Figure 6
Right & Rear Views

1. S/PDIF-Out Jack
2. Microphone-In Jack
3. Headphone-Out Jack
4. USB 2.0 Port
5. Optical Device Drive 

Bay
6. Emergency Eject Hole
7. RJ-11 Phone Jack
8. Security Lock Slot
9. BatteryChanging DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional
code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD
(e.g. due to an unexpected power inter-
ruption) you may push the end of a
straightened paper clip into the emer-
gency eject hole. Do not use a sharp-
ened pencil or similar object that may
break and become lodged in the hole. 

Media Warning

Don’t try to remove a floppy disk/CD/
DVD while the system is accessing it.
This may cause the system to “crash”.

Right

Rear

1 52 4

9

3 6 7 8
System Map: Right & Rear Views - 15
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System Map: Bottom View
Figure 7

Bottom View

1. Battery
2. Bluetooth Module Cover 
3. RAM & CPU Bay Cover
4. Vent
5. Hard Disk Bay Cover 
6. 3.5G USIM Card 

Location

Battery Information

Always completely discharge, then
fully charge, a new battery before
using it. Completely discharge and
charge the battery at least once ev-
ery 30 days or after about 20 partial
discharges.

CPU

The CPU is not a user serviceable
part. Accessing the CPU in any way
may violate your warranty.

Overheating

To prevent your computer from
overheating make sure nothing
blocks any vent while the computer
is in use.

2

3

1

4

4

5
6

2

3

1

4

4

5
6

Models A & C 

Models B & D 
16 -  System Map: Bottom View
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive,
and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon , and
then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel
is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows
(e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however
many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 6 on page 22.
To see all controls it may be necessary to toggle to Classic View on.

Figure 8 - Start Menu & Control Panel

Click here to toggle Classic View 
Windows Vista Start Menu & Control Panel - 17
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Video Features
This computer features two different (either SiS for Models A & B or NVIDIA for Models C & D) video op-
tions. You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista and/or the SiS VGA Control Center/NVIDIA Control Panel.

To access Windows Vista Display Settings:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > 

Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 9 on page 19).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 9 on page 19).
5. Click Advanced Settings (button)  (Figure 9 on page 19) to bring up the Advanced Settings tabs.

To access the SiS VGA Control Center (Models A & B):
1. The SiS VGA Control Center can be accessed by right-clicking the SiSTray taskbar icon , and selecting Control Center 

(or from the SiS VGA Control Center in the Windows Control Panel).

To access the NVIDIA Control Panel (Models C & D):
1. The NVIDIA Control Panel can be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel (or from 

the NVIDIA Control Panel in the Windows Control Panel).

1
2

3
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Figure 9 - Display Settings & Control Center/Control Panel

21
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 17) allows you to
configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further
configuration options.

Figure 10 - Power Options
Note: Sleep is the default power saving state in Windows Vista
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Audio Features
You can configure the audio options on your computer from the Sound  control panel
in Windows, or from the Realtek HD Audio Manager /  icon in the taskbar/con-
trol panel (right-click the taskbar icon  to bring up an audio menu). The volume may
also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level is
set using the volume con-
trol within Windows (and
the volume function keys
on the computer). Click
the Volume icon in the
taskbar to check the set-
ting.

Figure 11
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
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Driver Installation
The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for the
proper operation of the computer. Insert the CD-ROM
and click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

Install the drivers in the order indicated in Table 6. Af-
ter installing each driver it will become grayed out (if you
need to reinstall any driver, click Unlock).

Manual Driver Installation
Click the Browse CD button in the Drivers Installer ap-
plication and browse to the executable file in the appro-
priate driver folder.

Windows Update
After installing all the drivers make sure you enable
Window Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

Table 6 - Driver Installation

Driver (Windows Vista with SP1) Page#

Video  page 23

Audio  page 23

Modem  page 23

LAN  page 23

TouchPad  page 23

CardReader  page 23

Hot-Key  page 23

PC Camera (Optional)  page 24

Wireless LAN (Optional)  page 27

3.5G Module (Optional)  page 29

Fingerprint Reader (Optional for Mod-
els C & D)

 page 33

Bluetooth (Optional)
Note: No driver installation required (see  page 35)

Enable Windows Update (see left)
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Video
1. Click 1.Install Video Driver > Yes.

Models A & B (SiS):
2. Click Yes (click Yes if you want to view the ReadMe 

file).
3. Click Yes to restart the computer.

Models C & D (NVIDIA):
4. Click Next.
5. Click Finish to restart the computer.

Audio
1. Click 2.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install Lan Driver > Yes.
2. Click Next.
3. Click Finish > Finish to restart the computer.
4. The network settings can now be configured.

TouchPad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click Finish > Restart Now to restart the computer.

CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Hot-Key
1. Click 7.Install HOTKEY Driver > Yes. 
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
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PC Camera
The PC Camera module uses the BisonCap application
to capture video files.

PC Camera Driver Installation
1. Turn on the module using Fn + F10 (the on-screen 

visual indicator  will briefly be displayed when 
the module is powered on).

2. Click Option Drivers (button).
3. Click 1.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the 

BisonCam shortcut on the desktop, or from the 
BisonCam item in the Start > Programs/All 
Programs menu (if the hardware is turned off use the 
Fn + F10 key combination to turn it on again).

PC Camera Audio Setup
If you wish to capture video & audio with your camera,
it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings 
and click Control Panel).

2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) 

and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the 

right-click menu).
6. Click Levels (tab), and adjust the Microphone and 

Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap program from the Start > Programs/

All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Microphone 

(Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture 

Audio (it should have a tick alongside it).

Latest PC Camera Driver Information

Check the Device Drivers & Utilities + User’s Manual disc,
and any accompanying insert pages, for the latest updated
information on the PC Camera driver, which may override
the information provided here.
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BisonCap
The BisonCap application is a video viewer useful for
general purpose video viewing and testing, and can cap-
ture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/
All Programs > BisonCam menu (it is recommended that 
you Set Capture File before the capture process - see 
“Set Capture File” below).

2. Go to the Capture menu heading (if you wish to capture 
audio check “PC Camera Audio Setup” on page 24) and 
select Start Capture.

3. Click OK (the file location will be displayed in the pop-up 
box) to start capturing the video, and press Esc to stop the 
capture (you can view the file using the Windows Media 
Player).

Set Capture File
Prior to capturing video files you may select the Set Cap-
ture File... option in the File menu, and set the file name
and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then
click Open, then set the “Capture file size:” and click
OK. You can then start the capture process as above.

Zoom
The BisonCap program allows you to zoom the camera
in and out.

1. Run the BisonCap program.
2. Go to Zoom and select ZoomOut/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.        
3. The picture (in JPEG format) will be placed in the 

Snapshot folder  on the desktop (do not move or 
rename the folder).
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap pro-
gram is flickering, you can try to adjust the setting in the
Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture 

Filter....
3. Click either 50Hz or 60Hz under Frequency in Property 

Page (tab).

Reducing Video File Size
Note that capturing high resolution video files requires a
substantial amount of disk space for each file. After re-
cording video, check the video file size (right-click the
file and select Properties) and the remaining free space
on your hard disk (go to Computer, right-click the hard
disk, and select Properties). If necessary you can re-
move the recorded video file to a removable medium e.g.
CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum
of 15GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended
that you save the captured video file to a location other
than the C: drive (see “Set Capture File” on page 25),
limit the file size of the captured video or reduce video
resolution.

To Reduce Video Resolution Output Size:
1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture 

Pin....
3. Click the Output Size drop box and select a lower 

resolution size in order to reduce the captured file size.
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Wireless LAN

Wireless LAN Driver Installation
1. Make sure the module is powered on.
2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to complete the installation.

Note: The operating system is the default setting for
Wireless LAN control in Windows Vista.

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect 
to a network (or right-click the icon , and then click 
Connect to a network).

2. In the Show list, click to choose Wireless from the drop-
down menu.

3. A list of currently available networks will appear.
4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click 

Set up a connection or network (a list of options will 
appear allowing manual searching, and creating a new 
network).

6. Move the cursor over the taskbar icon  to see the 
connection status.

7. To disconnect from the wireless network you can click the 
taskbar wireless icon , and then select Connect or 
disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click 
Disconnect from).

Power Toggle for the Wireless LAN Module

Enable power to the Wireless LAN module by using the
Fn + F11 key combination. When the Wireless LAN mod-
ule is powered on, the  LED will be green and the on-
screen visual indicator  will briefly be displayed.
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3.5G Module
If you have included an optional 3.5G module in your
purchase option, follow the instructions below to install
the USIM card (which will be provided by your service
provider), and then install the application.

1. Turn off the computer, and turn it over and remove the 
battery.

2. Locate the SIM card cover and loosen screw  in Figure 
12.

3. Remove the SIM card cover  in Figure 12.
4. Insert the USIM card as you would into your mobile phone.
5. Slide the SIMLOCK towards the hinge (in the opposite 

direction to the arrow illustrated in Figure 13) in order to 
release the lock and lift it up.

Figure 12 - SIM Card Cover Removal
6. Insert the USIM card as illustrated in (Figure 13) and 

close the SIMLOCK.
7. Lock the SIMLOCK by pushing it in the direction of the 

arrow in Figure 13 until it clicks into the lock position.
8. Replace the cover, screw and battery.

Figure 13 -  Insert the USIM Card & Lock the SIM-
LOCK

Power Safety Warning

Before you undertake any installation procedures, make
sure that you have turned off the power, and disconnected
all peripherals and cables (including telephone lines). It is
advisable to also remove your battery in order to prevent
accidentally turning the machine on.

1

2

2

1

28 -  3.5G Module



Concise User’s Guide

English
3G Watcher Application
With the 3.5G module and USIM card (provided by
your service provider) installed you may then install the
3G Watcher application. The 3G Watcher application
allows you to directly access your 3.5G internet service
from the computer.

3G Watcher Application Installation
1. Make sure you enable power to the module by pressing 

the Fn +  key combination (the on-screen visual indi-
cator  will indicate the module’s power status).

2. If a Found New Hardware wizard appears, click 
Cancel.

3. Click Option Drivers (button).
4. Click 3.3G Driver > Yes.
5. Click Next.
6. Click the button to accept the license agreement, and 

then click Install.
7. When the next screen appears wait about 2 minutes 

before clicking Finish (to allow the hardware to detect 
the 3.5G module).

8. The 3G Watcher icon  will appear on the desktop.
9. You can access the 3G Watcher application from the 

Start menu (Start > Programs/All Programs > Sierra 

Wireless > 3G Watcher), or by clicking the desktop 
icon .

Setting Up a Carrier Profile
Although the connection information is stored on the
USIM card supplied by the service provider, you will
need to set up the appropriate carrier profile from the 3G
Watcher software.
1. Power on the 3.5G module using the Fn +  key combi-

nation.
2. Access the 3G Watcher application from the Start menu 

(Start > Programs/All Programs > Sierra Wireless > 3G 
Watcher), or by clicking the desktop icon .

3. Click Tools and select Options.
4. Click Profiles and then click the Add new profile button 

, and select WWAN profile.

Figure 14 - Add WWAN Profile
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5. You can then enter a new profile name or choose a profile 
from the drop-down list provided by the software.

6. Click Apply > OK to save the information.
7. You can choose the profile from the pull-down menu.

Figure 15 - User Options and Choose Profile

Connecting to the Service Provider
1. Power on the 3.5G module using the Fn +  key combi-

nation.
2. You can access the 3G Watcher application from the Start 

menu (Start > Programs/All Programs > Sierra 
Wireless > 3G Watcher), or by clicking the icon .

3. The software will run and display the service provider name 
(connection information is obtained from the USIM card).

Figure 16 - 3G Watcher
4. Click Connect  to begin the connection process.
5. The 3G Watcher application will then display the 

connection information in the window.

Figure 17 - Connecting

Profile Details

If you have chosen the profile from the drop-down list then
most of the information in the General and Advanced
tabs should be automatically filled in for you (however
check with your service provider for the latest information
as you may at least need to add in your Username and
Password).
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6. When the connection is successful a taskbar notification 
will appear (as below).

Figure 18 - Connected Taskbar Notification
7. You can then access the internet, download e-mail etc. as 

per any internet connection.
8. While you are connected the taskbar icon will be green 

 (it will be red  when the program is running but not 
connected).

9. To disconnect click the Disconnect  icon.

Figure 19 - 3GWatcher Connected

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the 

Fn +  key combination.

12. If you click the 3G Watcher close icon  a message will 
be displayed asking you to click OK to confirm the 
program exit. 

Figure 20 - Exit Warning
13. Exiting the program DOES NOT turn off the 3.5G module, 

and you will need to press the Fn +  key combination to 
turn off the module (pay careful attention to this aboard 
aircraft - see “Wireless Device Operation Aboard 
Aircraft” on page 9).

14. If the module is on and the computer enters a power-
saving state, then the power status of the module on 
resuming from the power-saving state will be as below:

• If the 3.5G module is on and the computer is Shut 
Down or Restarted; the module will be off when the 
computer starts up.

• If the 3.5G module is on and the computer enters 
Sleep or Hibernate; the module will be off when the 
computer resumes from sleep.
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Short Messaging Service
In addition to standard internet services you may also
send and receive SMS text messages using the 3G
Watcher program.

1. The SMS message indicator  in the main window will 
notify you of any new messages received.

2. Double-click the icon  or select Tools > SMS Express.
3. Select the inbox folder and select any message to read it, 

or select File > New Message or click the New button to 
prepare a new message.

For more details on SMS see 3GWatcher Online Help
from the Help > Help Topics menu.

3G Watcher Online Help

For further details on the 3G Watcher application you can
access the Online Help from the Help > Help Topics menu.

Click on any topic from the Contents window to display de-
tails.
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Fingerprint Reader
If you have included the fingerprint reader (optional for
Models C & D only) in your purchase option you will
need to install the driver as per the instructions below. 

Make sure you have administrator’s rights to your com-
puter, and have a Windows password enabled for full se-
curity protection.

Before beginning the enrollment process it is recom-
mended that you go through the fingerprint tutorial. To
run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after in-
stalling the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual 

CD-ROM into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.FingerPrint > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

User Enrollment
1. Click Start > Programs/All Programs > Protector Suite 

QL > User Enrollment, or double click the taskbar icon 
.

2. On the first run of the program you will be asked to click 
the button to accept the license, and then click OK.

3. Click Next (“Enrollment to the hard disk” will 
automatically be selected), and click Finish.

Help & Manual

Right-click the taskbar icon  to bring up the menu to se-
lect Help.

Insert the Device Drivers & Utilities + User’s Manual CD-
ROM and click Option Drivers (button). Click Unlock
(button) and then click 4.FingerPrint > Yes.

Click Documentation to open the folder containing the
manual in .pdf format.

To install the Adobe Acrobat Reader software to read the file,
insert the Device Drivers & Utilities + User’s Manual CD-
ROM and click User’s Manual (button), and click Install
Acrobat Reader (button).
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4. If you have not set a Windows password you will be 
prompted to do so (note: If you have not set a password 
Protector Suite QL cannot secure access to your 
computer).

5. Click Next and you will then be prompted to enter your 
Windows password.

6. Click Next > Next (if you have the “Run interactive 
tutorial” tickbox selected you will run through the 
Fingerprint Tutorial).

7. Click Next for each window of the tutorial (you can click 
the button to “skip tutorial” at any time).

8. Click the button above any of the fingers to begin the 
enrollment process for that finger.

9. Swipe the finger three times to enroll that finger.
10. Repeat the process for all the fingers you wish to enroll, 

and then click Next.
11. Click Finish.
12. Click any of the headings under “Learn more about:” to 

get more information on any topic.
13. Click Close.
14. Restart the computer.
15. Right-click the taskbar icon  to bring up the menu that 

allows you to Edit Fingerprints, Start Control Center, 
access the Help menu etc. You can also run the Control 
Center etc. from the Protector Suite QL item in the 
Programs/All Programs menu.

16. See “Help & Manual” on page 33 for further details.
17. If you swipe your finger over the reader at any time you 

can access the Biomenu to lock the computer, register 
websites, open the Control Center and access the Help 
menu.

18. The Control Center allows you to change the Settings, 
enroll Fingerprints and get Help.

Figure 21 -  Control Center & Biomenu 

Fingerprint Enrollment

Note that it is strongly recommended that you enroll
more than one finger in case of injury etc.
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Bluetooth Configuration
Setup your Bluetooth Device so the 
Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your 

device documentation).

To Turn the Bluetooth Module on
1. Press the Fn + F12 key combination to power on the Blue-

tooth module. 
2. A Bluetooth icon  will appear in the taskbar (you may 

need to enable the option from the Bluetooth Devices 
control panel).

3. You can then do any of the following to access the 
Bluetooth Devices control panel.

• Double-click the icon  to access the Bluetooth Devices 
control panel.

• Click Start, and click Control Panel (or point to Settings 
and click Control Panel), and then click Bluetooth 
Devices (Hardware and Sound).

• Click/Right-click the icon  and choose an option from 
the menu.

Figure 22 - Bluetooth Devices & Click Icon Menu

To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth 

devices to connect to this computer check box 
(Connections) has a tick inside it.

3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.

Bluetooth Data 
Transfer

Note that transferring
data between the com-
puter and a Bluetooth
enabled device is sup-
ported in one direction
only (simultaneous
data transfer is not
supported).
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5. Click to select “My device is set up and ready to be 
found”, and then click Next.

Figure 23 - Add Bluetooth Device Wizard

6. The Wizard will then search for any available Bluetooth 
devices within range.

7. Select the device you want to communicate with, and click 
Next.

8. Select an appropriate passkey option and click Next > 
Finish.

Figure 24 - Passkey Option

To Change Settings for the Bluetooth 
Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click 

Properties to:

• Change the name of the device (click General, type a new 
name and click OK).

• Enable/Disable a service (click Services, tick/clear the 
check box next to the service and click OK).

To Make your Computer Discoverable 
to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth 

devices to find this computer check box (Discovery) 
has a tick inside it.

3. Make sure that Alert me when a new Bluetooth device 
wants to connect check box (Connections) has a tick 
inside it, if you want to be notified when a Bluetooth device 
wants to connect.

Figure 25 
Bluetooth 
Devices 
Options
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Troubleshooting
Problem Possible Cause - Solution

The Wireless LAN/
Bluetooth modules 
cannot be detected.

The modules are off. Check the LED indicator  to see if the WLAN/Bluetooth is on or off. If
the LED indicator is off, then press the Fn + F11 (WLAN) or Fn + F12 (Bluetooth) key
combination in order to enable the modules (see Table 5 on page 13).

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

A file cannot be copied to/
from a connected
Bluetooth device.

Transferring data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the
Bluetooth enabled device to your computer until the file transfer process from the computer has
been completed.

The captured video files 
from the PC Camera are 
taking up too much disk 
space.

Note that capturing high resolution video files requires a substantial amount of disk space for
each file.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive
system partition. It is recommended that you save the capture video file to a location other than
the C:drive, limit the file size of the captured video or reduce video resolution (Options > Video
Capture Pin... > Output Size). See “Reducing Video File Size” on page 26.
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Specifications

Feature Specification

Processor Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T8100/ T8300

45nm (45 Nanometer) Process Technology
3MB On-die L2 Cache & 800MHz FSB
2.1/ 2.4 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T9300/ T9500

45nm (45 Nanometer) Process Technology
6MB On-die L2 Cache & 800MHz FSB
2.5/ 2.6 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T7100/ T7250

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 800MHz FSB
1.8/ 2.0 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
T7300/ T7500/ T7700/ T7800

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 800MHz FSB
2.0/ 2.2/ 2.4/ 2.6 GHz

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds
and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check with your ser-
vice center for details.
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Intel® Celeron® M Processor
(478-pin) Micro-FCPGA Package, Socket P
530/ 540/ 550/ 560

65nm (65 Nanometer) Process Technology
1MB On-die L2 Cache & 533MHz FSB
1.73/ 1.86/ 2.0/ 2.13 GHz

Core Logic Models A & B:
SiS M672 + SiS968 Chipset

Models C & D:
SiS M671DX + SiS968 Chipset

LCD Options Models A & C:
14.1" WXGA/ WXGA+ Glare Type TFT LCD

Models B & D:
15.4" WXGA/ WXGA+/ WSXGA+ Glare Type TFT 
LCD

Video Adapter Models A & B:
SiS M672 Integrated Video (Internal On Chip)

High Performance 2D/3D Graphics Accelerator
Shared Memory Architecture (up to 256MB 
shared video memory dynamically allocated from 
system memory where needed)
Supports Microsoft DirectX 9.0
Supports Vertex Shader 2.0 and Pixel Shader 2.0

Models C & D:
NVIDIA GeForce 9300M GS Discrete Video (External 
On Board)

256MB of GDDR2 Video Memory On-Board
TurboCache™ Supporting Total Graphics 
Memory up to 512MB (depending on system 
memory)
Supports DirectX 10.0

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 667 MHz
Memory Expandable up to 4GB

Security Security (Kensington® Type) Lock Slot 
Fingerprint Reader Module (Factory Option - 
Models C & D)

BIOS Password

BIOS One 8Mb SPI Flash ROM Phoenix™ BIOS

Feature Specification
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Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page 42 for drive 
options)
Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD

Audio Intel High Definition Audio Compliant Interface
Compliant with Microsoft UAA (Universal Audio 
Architecture)
Direct Sound 3D™ Compatible

S/PDIF Digital Output
2 * Built-In Speakers
Built-In Microphone

Keyboard & 
Pointing Device

Winkey Keyboard Built-In TouchPad with Scrolling Function

Interface Three USB 2.0 Ports
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF Out Jack

One RJ-11 Modem Jack
One RJ-45 LAN Jack
One DC-in Jack
One External Monitor Port

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) 
Note: MS Duo/ Mini SD/ RS MMC Cards require a PC adapter

ExpressCard Slot One ExpressCard/34(54) Slot

Feature Specification
40 -  Specifications



Concise User’s Guide

English
Communication

*Note: The 
Bluetooth and 
3.5G Optional 
Modules cannot 
coexist. If one of the 
factory options is 
included in your 
purchase option, 
then the other is 
unavailable.

10Mb/100Mb Base-T Ethernet LAN 
56K MDC Modem, V.90 & V.92 Compliant
802.11 b/g USB Wireless LAN Module (Option) 
1.3M or 2.0M Pixel USB PC Camera Module (Factory Option)
*Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)
OR
*UMTS/HSPDA-based 3.5G Module with Mini Card Interface (Factory 
Option) 
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Power 
Management

Supports ACPI 3.0

Power Models A & B:
Full Range AC/DC Adapter
AC Input: 100 - 240V, 50 - 60Hz
DC Output: 19V, 3.42A or 18.5, 3.5A (65 Watts)

Models C & D:
Full Range AC/DC Adapter
AC Input: 100 - 240V, 50 - 60Hz
DC Output: 19V, 4.74A (90 Watts)

6 Cell Smart Lithium-Ion Battery Pack, 14.8V/4.0AH OR 4.4AH
9 Cell Smart Lithium-Ion Battery Pack, 14.8V/7.2AH (Option)

Environmental 
Spec

Temperature
Operating:    5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Feature Specification

UMTS Modes

Note that UMTS modes
CAN NOT be used in
North America.
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Dimensions 
& Weight

Models A & C:
336mm (w) * 250mm (d) * 24.8 - 35.7mm (h)
2.2 kg With 6 Cell Battery

Models B & D:
359mm (w) * 268mm (d) * 24.8 - 37mm (h)
2.5 kg With 6 Cell Battery

Optional

*Note: The 
Bluetooth and 
3.5G Optional 
Modules cannot 
coexist. If one of the 
factory options is 
included in your 
purchase option, 
then the other is 
unavailable.

Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
Super Multi Drive Module

802.11 b/g USB Wireless LAN Module

9 Cell Smart Lithium-Ion Battery Pack

1.3M or 2.0M Pixel USB PC Camera Module 
(Factory Option)

Fingerprint Reader Module (Factory Option - 
Models C & D)

*Bluetooth 2.0 + EDR (Enhanced Data Rate) Module 
(Factory Option)
OR
*UMTS/HSPDA-based 3.5G Module with Mini Card 
Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 
MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Feature Specification

UMTS Modes

Note that UMTS modes CAN NOT be
used in North America.
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Hinweis
Das Unternehmen behält sich das Recht vor, diese Publikation ohne Vorankündigung zu überarbeiten und den Inhalt zu
verändern.  Alle enthaltenen Informationen sind nur Anhaltspunkte und stellen keine Verpflichtung seitens des Herstellers
oder Wiederverkäufers dar. Sie übernehmen weder Verantwortung oder Haftung für mögliche Fehler oder Ungenauigkei-
ten dieser Publikation  noch sind sie in irgendeiner Weise verantwortlich für Verluste oder Schäden aus der Nutzung (oder
fehlerhaften Nutzung) dieser Publikation.
Die Publikation und alle beiliegende Software darf nicht, ganz oder in Teilen, ohne vorheriges Einverständnis des Verkäu-
fers, Herstellers oder Autors dier Publikation reproduziert, übersetzt, übertragen oder in maschinenlesbare Form umgewan-
delt werden, abgesehen von Kopien, die für Archivzwecke erstellt werden.
In dier Publikation erwähnte Marken- und Produktnamen können Copyrights und/oder eingetragene Warenzeichen ihrer
jeweiligen Firmen in. Sie werden nur zu Identifikationszwecken erwähnt und sind nicht als Werbung für die Produkte oder
ihre Hersteller gedacht.

© März 2008

Warenzeichen
Dies Produkt beinhaltet durch Urheberrechte geschützte Technologie, die durch Ansprüche bestimmter US-Patente und an-
dere geistige Eigentumsrechte geschützt ist, welche der Macrovision Corporation und anderen Rechtsbesitzern gehört. Die
Verwendung dier durch Urheberrechte geschützten Technologie muß von der Macrovision Corporation genehmigt werden
und dient nur für den Heimgebrauch bzw. andere beschränkte Ansichtszwecke, wenn nicht anderweitig von der Macrovi-
sion Corporation genehmigt. Reverse Engineering oder Auseinandernehmen ist untersagt.

Intel, Celeron und Intel Core sind warenzeichen/eingetragenes warenzeichen der Intel Corporation.
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Über das Ausführliche Benutzerhandbuch
Diese Kurzanleitung soll einen Überblick über die Schritte geben, die dazu notwendig sind, das System zu starten. Dieses
ist nur eine Ergänzung und kein Ersatz für das erweiterte englischsprachige Benutzerhandbuch, das auf der mitgelieferten
CD-ROM Device Drivers & Utilities + User's Manual im Adobe-Acrobat-Format vorliegt. Diese CD-ROM enthält auch
die Treiber und Utility-Programme, die für einen einwandfreien Betrieb des Notebooks notwendig sind. 

Einige oder alle Funktionen des Notebooks sind bereits eingerichtet worden. Falls das nicht der Fall ist oder wenn Sie ein-
zelne Teile des Systems neu konfigurieren (oder neu installieren) möchten, finden Sie eine Anleitung im erweiterten Be-
nutzerhandbuch. Die CD-ROM Device Drivers & Utilities + User's Manual enthält nicht das Betriebssystem.

Informationen zu gesetzlichen Vorschriften
Die Informationen zu gesetzlichen Vorschriften finden Sie im erweiterten Benutzerhandbuch auf der CD-ROM Device
Drivers & Utilities + User's Manual.

Betrieb von Wireless-Geraten in Flugzeugen

In der Regel ist die Benutzung jeglicher tragbarer elektronischer Funkgeräte in Flugzeugen verboten. Achten
Sie darauf, daß die Module (Bluetooth, WLAN und 3.5G) AUSGESCHALTET sind, wenn Sie das Notebook
im Flugzeug benutzen.
44 -  Über das Ausführliche Benutzerhandbuch
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Hinweise zu Pflege und Betrieb
Das Notebook ist zwar sehr stabil, kann aber dennoch beschädigt werden. Damit es nicht dazu kommt, sollten Sie die fol-
genden Hinweise beachten:

• Das Gerät darf nicht herunterfallen und in anderer Form Stößen ausgesetzt werden. Wenn der Computer fällt, können das 
Gehäuse und andere Komponenten beschädigt werden.

• Halten Sie den Computer trocken, Das Gerät darf nichtüberhitzt werden. Computer und Netzteil dürfen nicht in der Nähe von 
Wärmequellen stehen oder gelagert werden. Dies ist ein elektrisches Gerät. Wenn Wasser oder andere Flüssigkeiten eindringen, 
kann der Computer stark beschädigt werden.

• Vermeiden Sie Interferenzen mit anderen Geräten. Halten Sie den Computer fern von magnetischen Feldern, die von Stromquel-
len, Monitoren, Magneten etc. erzeugt werden. Die können die Leistung beeinträchtigen und Ihre Daten beschädigen.

• Achten Sie auf die richtige Bedienung des Computers. Schalten Sie ihn erst aus,  wenn alle Programme geschlossen wurden 
(speichern Sie Ihre Daten!). Speichern Sie regelmäßig Ihre Daten, da diese verloren gehen können, wenn der Akku verbraucht ist.

• Seien Sie vorsichtig bei der Verwendung von Peripheriegeräten.

Reparatur
Reparieren Sie das Gerät nicht selbst.  Damit verstoßen Sie gegen die Garantiebedingungen und Sie können Schäden am
Gerät und an der eigenen Gesundheit verursachen. Überlassen Sie alle Reparaturen autorisiertem Fachpersonal.  Trennen
Sie das Notebook vom Stromnetz.  Unter den folgenden Umständen sollten Sie das Gerät zur Reparatur geben:

• Wenn das Netzkabel oder der AC/DC-Adapter beschädigt oder zerschlissen sind.
• Wenn der Computer Regen ausgesetzt war oder mit Flüssigkeiten in Berührung gekommen ist.
• Wenn der Computer unter Beachtung der Bedienungsanweisungen nicht korrekt arbeitet.
• Wenn der Computer heruntergefallen ist oder beschädigt wurde (berühren Sie nicht die giftige Flüssigkeit des LCD-Bildschirms).
• Wenn ein ungewöhnlicher Geruch, Hitze oder Rauch aus dem Computer entweicht.
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Stromsicherheit
 Für dieses Computer  werden bestimmte Stromanforderungen gestellt: 
• Verwenden Sie nur einen AC/DC-Adapter, der für die Verwendung mit diesem Computer zugelassen ist. 
• Der AC/DC-Adapter kann zwar für internationale Benutzung vorgesehen sein, benötigt aber trotzdem eine gleichmäßige, ununter-

brochene Stromversorgung. Wenn Sie sich über Ihre lokalen Stromspezifikationen nicht im klaren sind, wenden Sie sich an Ihren 
Servicevertreter oder Ihre lokale Stromgellschaft.

• Der AC/DC-Adapter kann einen zwei- oder dreipoligen geerdeten Netzstecker haben.  Der dritte Pol hat eine wichtige Sicherheits-
funktion. Setzen Sie die nicht außer Kraft. Wenn Sie keinen Zugang zu einer passenden Steckdose haben, lassen Sie von einem qua-
lifizierten Elektriker eine solche einbauen. 

• Fassen Sie das Netzkabel am Stecker und nicht am Kabel an, wenn Sie es vom Stromnetz trennen möchten. 
• Achten Sie darauf, daß die Steckdose und alle verwendeten Verlängerungskabel die Gesamtstromlast aller angeschlossenen Geräte trägt.
• Trennen Sie den Computer vor dem Reinigen von allen externen Stromquellen.

Reinigung
• Tragen Sie Reinigungsmittel nicht direkt auf das Computer auf. Reinigen Sie es mit einem weichen, sauberen Tuch. 
• Verwenden Sie keine flüchtigen Reinigungsmittel (Petroleumdestillate) oder Scheuermittel zum Reinigen des Computers.

Warnung zur Stromsicherheit

Bevor Sie Schritte zum Aufrüsten des Computers unternehmen, müssen Sie zunächst das Gerät ausschalten und alle Peripheriegeräte
und Kabel (einschließlich Telefonkabel) abtrennen. Sie sollten auch den Akku herausnehmen, damit das Gerät nicht versehentlich ein-
geschaltet werden kann.

Vor dem Transport in einer Tasche ausschalten

Achten Sie darauf, dass Ihr Notebook ausgeschaltet ist, wenn Sie es fur den Transport z.B. wahrend einer Reise in eine Tasche einpak-
ken. In einer Tasche kann/konnen die Luftungsoffnung(en) verdeckt werden. Wenn das Gerat dann noch eingeschaltet ist, kann es uber-
hitzt werden. Damit das eingeschaltete Notebook nicht uberhitzt wird, stellen Sie sicher, dass die Luftungsoffnung(en) immer frei sind.
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Sicherheitshinweise zum Akku
• Verwenden Sie nur Akkus, die für diesen Computer entwickelt wurden. Ein falscher Akku-Typ kann explodieren, auslaufen oder 

den Computer beschädigen.
• Verwenden Sie den Akku nicht mehr, wenn er heruntergefallen ist oder in anderer Weise beschädigt (z.B. verzogen) ist. Auch wenn 

das Notebook mit dem beschädigten Akku zu funktionieren schein, können dadurch Stromkreise beschädigt werden, die schließlich 
einen Brand verursachen können.

• Laden Sie die Akkus über das Notebook auf. Durch falsches Laden kann der Akku explodieren.
• Versuchen Sie nicht, Akkus zu reparieren. Lassen Sie die Akkupacks durch den Servicevertreter oder qualifiziertes Fachpersonal 

reparieren oder austauschen.
• Halten Sie Kinder vom Akku fern und entsorgen Sie beschädigte Akkus sofort. Seien Sie vorsichtig bei der Entsorgung der Akkus. 

Akkus können explodieren oder auslaufen, wenn sie Feuer ausgesetzt sind oder unsachgemäß behandelt oder entsorgt werden.
• Halten Sie den Akku von Metallgeräten fern.
• Bringen Sie Klebeband auf den Akkukontakten an, bevor Sie den Akku entsorgen.
• Berühren Sie die Akkukontakte nicht mit Ihren Händen oder mit metallenen Gegenständen.

Entsorgen der Akkus/Batterien & Achtung

Das von Ihnen gekaufte Produkt enthält einen aufladbaren Akku. Dier Akku ist wiederverwertbar. Nach verschiedenen nationalen
und regionalen Getzgebungen kann es verboten in, einen nicht mehr gebrauchsfähigen Akku in den normalen Hausmüll zu wer-
fen. Informieren Sie sich bei Ihrem regionalen Entsorgungsunternehmen über Recycling-Möglichkeiten oder korrekte Entsorgung.

Wenn ein falscher Akku eingesetzt wird, besteht Explosionsgefahr. Tauschen Sie den Akku nur durch den gleichen oder einen
baugleichen  Typ aus, der vom Hersteller empfohlen wird. Entsorgen Sie den verbrauchten Akku entsprechend der Anweisungen
des Herstellers.
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Modellunterschiede
Diese Notebook-Serie umfasst vier verschiedene Modelltypen (für jedes Modell gibt es unterschiedliche Designs). Es ist
möglich, dass das Design und einige der Hot-Key-Tasten anders aussehen als in diesem Benutzerhandbuch abgebildet. Die
Anschlüsse, Komponenten, Funktionen usw. sind jedoch bei allen Ausführungen gleich. Die Modelle unterscheiden sich
wie in der Tabelle beschrieben.

Tabelle 1 - Modellunterschiede

Funktion Modell A Modell B Modell C Modell D

Core Logic SiS M672 + SiS968 SiS M671DX + SiS968

Videoadapter SiS Integrated Video (auf dem Chip) NVIDIA Discrete Video (extern onboard)

AC/DC-Adapter 65W (DC-Ausgang 19V, 3,42A oder 18,5V, 3,5A) 90W (DC-Ausgang 19V, 4,74A)

LCD-Typ 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 
WSXGA+ 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 

WSXGA+

Fingerabdruckleser Nein Nein Option Option
48 -  Hinweise zu Pflege und Betrieb
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Schnellstart
1. Entfernen Sie das gesamte Verpackungsmaterial.
2. Legen Sie das Notebook auf eine stabile Unterlage.
3. Schließen Sie alle Peripheriegeräte, die Sie mit dem Notebook verwenden wollen (z. B. Tastatur und Maus), an die entsprechenden 

Schnittstellen an.
4. Schließen Sie den AC/DC-Adapter an die DC-Eingangsbuchse an der linken Seite des Notebooks an. Verbinden Sie dann das 

Netzkabel mit einer Netzsteckdose und dem AC/DC-Adapter.
5. Klappen Sie den Deckel/LCD vorsichtig mit einer Hand auf, und öffnen Sie ihn auf einen angenehmen Sichtwinkel (jedoch nicht 

weiter als 130°). Mit der anderen Hand halten Sie das Unterteil des Notebooks fest (siehe Abb. 1 unten) (Hinweis: Heben Sie den 
Computer niemals am Deckel/LCD hoch).

6. Drücken Sie auf den Netzschalter, um das Notebook einzuschalten.

Abb.  1 - Öffnen des Deckels/LCD/Notebooks mit angeschlossenem AC/DC-Adapter

Herunterfahren

Bitte beachten Sie, daß der Computer immer mit dem Befehl Herunterfahren in das Menü der Schaltfläche Sperren
in Windows Vista heruntergefahren werden muß. Dadurch werden Festplatten- bzw. Systemprobleme vermieden.
Schnellstart - 49
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Systemsoftware
Möglicherweise wurde das Notebook bereits mit vorinstal-
lierter Software ausgeliefert. Ist das nicht der Fall, oder
wenn Sie das Notebook für ein anderes System neu konfi-
gurieren möchten, finden Sie dazu eine Anleitung in diesem
Handbuch zum Betriebssystem Microsoft Windows Vista.
Weitere Informationen zur Installation der Treiber und
Hilfsprogramme finden Sie in den Kapiteln 4 und 7 des er-
weiterten Benutzerhandbuchs auf der CD-ROM Device
Drivers & Utilities + User's Manual.

Unterstützte Betriebssysteme

Nicht enthalten
Zu den Betriebssystemen (z.B.  Windows Vista/Windows
XP) und zu den Programmen (z.B. Textverarbeitung, Kal-
kulationsprogramme und Datenbanken) gibt es eigene
Handbücher, in denen Sie entsprechende Informationen fin-
den.

Treiber

Wenn Sie eine neue Systemsoftware installieren oder erneut in-
stallieren, müssen Sie die geeigneten Treiber installieren. Trei-
ber sind Programme, die als Schnittstelle zwischen dem
Computer und einer Hardware-Komponente, z.B. einem Wire-
less-Netzwerkmodul, dienen. Es ist sehr wichtig, dass Sie die
Treiber in der in Tabelle 6 auf Seite 64 angegebenen Reihen-
folge installieren. Sie können die meisten erweiterten Einstel-
lungen nicht benutzen, bevor nicht die notwendigen Treiber und
Hilfsprogramme sachgemäß installiert sind.

Betriebssystem Anmerkung

Windows XP (Home 
Edition oder Profes-

sional)

Informationen zum Betriebssystem 
Windows XP finden Sie auf der CD-
ROM Device Drivers & Utilities + 
User’s Manual.

Windows Vista mit 
Service Pack 1 (64-

bit) Home Basic 
Edition/ Home Pre-
mium Edition/Busi-

ness Edition/ 
Enterprise Edition/ 

Ultimate Edition

Bevor Sie die Treiber installieren, 
müssen Sie das Windows Vista Ser-
vice-Pack 1 (oder eine Version von 
Windows Vista, die das Service-Pack 
1 enthält) installieren. Details zum 
Download erhalten Sie auf der Web-
site von Microsoft oder von Ihrem Ser-
vice-Zentrum.

Windows Vista kann nur dann mit 
voller Leistung laufen, wenn der Com-
puter über einen Systemspeicher 
(RAM) von mindestens 1GB verfügt.
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Systemübersicht: Ansicht von vorne mit geöff-
netem LCD-Bildschirm (Modelle A & C) Abb. 2

Ansicht von vorne mit 
geöffnetem LCD-Bild-

schirm (Modelle A & C)

1. PC-Kamera (optional)
2. LCD-Bildschirm
3. Lautsprecher
4. Netzschalter
5. Hot-Key-Tasten
6. Tastatur
7. Mikrofon
8. TouchPad mit Tasten
9. Fingerabdruckleser 

(optional nur für 
Modelle C & D) 

10. LED-Anzeigen

Die Benutzung drahtlos 
angeschlossener Geräte in 

Flugzeugen

In der Regel ist die Benutzung jeg-
licher tragbarer elektronischer
Funkgeräte in Flugzeugen verbo-
ten. Achten Sie darauf, daß die
Wireless-Module AUSGE-
SCHALTET sind, wenn Sie das
Notebook im Flugzeug benutzen.

Drücken Sie die entsprechenden
Tastenkombinationen, um jeweils
das 3.5G-, das WLAN- oder das
Bluetooth-Modul zu aktivieren. Prü-
fen Sie die Statusanzeige, um fest-
zustellen, ob die Module ein- oder
ausgeschaltet sind  (siehe
Tabelle 5 auf Seite 55/ Tabelle 3
auf Seite 53).

2

5

1

7

8

4

6

9

33

10 10
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Systemübersicht: Ansicht von vorne mit geöff-
netem LCD-Bildschirm (Modelle B & D)Abb. 3

Ansicht von vorne mit 
geöffnetem LCD-Bild-

schirm (Modelle B & D)

1. PC-Kamera (optional)
2. LCD-Bildschirm
3. Lautsprecher
4. Netzschalter
5. Hot-Key-Tasten
6. Tastatur
7. Mikrofon
8. TouchPad mit Tasten
9. Fingerabdruckleser 

(optional nur für 
Modelle C & D) 

10. LED-Anzeigen

Die Benutzung drahtlos 
angeschlossener Geräte in 

Flugzeugen

In der Regel ist die Benutzung jeg-
licher tragbarer elektronischer
Funkgeräte in Flugzeugen verbo-
ten. Achten Sie darauf, daß die
Wireless-Module AUSGE-
SCHALTET sind, wenn Sie das
Notebook im Flugzeug benutzen.

Drücken Sie die entsprechenden
Tastenkombinationen, um jeweils
das 3.5G-, das WLAN- oder das
Bluetooth-Modul zu aktivieren. Prü-
fen Sie die Statusanzeige, um fest-
zustellen, ob die Module ein- oder
ausgeschaltet sind  (siehe
Tabelle 5 auf Seite 55/ Tabelle 3
auf Seite 53).

2
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1

7
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LED-Anzeigen
Die zwei LED-Anzeigegruppen (LED-Statusanzeigen und
LED-Strom- und -Kommunikationsanzeigen) auf dem
Computer zeigen wichtige Informationen über den aktuel-
len Status des Computers.

Tabelle 2 - LED-Statusanzeigen

Tabelle 3 - LED-Strom- und -Kommunikationsanzei-
gen

Symbol Farbe Beschreibung

Grün Es wird auf die Festplatte zugegriffen

Grün Die Funktion NumLk (Nummerntasta-
tur) ist aktiviert

Grün Caps-Lock ist aktiviert

Grün Scroll-Lock ist aktiviert

Symbol Farbe Beschreibung

Orange Der AC/DC-Adapter ist angeschlos-
sen

Grün Der Computer ist angeschaltet

Lampe 
blinkt grün

Das System ist im konfigurierten 
Energiesparmodus 

Orange Der Akku wird geladen

Grün Der Akku ist voll geladen

Lampe 
blinkt 

orange

Der Akku hat einen kritisch niedrigen 
Stromstatus erreicht

Grün Das Wireless LAN-Modul ist einge-
schaltet

Orange Das Bluetooth-Modul ist eingeschal-
tet
LED-Anzeigen - 53
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Hot-Key-Tasten & Tastatur
Mit den Hot-Key-Tasten haben Sie einen direkten Zugriff
auf den Standard-Internetbrowser und Ihr E-Mail-Standard-
programm, und Sie können mit nur einem schnellen Tasten-
druck den Leise-Modus ein- oder ausschalten.

Tabelle 4 - Hot-Key-Tasten

*Wenn der Leise-Modus aktiviert ist, werden die Lüfterge-
räusche und der Stromverbrauch reduziert. Beachten Sie,
dass sich dabei auch die Leistung des Notebooks verringern
kann.

Die Tastatur hat eine eingebettete Nummerntastatur für ein-
fache Zahleneingabe. Zusätzlich gibt es Funktionstasten,
über die Sie direkt zwischen den Funktionen umschalten
können (siehe Abb. 4). 

Abb. 4 - Tastatur 

Hot-Key-Taste Funktion

Das Standard-E-Mail-Programm aktivie-
ren

Einen Standard-Internet browser aktivie-
ren

Leise-Modus ein-/ausschalten* (um 
Strom zu sparen)

Nummemtastatur

Fn Taste

NumLk & ScrLk Tasten

Funktionstasten

Ein-/Ausschalten des
3.5G-Moduls

Sonderzeichen

Bei einigen Programmen können die Nummern-Tasten zur
Erzeugung von Sonderzeichen zusammen mit der Taste Alt
gedrückt werden. Diese Sonderzeichen können nur mit der
Nummerntastatur erzeugt werden. Die normalen Zahlenta-
sten (in der oberen Tastenreihe der Tastatur)  können dazu
nicht verwendet werden. Die Funktion NumLk muß aktiviert
sein.
54 -  Hot-Key-Tasten & Tastatur
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Funktionstasten und visuelle Anzeigen
Wenn die Funktionstasten (F1 - F12) gleichzeitig mit der Fn-Taste gedrückt werden, funktionieren sie wie Hotkeys. Ne-
ben den Tastenkombinationen für die Grundfunktionen gibt es visuelle Anzeigen, wenn der Hotkey Treiber (HotKey
Driver) installiert ist (siehe “Hot-Key” auf Seite 65). Wenn der Treiber installiert ist, erscheint in der Taskleiste das Sym-
bol .

Tasten Funktion/Visuelle Anzeigen Tasten Funktion/Visuelle Anzeigen

Fn + ~ Wiedergabe/Pause (in Audio /Videoprogrammen) Fn + F8/F9 LCD-Helligkeit ver-
ringern/erhöhen

Fn + 
Ein-/Ausschalten des 
3.5G-Moduls Fn + F10 PC-Kamera aktivie-

ren/deaktivieren

Fn + F1 TouchPad aktivieren/
deaktivieren Fn + F11 Wireless-LAN akti-

vieren/deaktivieren

Fn + F2 
LCD-Hintergrundlicht ausschalten 
(zum Einschalten beliebige Taste drücken oder Touch-
Pad berühren)

Fn + F12 Bluetooth aktivieren/
deaktivieren

Fn + F3 Stummschaltung/Stumm-
schaltung aufheben

Fn + 
NumLk

Ein-/Ausschalten des NumLk (Nummerntasta-
tur)

Fn + F4 Wechsel Schlaf/Wiederaufnahme Fn + ScrLk Ein-/Ausschalten des Scroll-Modus

Fn + F5/
F6 

Audio-Lautstärke verrin-
gern/erhöhen

Ein-/Ausschalten 
des Leise-Modus

Fn + F7 Wechseln der Anzeigegerate Tabelle 5 - Funktionstasten & visuelle Anzeigen
Hot-Key-Tasten & Tastatur - 55
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Systemübersicht: Ansicht von vorne und linksAbb. 5 
 Ansicht von vorne und 

links

1. LED-Anzeigen
2. DC-Eingangsbuchse
3. Schnittstelle für exter-

nen Monitor
4. RJ-45 LAN-Buchse
5. Luftungsoffnung
6. 2 USB 2.0 Anschlüsse
7. ExpressCard/54(34)-

Steckplatz
8. 7-in-1 Kartenleser

1

2 54
6

3
76 8

7-in-1 Kartenleser

Mit dem Kartenleser können einige der neuesten digitalen Speicherkarten gelesen werden. 

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / 
MS Pro (Memory Stick Pro) / MS Duo (PC adapter erforderlich) / 

Mini SD (PC adapter erforderlich) / RS MMC (PC adapter erforderlich)

Vorderseite

Linke Seite
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Systemübersicht: Ansicht von hinten und rechts
Abb. 6 

Ansicht von hinten und 
rechts

1. S/PDIF-Ausgangs-
buchse

2. Mikrofon-Eingangs-
buchse

3. Kopfhörer-Ausgangs-
buchse

4. USB 2.0 Anschluss
5. Schacht für optisches 

Laufwerk (für CD/DVD-
Geräte)

6. Notauswurfloch
7. RJ-11-Telefonbuchse
8. Sicherheitsschloß-

Buchse
9. Akkufach

Die DVD-Regionalcodes ändern

Gehen Sie auf Systemsteuerung und doppelKlicken
Sie auf Geräte-Manager (Hardware und Sound)
und dann auf das + neben den DVD/CD-ROM-Lauf-
werken. Klicken Sie doppelt auf das DVD-ROM-Lauf-
werk, öffnen das Menü Eigenschaften und wählen
DVD-Region (Registerkarte). In dem angezeigten
Fenster können Sie nun den Regionalcode einstellen.
Die DVD-Regionserkennung hängt vom Gerät, nicht
vom Betriebssystem ab. Sie können den Regionalco-
de für Ihr Modul 5mal  wählen. Die fünfte Wahl ist
nicht mehr änderbar. Sie kann auch bei Wechsel des
Betriebssystems oder bei Verwendung des Moduls in
einem anderen Computer verändert werden.

CD-Notauswurf

Wenn eine CD/DVD manuell entnommen
werden muß (z.B. wegen eines Stromaus-
falls) können Sie mit dem Ende einer gera-
degebogenen Büroklammer in das
Notauswurfloch drükken. Verwenden Sie
hierzu aber keinen spitzen Bleistift oder
ähnliche Objekte, die im Loch abbrechen
und darin stekkenbleiben könnten.

Warnung zu Datenträgern

Entnehmen Sie keine Diskette/CD, wenn
das System gerade darauf zugreift. Da-
durch könnte es zu einem “Systemzusam-
men-bruch” kommen.

Linke Seite

Côté droit

Côté gauche1 52 4

9

3 6 7 8

Rechte Seite

Hintenseite
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Systemübersicht: Ansicht von untenAbb. 7 
 Ansicht von unten

1. Akku
2. Abdeckung des Blue-

tooth-Modulfachs 
3. Abdeckung des CPU/

RAM-Schachts
4. Luftungsoffnung
5. Abdeckung des Fest-

plattenschachts
6. Position der 3.5G 

USIM-Karte

Hinweis zum Akku

Ein neuer Akku sollte bei seiner ersten
Verwendung zuerst einmal vollständig
entladen und dann komplett wieder ge-
laden werden. Entladen und laden Sie
den Akku mindestens einmal im Monat
oder nach etwa 20 Teilentladungen ein-
mal vollständig. 

CPU

Die CPU darf nicht vom Anwender repa-
riert werden. Jeglicher Zugriff auf die
CPU führt zum Verlust der Garantiean-
sprüche.

Überhitzung

Zum Schutz vor Überhitzung Ihres
Computers dürfen die Luftungsoff-
nung(en) nicht während das Notebook
in Betrieb ist verdeckt werden.

2

3

1

4

4

5
6

2

3

1

4

4

5
6

Modelle A & C 

Modelle B & D 
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Windows Vista Startmenü und Systemsteuerung
Die meisten Einstellfenster, Utilitys und Programme erreichen Sie in Windows Vista (und bei den meisten anderen Ver-
sionen von Windows) über das Start-Menü. Wenn Sie Programme und Utilitys installieren, werden diese auf der Festplatte
installiert. Eine Verknüpfung davon wird in das Start-Menü und/oder auf dem Desktop erstellt. Klicken Sie mit der rechten
Maustaste auf das Startmenü-Symbol , und wählen Sie die Option Eigenschaften, um das Erscheinungsbild des Start-
menüs zu ändern.

In diesem Benutzerhandbuch finden Sie wiederholt die Aufforderung, die Systemsteuerung zu öffnen. Zur Systemsteue-
rung gelangen Sie über das Start-Menü. In der Systemsteuerung können Sie die Einstellungen für die meisten wichtigen
Windows-Funktionen (z.B. Strom, Video, Netzwerk, Audio) vornehmen. Windows Vista bietet für viele dieser Funktionen
Einstellfenster, wobei viele neue Fenster bereits hinzugefügt werden (oder die bestehenden verbessert werden), wenn Sie
die in Tabelle 6 auf Seite 64 aufgeführten Treiber installieren. Es kann sinnvoll sein, die klassische Ansicht des Startmenüs
einzustellen.

 
Klicken Sie hier, um in die Klassi-
sche Ansicht zu wechseln

Abb. 8 - Startmenü und Systemsteuerung
Windows Vista Startmenü und Systemsteuerung - 59
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Grafikfunktionen
Dieses Notebook verfügt je nach Modell über zwei verschiedene Videooptionen (SiS bei Modellen A & B und NVIDIA
bei Modellen C & D). Wenn der Grafiktreiber installiert ist, können Sie bei Windows Vista im Einstellfenster Anzeige-
einstellungen oder im SiS VGA Control Center/NVIDIA Systemsteuerung die Anzeigegeräte wechseln und Anzeige-
optionen konfigurieren.

So öffnen Sie in Windows Vista das Dialogfeld Anzeigeeinstellungen:
1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung).
2. Klicken Sie im Menü Darstellung und Anpassung auf Bildschirmauflösung anpassen (oder doppelklicken Sie auf Anpassung > 

Anzeige).
3. Verschieben Sie den Regler auf die gewünschte Einstellung für die Auflösung  (siehe Abb. 9 auf Seite 61).
4. Klicken Sie auf den Pfeil, und wählen Sie die gewünschte Einstellung für die Farbtiefe  (siehe Abb. 9 auf Seite 61).
5. Klicken Sie auf Erweiterte Einstellungen (Schaltfläche) , (siehe Abb. 9 auf Seite 61) um das Einstellfenster Erweiterte 

Eigenschaften aufzurufen.

So öffnen Sie das SiS VGA Control Center (Modelle A & B):
1. Das SiS VGA Control Center kann aufgerufen werden, indem Sie mit der rechten Maustaste auf das SiSTray-Taskleistensymbol  

klicken und dort Control Center wählen (sie können dorthin auch über das SiS VGA Control Center in der Windows-Systemsteue-
rung gelangen).

So öffnen Sie die NVIDIA Systemsteuerung (Modelle C & D):
1. Die NVIDIA Systemsteuerung kann aufgerufen werden, indem Sie mit der rechten Maustaste auf den Desktop klicken und dort 

NVIDIA Systemsteuerung wählen (sie können dorthin auch über die NVIDIA Systemsteuerung (NVIDIA Control Panel) in der 
Windows-Systemsteuerung gelangen).

1
2

3

60 -  Grafikfunktionen
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Abb. 9 - Anzeigeeinstellungen & Control Center/Systemsteuerung

21

3

21

3
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Energieverwaltungsfunktionen
Die Energieoptionen von Windows (siehe Seite 59) ermöglichen Ihnen die Konfiguration der Optionen für das Energiema-
nagement des Computers. Sie können Strom sparen, indem Sie Energiesparpläne erstellen, die Netzschalter-, Energie-
spartasten- und Zuklappeinstellung (beim Schließen des Dekkels) konfigurieren und im linken Menü den Anzeige- und
Energiesparmodus festlegen. Beachten Sie, dass sich die Energiesparpläne (Energiesparmodus) auf die Computerlei-
stung auswirken.

Wählen Sie einen bestehenden Plan aus, oder klicken Sie im linken Menü auf Energiesparplan erstellen, und wählen Sie
die Optionen, um einen neuen Plan zu erstellen. Klicken Sie auf Energieplaneinstellungen ändern, und klicken Sie auf
Erweiterte Energieeinstellungen ändern, um weitere Optionen für die Konfiguration aufzurufen.

Abb. 10 - Energieoptionen

Hinweis: Bei Windows Vista ist die Standardeinstellung Energie sparen
62 -  Energieverwaltungsfunktionen
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Audiofunktionen
Die Audioeinstellungen können Sie bei Windows durch Anklicken des Soundsymbols 
oder des Realtek HD Audio Manager -Symbols /  in der Taskleiste/Systemsteue-
rung aufrufen (wenn Sie mit der rechten Maustaste auf das Taskleistensymbol  klikken,
wird das Audiomenü aufgerufen). Die Lautstärke können Sie durch Drücken der Tastenkom-
bination  Fn + F5/F6 ändern.

Lautstärkeeinstellung

Die Lautstärke wird mit den
Windows-Lautstärkereg-
lern (oder den Lautstärke-
reglern am Notebook)
eingestellt. Überprüfen Sie
die Einstellung, indem Sie in
der Taskleiste auf das Laut-
stärke-Sym-
bol
Klicken.

Abb. 11 - Realtek HD Audio-Manager

Klicken Sie mit der
rechten Maustaste auf
das Symbol , um
das obige Menü auf-
zurufen.
Audiofunktionen - 63
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Installation der Treiber
Die CD-ROM "Device Drivers & Utilities + User's Manu-
al" enthält die Treiber und Hilfsprogramme, die für das ein-
wandfreie Funktionieren des Notebooks notwendig sind.
Legen Sie die mitgelieferte CD-ROM und Klicken Sie auf
Install Drivers (Schaltfläche), oder klicken Sie auf Option
Drivers (Schaltfläche), um das optionale Treibermenü auf-
zurufen.
Installieren Sie die Treiber in der in Tabelle 6 angegebenen
Reihenfolge. Nachdem ein Treiber installiert wurde, wird er
grau dargestellt (wenn einer dieser Treiber ein weiteres Mal
installiert werden soll, klicken Sie auf die Schaltfläche Un-
lock).

Manuelle Treiber-Installation
Klicken Sie in der Anwendung Drivers Installer auf die
Schaltfläche Browse CD (CD durchsuchen) und navigieren
Sie zu der ausführbaren Datei in dem Ordner für Ihren Trei-
ber.

Windows Update
Nachdem Sie alle Treiber installiert haben, sollten Sie die
Funktion Windows Update aktualisieren, um immer die
neuesten Sicherheits-Updates usw. zu erhalten (die Updates
enthalten die neuesten Fehlerbehebungen von Microsoft). Tabelle 6 - Installationsvorgang

Treiber (Windows Vista mit SP1) Seite#

Video Seite 65

Audio Seite 65

Modem Seite 65

Network (LAN) Seite 65

TouchPad Seite 65

Kartenleser Seite 65

Hot-Key Seite 65

PC-Kamera (Option) Seite 66

Wireless-LAN-Modul (Option) Seite 69

3.5G-Modul (Option) Seite 71

Fingerabdruckleser (Option) - nur für die 
Modelle C und D

Seite 75

Bluetooth-Modul (Option)
Hinweis: Ein Treiber muss nicht installiert werden (siehe 
Seite 77)

Windows Update aktivieren (siehe links)
64 -  Installation der Treiber
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Video
1. Klicken Sie auf 1.Install Video Driver > Ja.

Modelle A & B (SiS):
2. Klicken Sie auf Ja (klicken Sie auf Ja, wenn Sie die 

ReadMe-Datei lesen möchten).
3. Klicken Sie auf Ja, um das Notebook neu zu starten. 

Modelle C & D (NVIDIA):
4. Klicken Sie auf Weiter.
5. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Audio
1. Klicken Sie auf 2.Install Audio Driver > Ja.
2. Klicken Sie auf Weiter.
3. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Modem
1. Klicken Sie auf 3.Install Modem Driver > Ja.
2. Klicken Sie auf OK.
3. Ihr Modem ist nun bereit zur Konfiguration.

LAN
1. Klicken Sie auf 4.Install Lan Driver > Ja.
2. Klicken Sie auf Weiter.
3. Klicken Sie auf Fertig stellen > Fertig stellen, um das 

Notebook neu zu starten.
4. Nun können die Netzwerkeinstellungen konfiguriert 

werden.

TouchPad
1. Klicken Sie auf 5.Install Touchpad Driver > Ja.
2. Klicken Sie auf Weiter.
3. Klicken Sie auf Fertig stellen > Jetzt neu starten, um das 

Notebook neu zu starten.

Kartenleser
1. Klicken Sie auf 6.Install Cardreader Driver > Ja.
2. Klicken Sie auf Weiter > Weiter.
3. Klicken Sie auf Fertig stellen, um das Notebook neu zu 

starten.

Hot-Key
1. Klicken Sie auf 7.Install HOTKEY Driver > Ja.
2. Klicken Sie auf Next > Install.
3. Klicken Sie auf Finish > Finish, um das Notebook neu zu 

starten.
Installation der Treiber - 65
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PC-Kamera
Das PC-Kamera-Modul verwendet für die Aufnahme von
Videodateien die Anwendung BisonCap.

Installieren des PC-Kamera-Treibers
1. Schalten Sie das Modul mit der Tastenkombination Fn + 

F10 ein (wenn das Modul eingeschaltet wird, erscheint 
kurz die Anzeige ). 

2. Klicken Sie auf Option Drivers (Schaltfläche).
3. Klicken Sie auf 1.PC Camera, Web cam > Ja.
4. Wählen Sie eine Sprache und klicken auf Weiter.
5. Klicken Sie auf Weiter > Fertig stellen, um  das 

Computer neu zu starten.
6. Die BisonCap-Software wird über die Verknüpfung auf 

dem Desktop oder über den Eintrag BisonCam im Menü 
Start > Programme/Alle Programme gestartet (wenn 
die Hardware ausgeschaltet wurde, können Sie sie mit der 
Tastenkombination Fn + F10 wieder einschalten).

Audio-Setup für die PC-Kamera
Wenn Sie mit der Kamera Video- und Audio-Daten aufneh-
men möchten, müssen Sie bei Windows die Optionen für die
Audio-Aufnahme einstellen.

1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung 
(oder zeigen auf Einstellungen und klicken Systemsteue-
rung).

2. Klicken Sie auf Sound  (Hardware und Sound).
3. Klicken Sie auf Aufnahme (Registerkarte).
4. Klicken Sie mit der rechten Maustaste auf Mikrofon (Realtek 

High Definition Audio) und stellen Sie sicher, dass die 
Funktion nicht deaktiviert ist.

5. Klicken sie doppelt auf Mikrofon (oder wählen Sie aus dem 
Rechtsklick-Menü die Option Eigenschaften).

6. Klicken Sie auf Pegel (Registerkarte), und regeln Sie die 
Einstellungen von Mikrofon and Mikrofonverstärkung.

7. Klicken Sie auf OK und schließen Sie alle Fenster.
8. Starten Sie das Programm BisonCap aus dem Menü Start > 

Programme/Alle Programme > BisonCam.
9. Rufen Sie das Menü Geräte auf, und wählen Sie Mikrofon 

(Realtek....) (es sollte mit einem Häkchen gekennzeichnet 
sein).

10. Rufen Sie das Menü Aufnahme auf, und wählen Sie Audio 
aufnehmen (es sollte mit einem Häkchen gekennzeichnet 
sein).

Neueste Informationen zum PC-Kameratreiber

Auf der Disc Device Drivers & Utilities + User's Manual und auf
allen beigefügten Zusatzseiten finden Sie die neuesten aktua-
lisierten Informationen zum PC-Kameratreiber. Diese Informa-
tionen werden sind vom Inhalt aktueller als die hier
angegebenen Informationen.
66 -  PC-Kamera
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BisonCap
Die Anwendung BisonCap ist ein Videowiedergabegerät
für die allgemeine Videowiedergabe und -prüfung. Die Vi-
deodateien werden im Format .avi aufgenommen.

1. Starten Sie das Programm BisonCap aus dem Menü Start > 
Programme/Alle Programme > BisonCam (es wird empfoh-
len, vor der Aufnahme die Aufnahmedatei einzustellen - 
siehe "Einstellen der Aufnahmedatei" weiter unten).

2. Gehen Sie zum Menü Aufnahme (wenn Sie Ton aufnehmen 
möchten, siehe “Audio-Setup für die PC-Kamera” auf 
Seite 66) und wählen Sie dann Aufnahme starten.

3. Klicken Sie auf OK (der Speicherort der Datei wird im Pop-up-
Fenster angezeigt), um die Aufzeichnung zu starten, und auf 
Esc, um sie zu stoppen (Die Datei können Sie sich dann mit 
Windows Media Player ansehen).

Einstellen der Aufnahmedatei
Vor dem Aufnehmen von Videodateien können Sie im Menü
Datei die Option Aufnahmedatei einst. wählen und den Da-
teinamen und den Speicherort für die aufgenommene Datei
festlegen (dadurch können Sie vermeiden, dass andere Dateien
versehentlich überschrieben werden). Wählen Sie den Namen
und den Speicherort, und klicken Sie auf Öffnen. Legen Sie
dann bei "Capture file size:" die Größe der Aufnahmedatei
fest, und klicken Sie auf OK. Nun können Sie den Aufnahme-
vorgang wie oben beschrieben starten.

Zoom 
Mit dem Programm BisonCap können Sie das Kamerabild
verkleinern und vergrößern.

1. Starten Sie das Programm BisonCap.
2. Gehen Sie zum Menü Zoom und wählen Sie dann 

Vergrößern/Verkleinern.

Fotografieren
Mit dem Programm BisonCap können Sie auch fotografie-
ren.

1. Starten Sie das Programm BisonCap.
2. Gehen Sie zum Menü Optionen und wählen Sie dann 

Fotografieren.                   
3. Das Bild (im Format JPEG) wird im Desktopordner Snapshot 

 gespeichert (der Ordner darf nicht verschoben oder 
umbenannt werden).
PC-Kamera - 67
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Bildschirmflimmern beseitigen
Wenn das Videobild bei der Wiedergabe mit dem Pro-
gramm BisonCap flimmern sollte, können Sie bei den Op-
tionen des Video Aufnahme Filters die Einstellung
vornehmen.

1. Starten Sie das Programm BisonCap.
2. Gehen Sie zu Optionen und wählen Sie "Video Aufnahme 

Filter....
3. Wählen Sie aus dem Feld Frequenz in der Registerkarte 

Eigenschaftenseite entweder 50Hz oder 60Hz.

Reduzieren der Videodateigröße
Beachten Sie, dass die Dateien beim Aufnehmen von Vide-
odateien mit großer Auflösung sehr viel Speicherplatz in
Anspruch nehmen. Prüfen Sie nach dem Aufnehmen des
Videos die Dateigröße (klicken Sie mit der rechten Mausta-
ste auf die Datei, und wählen Sie Eigenschaften) und den
freien Speicherplatz auf der Festplatte (klicken Sie auf
Computer, danach mit der rechten Maustaste auf die Fest-
platte, und wählen Sie dann Eigenschaften). Wenn nötig,
können Sie die aufgenommene Videodatei auf einem aus-
tauschbaren Datenträger speichern, z. B. CD, DVD oder
USB-Speicher.
Beachten Sie, dass das Betriebssystem Windows Vista min-

destens 15GB freien Speicher auf der Systempartition
Laufwerk C: benötigt. Um Probleme mit dem Betriebssy-
stem zu vermeiden, sollten Sie die Videodateien nicht auf
Laufwerk C: speichern (siehe “Einstellen der Aufnahme-
datei” auf Seite 67), die Dateigröße beschränken oder die
Auflösung der Videoaufnahmen verringern.

So verringern Sie die Größe der Videoauflösung:
1. Starten Sie das Programm BisonCap.
2. Gehen Sie zu Optionen, und wählen Sie dort Video 

Aufnahme konfigurieren....
3. Klicken Sie das Feld Ausgabegröße an, und wählen Sie 

eine niedrigere Auflösung, um die Größe der 
Aufnahmedateien zu verringern.
68 -  PC-Kamera
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Wireless LAN

Installieren des Wireless-LAN-Treibers
1. Schalten Sie das Modul ein.
2. Klicken Sie auf Option Drivers (Schaltfläche).
3. Klicken Sie auf 2.Wireless Lan > Ja.
4. Wählen Sie eine Sprache und klicken auf Weiter.
5. Klicken Sie auf Weiter > Installieren.
6. Klicken Sie auf Fertig stellen, um die Installation 

abzuschließen.

Hinweis: Das Betriebssystem ist die Standardeinstellung für
die Steuerung des Wireless LAN bei Windows Vista.

Anschließen an ein Drahtlosnetzwerk
Stellen Sie sicher, dass das Wireless-LAN-Modul aktiviert ist.

1. Klicken Sie auf das Wireless-Symbol  in der Taskleiste, 
und klicken Sie dann auf Verbindung mit einem Netz-
werk herstellen (oder klicken Sie mit der rechten Mausta-
ste auf das Symbol , und klicken Sie dann auf 
Verbindung mit einem Netzwerk herstellen).

2. Klicken Sie in der Liste Anzeigen aus dem Dropdown-
Menü die Option Drahtlosnetzwerke.

3. Eine Liste der verfügbaren Netzwerke wird angezeigt.
4. Klicken Sie auf ein Netzwerk und dann auf Verbinden.
5. Wenn das gewünschte Netzwerk nicht angezeigt wird, 

klicken Sie auf Eine Verbindung oder ein Netzwerk 
einrichten.

6. Schieben Sie den Cursor über das Taskleistensymbol , 
um den Verbindungsstatus aufzurufen.

7. Wenn Sie die Verbindung zum Wireless-Netzwerk trennen 
möchten, klicken Sie in der Taskleiste auf das Wireless-
Symbol , und wählen Sie dann die Option Verbindung 
herstellen oder Trennen, um das Netzwerkmenü 
aufzurufen. Klicken Sie dann auf Trennen (oder klicken 
Sie mit der rechten Maustaste auf das Symbol , und 
klicken Sie dann auf Verbindung trennen von).

Ein- und Ausschalten des Wireless-LAN-Moduls

Das Wireless-LAN-Modul wird durch Drücken der Tastenkom-
bination (Fn + F11) eingeschaltet. Wenn das Wireless-LAN-
Modul eingeschaltet ist,  leuchtet die LED  grün und er-
scheint kurz die Anzeige .
Wireless LAN - 69
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3.5G-Modul
Wenn Ihr Modell das optionale 3.5G-Modul enthält, fol-
gen Sie den nachfolgenden Anweisungen, um die USIM-
Karte zu installieren (Sie erhalten sie von Ihrem Dienstan-
bieter). Installieren Sie dann die Anwendung.

1. Schalten Sie das Notebook aus, drehen Sie es herum, und 
nehmen Sie den Akku heraus.

2. Lösen Sie die Schrauben der Abdeckung des SIM-
Kartenfachs  in Abb. 12.

3. Nehmen Sie die Abdeckung des SIM-Kartenfachs ab  in 
Abb. 12.

4. Setzen Sie die USIM-Karte wie bei Ihrem Mobiltelefon ein.
5. Schieben Sie den SIMLOCK-Riegel in Richtung Scharnier (in 

die entgegengesetzte Richtung des in Abb. 13 dargestellten 
Pfeils), um den Riegel zu öffnen, und klappen Sie ihn hoch.

Abb. 12 - Abnehmen der SIM-Kartenfachabdeckung

6. Setzen Sie die USIM-Karte wie abgebildet ein (Abb. 13), und 
schließen Sie den SIMLOCK.

7. Verriegeln Sie den SIMLOCK, indem Sie ihn bis zum 
Einrasten in Pfeilrichtung schieben (Abb. 13).

8. Setzen Sie die Abdeckung wieder auf, die Schraube und den 
Akku ein.

Abb. 13 - Einsetzen der USIM-Karte und Schließen 
des SIMLOCK-Riegels

Warnung zur Stromsicherheit

Bevor Sie Schritte zum Aufrüsten des Computers unterneh-
men, müssen Sie zunächst das Gerät ausschalten und alle Pe-
ripheriegeräte und Kabel (einschließlich Telefonkabel)
abtrennen. Sie sollten auch den Akku herausnehmen, damit
das Gerät nicht versehentlich eingeschaltet werden kann.

1
2

2

1
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Ausführliches Benutzerhandbuch

D
eutsch
Programm 3G Watcher
Wenn das 3.5G-Modul und die USIM-Karte (Ihres
Dienstanbieters) installiert sind, können Sie das Programm
3G Watcher verwenden. Mit 3G Watcher können Sie mit
dem Notebook direkt auf den -Internetdienst zugreifen.

Installieren von 3G Watcher
1. Schalten Sie das Modul an, indem Sie auf die Tasten Fn + 

 drücken (die Anzeige  zeigt den Stromstatus des 
Moduls an).

2. Wenn der Assistent "Neue Hardware gefunden" erscheint, 
klicken Sie Abbrechen.

3. Klicken Sie auf Option Drivers (Schaltfläche).
4. Klicken Sie auf  3.3G Driver > Ja.
5. Klicken Sie auf Weiter.
6. Klicken Sie auf die Schaltfläche Ich akzeptiere die 

Bedingungen der Lizenzvereinbarung, und dann auf  
Installieren.

7. Wenn das nächste Fenster angezeigt wird, müssen Sie 
ca. 2 Minuten warten, bevor Sie auf Fertigstellen 
klicken (damit die Hardware das 3.5G-Modul erkennen 
kann).

8. Auf dem Desktop erscheint das 3G Watcher -Symbol .
9. Sie können das Programm 3G Watcher über das Start-

Menü aufrufen (Start > Programme/ AlleProgramme > 
Sierra Wireless > 3G Watcher) oder durch Anklicken 
des Symbols  in der Taskleiste.

Einrichten eines Profils
Auch wenn die Verbindungsinformationen auf der vom
Dienstanbieter zur Verfügung gestellten USIM-Karte ge-
speichert sind, müssen Sie im Programm 3G Watcher das
richtige Profil einrichten.

1. Benutzen Sie die Tastenkombination Fn + , um das 3.5G-
Modul zu aktivieren.

2. Sie können das Programm 3G Watcher über das Start-Menü 
aufrufen (Start > Programme/ AlleProgramme > Sierra 
Wireless > 3G Watcher) oder durch Anklicken des Symbols 

 in der Taskleiste.
3. Klicken Sie auf Extras und wählen Sie Optionen.
4. Klicken Sie auf Profile und dann auf die Schaltfläche Neues 

Profil hinzufügen . Wählen Sie WWAN-Profil.

Abb. 14 - WWAN-Profil hinzufügen
3.5G-Modul - 71



Ausführliches Benutzerhandbuch

D
eu

ts
ch
5. Sie können dann einen neuen Profilnamen eingeben oder ein 
Profil aus der Drop-down-Liste auswählen, die von der 
Software angeboten wird.

6. Klicken Sie auf  Übern. > OK, um die Informationen zu 
speichern.

7. Sie können das Profil aus dem Pull-down-Menü auswählen.

Abb. 15 - Benutzeroptionen und Profile

Herstellen einer Verbindung zum Dienstan-
bieter
1. Benutzen Sie die Tastenkombination Fn + , um das 3.5G-

Modul zu aktivieren.
2. Sie können das Programm 3G Watcher über das Start-Menü 

aufrufen (Start > Programme/ AlleProgramme > Sierra 
Wireless > 3G Watcher) oder durch Anklicken des Symbols 

 in der Taskleiste.
3. Die Software wird gestartet und zeigt dann den namen des 

Dienstanbieters an (die Verbindungsdaten sind auf der USIM-
Karte gespeichert). 

Abb. 16 - 3G Watcher
4. Klicken Sie auf Verbinden um die Verbindung herzustellen.
5. Das Programm 3G Watcher zeigt im Fenster dann die 

Verbindungsinformationen an.

Abb. 17 - Verbindung wird hergestellt

Informationen zum Profil

Wenn sie ein Profil aus der Drop-down-Liste ausgewählt ha-
ben, werden die meisten Daten in den Registerkarten Allge-
mein und Erweitert automatisch in die Felder eingetragen
(lassen Sie sich von Ihrem Dienstanbieter jedoch die neue-
sten Daten geben, da Sie auf jeden Fall Ihren Benutzerna-
men und das Kennwort eingeben müssen).
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6. Wenn die Verbindung erfolgreich hergestellt wurde, erscheint 
eine entsprechende Benachrichtigung (siehe unten).

Abb. 18 - Verbindungsbenachrichtigung in der Tas-
kleiste

7. Sie können dann wie bei jeder Internetverbindung auf das 
Internet zugreifen, E-Mails herunterladen usw.

8. Solange die Verbindung besteht, ist das Taskleistensymbol 
grün  (wenn das Programm läuft, aber nicht verbunden ist, 
leuchtet es rot ).

9. Um die Verbindung zu trennen, klicken Sie auf das Trennen-
Symbol.

Abb. 19 - 3G Watcher verbunden
10. Das Programm trennt die Verbindung zum Dienstanbieter.
11. Das Modul ist dann immer noch aktiviert. Um es zu 

deaktivieren, drücken Sie auf die Tastenkombination Fn+ .

12. Wenn Sie auf das Schließen-Symbol  von 3G Watcher 
klicken, erscheint ein Fenster, in dem Sie auf OK klicken 
müssen, um das Programm zu beenden. 

 

13. Durch das Beenden des Programms wird das Modul NICHT 
ausgeschaltet. Um es auszuschalten, müssen Sie auf die 
Tastenkombination Fn +  drücken (denken Sie daran, 
wenn Sie im Flugzeug unterwegs sind - siehe “Betrieb von 
Wireless-Geraten in Flugzeugen” auf Seite 44).

14. Wenn das Modul aktiviert ist, und der Computer in einen 
Stromsparmodus wechselt, wird der Stromstatus des Moduls 
beim erneuten Einschalten des Computers wie umseitig 
angezeigt:

• Wenn das 3.5G-Modul aktiviert ist und der Computer aus-
geschaltet oder neu gestartet wird, ist das Modul beim 
Wiedereinschalten des Computers aus.

• Wenn das 3.5G-Modul aktiviert ist und der Computer in 
den Energiesparmodus oder Ruhezustand wechselt, ist 
das Modul beim Wiedereinschalten des Computers aus.

Abb. 20 
Hinweis zum Beenden
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SMS-Dienst
Neben der Nutzung der Standard-Internetdienste können
Sie mit 3G Watcher auch SMS-Nachrichten senden und
empfangen.

1. Wenn eine neue SMS-Nachricht eingegangen ist, erscheint 
im Hauptfenster das SMS-Symbol .

2. Klicken Sie doppelt auf das Symbol  oder wählen Sie  
Extras > SMS Express....

3. Rufen Sie den Posteingangsordner auf, und wählen Sie die 
Nachricht aus, die Sie lesen möchten, oder klicken Sie auf 
Datei > Neue E-Mail, oder klicken Sie auf die Schaltfläche 
Neu, um eine neue SMS-Nachricht zu schreiben.

Ausführliche Informationen zu SMS-Nachrichten finden
Sie in der 3GWatcher Online-Hilfe, die Sie bei Hilfe >
Hilfethemen finden.

3G Watcher Online-Hilfe

Weitere Informationen zum Programm 3G Watcher finden Sie
in der dazugehörigen Online-Hilfe bei Hilfe > Hilfethemen.

Klicken Sie im Fenster Inhalt auf ein beliebiges Thema, zu dem
weitere Informationen angezeigt werden sollen.
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Fingerabdruckleser
Wenn das von Ihnen erworbene Gerät über einen Fingerab-
druckleser verfügt (optional nur für die Modelle C und D)
müssen Sie den Treiber entsprechend der folgenden Anwei-
sung installieren. 

Für einen vollen Schutz müssen Sie für den Computer Ad-
ministratorrechte und ein Windows-Kennwort aktiviert ha-
ben. 

Bevor Sie mit der Registrierung beginnen, sollten Sie das
Lernprogramm zum Fingerabdruckleser durchgehen. Um
das Lernprogramm zu starten, klicken Sie auf Start > Pro-
gramme/ Alle Programme > Protector Suite QL > Fin-
gerprint Tutorial (Fingerabdruck-Lernprogramm).

Installieren des Fingerabdruckleser-
Treibers
1. Legen Sie die CD-ROM Device Drivers & Utilities + 

User’s Manual in das CD/DVD-Laufwerk.
2. Klicken Sie auf Option Drivers (Schaltfläche).
3. Klicken Sie auf 4.FingerPrint > Ja.
4. Klicken Sie auf Softwareinstallation.
5. Klicken Sie auf Weiter > Weiter > Weiter.
6. Klicken Sie auf Fertig stellen > Ja, um das Notebook neu 

zu starten.

Benutzerregistrierung
1. Klicken Sie auf Start > Programme/ Alle Programme > Pro-

tector Suite QL > Benutzerregistrierung, oder doppelKlik-
ken Sie in der Taskleiste auf das Symbol .

2. Wenn das Programm das erste Mal gestartet wird, werden Sie 
gefragt, ob Sie die Lizenzvereinbarung annehmen möchten. 
Klicken Sie dann auf OK.

3. Klicken Sie auf Weiter ("Registrierung auf der Festpllate" 
wird automatisch ausgewählt) und klicken Sie auf Fertig 
stellen.

Hilfe & Handbuch

Klicken Sie mit der rechten Maustaste auf das Taskleistensym-
bol  und wählen Sie aus dem Menü die Option Help (Hilfe).

Legen Sie die mitgelieferte CD-ROM Device Drivers & Utilities
+ User's Manual ein und klicken Sie auf Option Drivers
(Schaltfläche). Klicken Sie auf Unlock (Schaltfläche) und dann
Klikken Sie auf 4.FingerPrint > Ja.

Klicken Sie auf Documentation um den Ordner zu öffnen, in
dem Sich das Benutzerhandbuch im .pdf-Format befindet.

Um die Adobe Acrobat Reader-Software zu installieren, die Sie
benötigen, um die Datei lesen zu können, legen Sie die CD-
ROM Device Drivers & Utilities + User’s Manual in das CD-
Laufwerk ein, und Klicken sie auf User’s Manual (Schaltflä-
che) und dann auf  Install Acrobat Reader (Schaltfläche).
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4. Wenn Sie kein Windows-Kennwort eingerichtet haben, 
werden Sie dazu aufgefordert (Hinweis: Wenn kein Kennwort 
festgelegt wurde, kann Protector Suite QL nicht den Zugriff 
auf den Computer sichern).

5. Wenn Sie auf Weiter klicken, werden Sie aufgefordert, Ihr 
Windows-Kennwort einzugeben.

6. Klicken Sie auf Weiter > Weiter (Markieren Sie das 
Kontrollfeld bei "Interaktives Lernprogramm ausführen", 
um das Fingerabdruck-Lernprogramm durchzugehen).

7. Klicken Sie bei jedem Fenster des Lernprogramms auf Weiter 
(sie können jederzeit auch auf die Schaltfläche 
"Lernprogramm überspringen" klicken).

8. Klicken Sie auf eine der Tasten über einem beliebigen Finger, 
um mit der Registrierung dieses Fingers zu beginnen.

9. Tippen Sie dreimal mit dem Finger auf, um diesen Finger zu 
registrieren.

10. Wiederholen Sie diesen Vorgang für alle Finger, die registriert 
werden sollen, und dann klicken Sie auf Weiter.

11. Klicken Sie auf Fertig stellen.
12. Klicken Sie auf einen der Einträge unter "Weitere 

Informationen zu:", um weitere Informationen über dieses 
Thema zu erhalten.

13. Klicken Sie auf Schließen.
14. Starten Sie das Notebook neu.
15. Klicken Sie mit der rechten Maustaste auf das 

Taskleistensymbol  um das Menü mit den Optionen zu 
starten, mit denen Sie Fingerabdrücke bearbeiten, auf das 
Control Center zugreifen, die Hilfe aufrufen können. Sie 

können das Control Center usw.  auch über den Eintrag 
Protector Suite QL im Menü Start > Programme/Alle 
Programme starten. 

16. Eine ausführliche Beschreibung finden Sie unter “Hilfe & 
Handbuch” auf Seite 75.

17. Wenn Sie mit dem Finger auf den Fingerabdruckleser tippen, 
können Sie auf das Biomenü zugreifen, um den Computer 
zu sperren, Websites zu registrieren, das Control Center 
zu öffnen und das Hilfe-Menü aufzurufen.

18. Im Control Center können Sie die Einstellungen und 
Fingerabdrücke bearbeiten, und hier erhalten Sie auch Hilfe 
dazu.

Abb. 21 -  Control Center & Biomenü 

Fingerabdruckregistrierung

Beachten Sie, dass es für den Fall einer Verletzung o. ä.
sinnvoll ist, mehr als einen Finger zu registrieren.
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Bluetooth-Konfiguration
Richten Sie Ihr Bluetooth-Gerät so ein, 
dass der Computer es erkennen kann
1. Schalten Sie Ihr Bluetooth-Gerät (z. B. PDA, Mobiltelefon) ein.
2. Schalten Sie das Gerät in den Erkennbar-Modus (eine 

Beschreibung dazu finden Sie in der dazugehörigen 
Dokumentation).

Einschalten des Bluetooth-Moduls
1. Schalten Sie das Bluetooth-Modul mit der Tastenkombination 

Fn + F12 ein. 
2. In der Taskleiste erscheint das Bluetooth-Symbol  

(möglicherweise müssen Sie die Option über das Fenster 
Bluetooth-Geräte aktivieren).

3. Führen Sie dann einen der folgenden Schritte aus, um das 
Fenster Bluetooth-Geräte aufzurufen.

• Klicken Sie doppelt auf das Symbol , um das Fenster 
Bluetooth-Geräte aufzurufen.

• Klicken Sie Start (Menü) und klicken Sie Systemsteue-
rung (oder zeigen auf Einstellungen und klicken System-
steuerung), und klicken Sie dan auf Bluetooth-Geräte 
(Hardware und Sound).

• Klicken/klicken Sie mit der rechten Maustaste auf das 
Symbol  und wählen Sie eine Option aus dem Menü.

Abb. 22 - Fenster "Bluetooth-Geräte" und beim Ank-
licken des Symbols angezeigtes Menü

Hinzufügen eines Bluetooth-Geräts
1. Rufen Sie das Fenster Bluetooth-Geräte auf.
2. Klicken Sie auf Optionen (Registerkarte), und machen Sie ein 

Häkchen bei Bluetooth-Geräte können eine Verbindung 
mit diesem Computer herstellen (Verbindungen).

3. Klicken Sie auf Geräte (Registerkarte) und klicken Sie dann 
auf Hinzufügen.

4. Der Assistent zum Hinzufügen von Bluetooth-Geräten 
erscheint.

Bluetooth-
Datenübertragung

Beachten Sie, dass die
Datenübertragung zwi-
schen dem Notebook und
einem Bluetooth-Gerät
nur in einer Richtung
möglich ist (eine gleich-
zeitige Datenübertra-
gung in beide
Richtungen wird nicht
unterstützt).
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5. Klicken Sie auf “Gerät ist eingerichtet und kann erkannt 
werden”, und klicken Sie dann auf Weiter.

Abb. 23 - Assistent zum Hinzufügen von Bluetooth-
Geräten

6. Der Assistent sucht dann innerhalb der Reichweite nach 
verfügbaren Bluetooth-Geräten.

7. Wählen Sie das Gerät aus, mit dem Sie kommunizieren 
möchten, und klicken Sie auf Weiter.

8. Wählen Sie einen geeigneten Hauptschlüssel, und klicken Sie 
auf Weiter > Fertig stellen.

Abb. 24 - Hauptschlüssel-Option

Ändern der Einstellungen für das Blue-
tooth-Gerät
1. Rufen Sie das Fenster Bluetooth-Geräte auf.
2. Klicken Sie auf das Gerät, das Sie ändern möchten, und dann 

auf Eigenschaften, um:
• den Namen des Geräts zu ändern (klicken Sie auf Allgemein, 

geben Sie einen neuen Namen ein, und klicken Sie auf OK).
• einen Dienst zu aktivieren/deaktivieren (klicken Sie auf Dien-

ste, markieren Sie das Kontrollkästchen neben im Feld Dienst 
(oder entfernen die Markierung), und klicken Sie auf OK).

Schalten des Computers in den Er-
kennbar-Modus Für Bluetooth-Geräte
1. Rufen Sie das Fenster Bluetooth-Geräte auf.
2. Klicken Sie auf Optionen (Registerkarte), und machen Sie ein 

Häkchen bei Bluetooth-Geräte können diesen Computer 
ermitteln (Suche).

3. Machen Sie ein Häkchen bei Benachrichtigung anzeigen, 
wenn ein Bluetooth-Gerät eine Verbindung herstellen möchte 
(Verbindungen), wenn Sie benachrichtigt werden möchten, wenn 
ein Bluetooth-Gerät eine Verbindung herstellen möchte.

Abb. 25
Bluetooth-Geräte - 

Optionen
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Fehlerbehebung
Problem Mögliche Ursache - Lösung

Die Module Wireless-LAN/Bluetooth 
können nicht erkannt werden.

Das/Die Modul(e) ist/sind ausgeschaltet. Stellen Sie anhand der Anzeige-LED   fest, 
ob das Modul an- oder ausgeschaltet ist. Wenn die Anzeige-LED nicht leuchtet, drücken 
Sie die Tastenkombination Fn + F11 (WLAN) oder Fn + F12 (Bluetooth), um das/die 
Modul(e) zu aktivieren (siehe Tabelle 5 auf Seite 55).

Das Bluetooth-Modul ist aus, wenn das 
Gerät aus dem Energiesparmodus 
zurückkehrt.

Das Bluetooth-Modul ist standardmäßig ausgeschaltet, wenn es aus dem 
Energiesparmodus zurückkehrt. Drücken Sie die Tastenkombination (Fn + F12), um das 
Bluetooth-Modul nach der Rückkehr aus dem Energiesparmodus wieder einzuschalten.

Eine Datei kann nicht auf ein/von einem 
angeschlossenen Bluetooth-Gerät 
übertragen werden.

Die Datenübertragung zwischen dem Notebook und einem Bluetooth-Gerät nur in einer 
Richtung möglich ist (eine gleichzeitige Datenübertragung in beide Richtungen 
wird nicht unterstützt). Sie können eine Datei vom Notebook auf ein aktiviertes 
Bluetooth-Gerät nur dann kopieren, wenn nicht gleichzeitig Dateien vom Gerät zum 
Computer übertragen werden. Dieser Vorgang muss zuerst abgeschlossen werden.

Die mit der PC-Kamera aufgenommenen 
Dateien benötigen zu viel Speicherplatz.

Videodateien, die mit hoher Auflösung aufgenommen werden, erfordern sehr viel 
Speicherplatz.

Beachten Sie, dass das Betriebssystem Windows Vista mindestens 15 GB freien 
Speicher im Laufwerk C: der Systempartition benötigt. Es wird empfohlen, die 
aufgenommenen Videodateien in einem anderen Laufwerk als C: zu speichern, die 
Dateigröße der Aufnahmedateien zu beschränken oder die Auflösung der Videos zu 
verringern (Optionen/Options > Video Aufnahme konfigurieren.../Video Capture 
Pin... > Ausgabegröße). Siehe “Reduzieren der Videodateigröße” auf Seite 71.
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Technische Daten

Funktion Technische Daten

Prozessor Typen Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T8100/ T8300

(45nm) 45 Nanometer-Prozesstechnologie 
3 MB L2 Cache & 800-MHz-Systembus (FSB) 
2,1/ 2,4 GHz

Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T9300/ T9500

(45nm) 45 Nanometer-Prozesstechnologie 
6 MB L2 Cache & 800-MHz-Systembus (FSB) 
2,5/ 2,6 GHz

Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T7100/ T7250

(65nm) 65 Nanometer-Prozesstechnologie 
2 MB L2 Cache & 800-MHz-Systembus (FSB) 
1,8/ 2,0 GHz

Intel Core 2 Duo Prozessor 
Micro-FCPGA-Paket (478-pin)
T7300/ T7500/ T7700/ T7800

(65nm) 65 Nanometer-Prozesstechnologie 
4 MB L2 Cache & 800-MHz-Systembus (FSB) 
2,0/ 2,2/ 2,4/ 2,6 GHz

Aktualität der technischen Daten

Die in diesem Anhang aufgeführten technischen Daten sind zum Zeitpunkt der Druckstellung richtig. Bestimmte Elemente (ins-
besondere Prozessortypen/-geschwindigkeiten) können im Rahmen des Entwicklungsplans des Herstellers zwischenzeitlich ge-
ändert oder aktualisiert werden. Detailinformationen erhalten Sie bei Ihrem Servicezentrum.
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Intel Celeron M Prozessor 
Micro-FCPGA-Paket (478-pin)
530/ 540/ 550/ 560

(65nm) 65 Nanometer-Prozesstechnologie 
1 MB L2 Cache & 533-MHz-Systembus (FSB) 
2,0/ 2,2/ 2,4 GHz

Core Logic Modelle A & B
SiS M672 + SiS968 Chipsatz

Modelle C & D
SiS M671DX + SiS968 Chipsatz

LCD-Bildschirm Modelle A & C 
Glare-Type TFT-Flachbildschirm, 14,1" - WXGA / 
WXGA+

Modelle B & D 
Glare-Type TFT-Flachbildschirm, 15,4" - WXGA / 
WXGA+ / WSXGA+

Videoadapter Modelle A & B
SiS M672 Integrated Video (auf dem Chip)

Hochleistungs-2D/3D-Grafikbeschleuniger
Shared-Memory-Architektur (bis zu 256MB 
gemeinsam verwendeter Videospeicher, der vom 
Systemspeicher nach Bedarf dynamisch zugewie-
sen wird)
Unterstützt DirectX 9
Unterstützt Vertex Shader 2.0 und Pixel Shader 
2.0

Modelle C & D
NVIDIA GeForce 9300M GS Discrete Video (extern 
onboard)

256MB GDDR2 Video-RAM On Board
TurboCache™ unterstützt einen gesamten Grafik-
speicher von bis zu 512MB (je nach Systemspei-
cher)
Unterstützt DirectX 10

Speicher Zwei 200-Pin SODIMM-Sockel, Unterstützung von DDRII (DDR2) 667 Speicher
Speicher auf bis zu 4GB erweiterbar

Sicherheit Öffnung für Sicherheitsschloß (Typ Kensington)
Fingerabdruckleser (Werkseitige Option  - Modelle 
C & D)

BIOS-Paßwort

Funktion Technische Daten
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BIOS Phoenix BIOS (8MB SPI Flash-ROM) Phoenix BIOS

Speicher Ein Austauschbares optisches Laufwerk (12,7 mm Höhe) für CDs/DVDs (Laufwerksoptionen finden Sie unter 
“Optional” auf Seite 84)
Eine einfach auszuwechselnde SATA-2,5"-Festplatte (9,5 mm Höhe)

Audio Intel High-Definition-Audio-kompatible Schnittstelle
Kompatibel mit Microsoft UAA (Universal Audio Archi-
tecture)
Kompatibel mit Direct Sound 3D™

S/PDIF Digtalausgang
2 eingebaute Lautsprecher
Eingebautes Mikrofon

Tastatur “Win Key”-Tastatur

Zeigegerät Eingebautes TouchPad (integrierte Rolltastenfunktion)

Schnittstellen Drei USB 2.0-Anschlüsse 
Eine Lautsprecher/Kopfhörer-Ausgangsbuchse
Eine Mikrofon-Eingangsbuchse
Eine S/PDIF-Ausgangsbuchse

Eine RJ-11 Buchse für Modem
Eine RJ-45-Buchse für LAN
Eine DC-Eingangsbuchse
Eine Schnittstelle für externen Monitor

Kartenleser Festes 7-in-1 Kartenleser-Modul (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Hinweis: MS Duo/ Mini SD/ RS MMC Karte erfordert PC-Adapter

ExpressCard-
Steckplatz ExpressCard/54(34)-Steckplatz

Funktion Technische Daten
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Kommunikation

*Anmerkung: Ein 
Notebookmodell 
kann nicht gleich-
zeitig ein Blue-
tooth- und ein 
3.5G-Modul haben. 
Wenn das Modell 
über ein Modul ver-
fügt, ist das andere 
nicht verfügbar.

56K MDC-Modem (V.90- und V.92-kompatibel)
10Mb/100Mb Ethernet LAN
USB 802.11b/g Wireless LAN-Modul (Option)
1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werkseitige Option)
*USB Bluetooth 2.0 + EDR-Modul (Werkseitige Option)
Oder 
*UMTS/HSPDA-gestützes 3.5G-Modul mit MiniCard-Schnittstelle 
(Werkseitige Option)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Energieverwal-
tung Unterstützt ACPI v3.0

Stromversor-
gung

Modelle A & B
AC/DC-Adapter für den gesamten Spannungsbereich 
AC-Eingang: 100-240 V, 50-60Hz
DC-Ausgang: 19V, 3,42A oder 18,5V, 3,5A (65W)

Modelle C & D
AC/DC-Adapter für den gesamten Spannungsbereich 
AC-Eingang: 100-240 V, 50-60Hz
DC-Ausgang: 19V, 4,74A (90W)

Akkupack mit Smart Lithium-Ionen-Hauptakku mit 6 Zellen, 4000mAH oder 4400mAH
oder
Akkupack mit Smart Lithium-Ionen-Hauptakku mit 9 Zellen, 7200mAH - Option

Umgebungsbe-
dingungen

Temperatur
In Betrieb: 5ºC – 35ºC
Bei Aufbewahrung: -20ºC – 60ºC

Relative Luftfeuchtigkeit
In Betrieb: 20 – 80 %
Bei Aufbewahrung: 10 – 90 %

Funktion Technische Daten

UMTS-Modi

Beachten Sie, dass  die UMTS-
Modi NICHT in Nordamerika ver-
wendet werden können.
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Abmessungen  
und Gewicht

Modelle A & C
336 (B) x 250 (T) x 24,8 - 35,7 (H) mm
2,2 kg mit 6-Zellen-Akku

Modelle B & D
359 (B) x 268 (T) x 24,8 - 37 (H) mm
2,5 kg mit 6-Zellen-Akku

Optional

*Anmerkung: Ein 
Notebookmodell 
kann nicht gleich-
zeitig ein Blue-
tooth- und ein 
3.5G-Modul haben. 
Wenn das Modell 
über ein Modul ver-
fügt, ist das andere 
nicht verfügbar.

Optionen für optische Laufwerks-Module:
Kombiniertes-Laufwerk
DVD Dual (Super Multi)-Laufwerk

USB 802.11b/g Wireless LAN-Modul 

Akkupack mit Smart Lithium-Ionen-Hauptakku mit 9 
Zellen

1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werk-
seitige Option)

Fingerabdruckleser (Werkseitige Option - Modelle C 
& D)

*USB Bluetooth 2.0 + EDR-Modul (Werkseitige 
Option)
Oder 
*UMTS/HSPDA-gestützes 3.5G-Modul mit MiniCard-
Schnittstelle (Werkseitige Option)

Quad-band GSM/GPRS (850 MHz, 900MHz,
       1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Funktion Technische Daten

UMTS-Modi

Beachten Sie, dass  die UMTS-Modi NICHT in
Nordamerika verwendet werden können.
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n’assument aucune responsabilité en cas d’erreurs ou d’imprécisions qui pourraient se trouver dans cette publication et ne
sont en aucun cas responsable d’aucunes pertes ou dommages résultant de l’utilisation (correcte ou incorrecte) de cette pu-
blication.

Cette publication et les logiciels qui l’accompagnent ne peuvent pas, dans leur intégrité ou en partie, être reproduits, tra-
duits, transmits ou convertis en format électronique sans l’autorisation préalable du vendeur, du fabricant ou des créateurs
de cette publication, à l’exception de copies conservées par l’utilisateur pour archive.
Les noms de marques ou de produits mentionnés dans cette publication peuvent ou pas être protégés et/ou être des marques
déposées par leur compagnies respectives. Ils sont mentionnés dans un but d’identification seulement et ne signifient pas
l’approbation de ce produit ou de son fabricant.

© Mars 2008

Marques déposées
Ce produit incorpore une technologie de protection des droits d'auteur protégée par certains brevets américains et autres
droits sur la propriété intellectuelle appartenant à Macrovision Corporation et d’autres propriétaires légitimes. L’utilisation
de cette technologie de protection des droits d'auteur doit être autorisé par Macrovision Corporation, et n’est prévu que dans
un cadre privé ou limité, à moins d’obtenir l’autorisation de Macrovision Corporation. L'ingénierie inverse et le désassem-
blage sont interdits.

Intel, Celeron et Intel Core sont des marques déposées ou enregistrées d’Intel Corporation déposées.
Avertissement - 85
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A propos de ce Guide Utilisateur Concis
Ce guide rapide est une brève introduction à la mise en route de votre système. l s’agit d’un supplément, et non pas d’une
alternative au Manuel de l’Utilisateur en Anglais complet au format Adobe Acrobat sur le CD-ROM Device Drivers &
Utilities + User's Manual fourni avec votre ordinateur. Ce CD-ROM contient aussi les pilotes et utilitaires nécessaires au
fonctionnement correct de votre ordinateur portable. 

Certains ou tous les éléments de l’ordinateur peuvent avoir été déjà installés. Si ce n’est pas le cas, ou si vous avez l’inten-
tion de reconfigurer (ou réinstaller) des portions du système, reportez-vous au Manuel de l’Utilisateur complet. Le CD-
ROM Device Drivers & Utilities + User’s Manual ne contient pas de système d’exploitation.

Informations de contrôle
Des mises en garde et informations de contrôle sont incluses dans le Manuel de l'Utilisateur complet qui se trouve sur le
CD-ROM Device Drivers & Utilities +User’s Manual.

Utilisation des appareils sans fil à bord d'un avion

L'utilisation de tout appareil électronique de transmission est généralement interdite à bord d'un avi-
on. Assurez-vous que les modules 3.5G/WLAN/Bluetooth sont éteints si vous utilisez l'ordina-
teur à bord d'un avion.
86 -  A propos de ce Guide Utilisateur Concis
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Instructions d’entretien et d’utilisation
L’ordinateur portable est robuste, mais il peut toutefois être endommagé. Afin d’éviter ceci, veuillez suivre ces recommandations :
• Ne le laissez pastomber. Ne l’exposez à aucun choc ou vibration.  Si l’ordinateur tombe, le boîtier et d’autres éléments pour-

raient être endommagés.
• Gardez-le sec. Ne le laisser pas surchauffer. Tenez l’ordinateur et son alimentation externe à distance de toute source de chaleur. 

Il s’agit d’un appareil électrique. Si de l’eau ou tout autre liquide venait à pénétrer à l’intérieur de votre ordinateur, il pourrait être 
sérieusement endommagé.

• Evitez les interférences. Tenez l’ordinateur à distance de transformateurs à haute capacité, moteurs électriques, et autres appareils 
générateurs de champs magnétiques importants. Ceux-ci peuvent gêner ses performances normales et endommager vos données.

• Suivez les procédures appropriées d’utilisation de votre ordinateur. Arrêtez l’ordinateur correctement, et fermez tous vos pro-
grammes (n’oubliez pas d’enregistrer votre travail). N’oubliez pas d’enregistrer vos données régulièrement puisqu’elles peuvent 
être perdues si la batterie est vide.

• Soyez prudent lorsque vous utilisez des périphériques.

Révision
N’essayez pas de réaliser les opérations de révision de votre ordinateur par vous-même. Le faire pourrait annulez votre
garantie et vous exposez à des chocs électriques. Pour toute opération de révision, adressez-vous à des personnes agrées.
Débranchez votre ordinateur de toute source d’alimentation. Puis adressez-vous à des professionnels agréés si vous ren-
contrez l’une des situations suivantes :
• Si le cordon d’alimentation ou l’adaptateur CA/CC est endommagé, abimé ou effiloché.
• Si votre ordinateur a été exposé à la pluie ou tout autre liquide.
• Si votre ordinateur ne fonctionne pas normalement bien que vous ayez suivi les instructions de mise en marche à la lettre.
• Si votre ordinateur est tombé par terre ou a été endommagé de quelque manière que ce soit (ne touchez pas le liquide qui sortirait 

de l’écran LCD au cas où celui-ci serait cassé : il est très dangereux et contient des produits qui pourraient vous empoisonner).
• Si une odeur inhabituel, de la chaleur ou de la fumée apparaissait sortant de votre ordinateur.
Instructions d’entretien et d’utilisation - 87
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Sécurité electrique
Votre ordinateur possède des besoins en énergie propre :
• Utilisez uniquement un adaptateur CA/CC agréé avec votre ordinateur. 
• Votre adaptateur CA/CC peut avoir été conçu pour les voyages internationaux mais il lui faut tout de même une source de courant 

régulière et ininterrompue. Si vous n’êtes pas sûr des caractèristiques du réseau électrique local, consultez notre représentant de 
service ou la compagnie électrique locale.

• L’adaptateur CA/CC que vous utilisez, peut être à 2 broches ou à 3 broches, comprenant une prise de terre. Cette prise de terre est 
un des éléments de sécurité importants, ne vous en passez pas ! Si une prise murale compatible n’est pas disponible, demandez à un 
électricien qualifié de vous en installez une. 

• Quand vous voulez débrancher le cordon d’alimentation, ne tirez pas sur le fil, mais attrapez la tête de la prise. 
• Assurez-vous que la prise murale et la (les) rallonge(s) que vous utilisez peuvent supporter la consommation électrique de tous les 

appareils qui y sont reliées.
• Avant de nettoyez votre ordinateur, assurez-vous qu’il n’est relié à aucune source de courant.

Nettoyage
• N’appliquez pas de produit de nettoyage directement sur l’ordinateur, utilisez un bout de tissu propre et souple. 
• N’utilisez pas de produit de nettoyage volatil (des distillés pétrôle) ou abrasifs sur aucun des éléments de l’ordinateur.

Mise en garde pour le sécurité electrique
Avant d’entreprendre des procédures de mise à niveau, assurez-vous d’avoir éteint l’ordina-teur, et déconnecté tous les périphériques et
câ-bles (y compris les cor-dons téléphoniques). Il est également conseillé d’enlever la batterie afin d’éviter d’allumer l’ap-pareil par mégarde.

Eteignez avant de partir en voyage
Assurez-vous que votre notebook est complètement éteint avant de le mettre dans un sac de voyage (ou tout autre bagage similaire). Si
vous placez le notebook allumé dans un sac de voyage, cela peut obstruer la (les) ventilation(s). Pour éviter que votre ordinateur ne sur-
chauffe, assurez-vous que rien n'obstrue la (les) ventilation(s) quand l'ordinateur est en cours d'utilisation.
88 -  Instructions d’entretien et d’utilisation
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Précautions à prendre pour la batterie
• Utilisez uniquement des batteries conçues pour votre ordinateur. Un mauvais type de batterie peut provoquer des explosions, des 

fuites et/ou endommager votre ordinateur.
• Ne continuez pas d'utiliser une batterie qui est tombée, ou qui paraît endommagée (ex: tordue ou vrillée) d'une manière quelconque. 

Même si l'ordinateur continue de fonctionner avec la batterie en place, cela peut détériorer le circuit, pouvant déclencher un incendie.
• Rechargez les batteries en utilisant le système de l’ordinateur portable. Un rechargement incorrect peut provoquer l’explosion de la 

batterie.
• N’essayez jamais de réparer la batterie. Au cas où votre batterie aurait besoin d’être réparée ou changée, veuillez vous adresser à 

votre représentant de service ou à des professionnels qualifiés.
• Gardez les batteries endommagées hors de portée des enfants et débarrassez-vous en le plus vite possible. Veuillez toujours jeter les 

batteries avec précautions. Les batteries peuvent exploser ou se mettre à fuire si elles sont exposées au feu ou si elles sont manipu-
lées ou jetées d’une façon non appropriée.

• Gardez la batterie loin des appareils métalliques.
• Placez un morceau de scotch sur les contacts de la batterie avant de la jeter.
• Ne touchez pas les contacts de la batterie avec les mains ou avec des objects en métal.

Elimination de la batterie & avertissement

Le produit que vous venez d’acheter contient une batterie rechargeable. Cette batterie est recyclable. Quand elle n’est plus utili-
sable, en fonction des lois locales des différents états et pays, il peut être illégal de s’en débarrasser en la jetant avec les ordures
ménagères normales. Vérifiez auprès du responsible local de l’élimination des déchets solides de votre quartier pour vous infor-
mer des possibilités de recyclage ou de la manière appropriée de la mettre au rebut.

Il existe un danger d’explosion si la batterie est replacée de façon incorrecte. Remplacez-la uniquement par des batteries de
même type ou de type équivalent, recommendé par le fabricant. Eliminez les batteries usagées selon les instructions du fabricant.
Instructions d’entretien et d’utilisation - 89
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Différences de Modèles
Cette série de notebooks comprend quatre types de modèles différents (chaque modèle comprend différents styles de de-
sign). L'aspect extérieur exact et certaines des boutons Hot-Key peuvent apparaître légèrement différents de ce qui est il-
lustré dans ce manuel, cependant les ports, les composants et les fonctions etc. sont tous les mêmes pour chaque style de
design.Les modèles diffèrent comme indiqué dans le tableau ci-dessous.

Tableau 1 - Différences entre modèles

Caractéristique Modèle A Modèle B Modèle C Modèle D

Core logic SiS M672 + SiS968 SiS M671DX + SiS968

Adaptateur Vidéo Vidéo intégrée SiS (Interne sur puce) Vidéo discret NVIDIA (Externe sur carte)

Adaptateur CA/CC 65W (Sortie c.c. 19V, 3,42A ou 18,5V, 3,5A) 90W (Sortie c.c. 19V, 4,74A)

Tipo de LCD 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 
WSXGA+ 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 

WSXGA+

Lecteur d'empreintes 
digitales Non Non Option Option
90 -  Instructions d’entretien et d’utilisation
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Guide de démarrage rapide
1. Enlevez tous les emballages.
2. Posez l’ordinateur sur une surface stable.
3. Connectez fermement les périphériques que vous souhaitez utiliser avec votre ordinateur portable (par ex. clavier et souris) à leurs 

ports respectifs.
4. Branchez l'adaptateur CA/CC à la prise d'entrée CC sur la gauche de l’ordinateur, branchez ensuite le cordon secteur à une prise 

murale, puis à l’adaptateur CA/CC.
5. D'une main, soulevez soigneusement le couvercle/LCD pour obtenir un angle de vision confortable (ne pas dépasser 130 degrés), 

de l'autre main (comme illustré dans la Figure 1 ci-dessous) maintenez la base de l'ordinateur (Remarque : Ne soulevez jamais 
l'ordinateur par le couvercle/LCD).

6. Pressez le bouton de mise en marche pour allumer.

Figure  1 - Ouvrir le couvercle/LCD/ordinateur avec un adaptateur CA/CC branché

Arrêt

Veuillez noter que vous devriez toujours éteindre votre ordinateur en utilisant la commande Arrêter du menu du
bouton de verrouillage de Windows Vista. Cette précaution évite des problèmes de disque dur ou de système.
Guide de démarrage rapide - 91
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Logiciel système
Votre ordinateur peut être livré avec un logiciel système
pré-installé. Si ce n’est pas le cas, ou si vous re-configurez
votre ordinateur pour un système différent, vous constaterez
que ce manuel fait référence au système d’exploitation Mi-
crosoft Windows Vista. De plus amples informations sur
l’installation des pilotes et utilitaires sont disponibles aux
Chapitres 4 & 7 du Manuel de l’Utilisateur sur le CD-ROM
Device Drivers & Utilities + User’s Manual.

Systèmes d'exploitation pris en charge

Non inclus
Les Systèmes d’exploitation (par ex. Windows Vista/Win-
dows XP, etc.) ainsi que les applications (par ex. program-
mes de traitement de texte, tableur et base de données) ont
leurs propres manuels, aussi veuillez consulter les manuels
appropriés.

Pilotes

Si vous installez/réinstallez un nouveau logiciel système, vous
devrez installer les pilotes appropriés. Les pilotes sont les pro-
grammes qui servent d'interface entre l'ordinateur et un maté-
riel, par exemple un module réseau sans fil. Il est très
important d'installer les pilotes dans l'ordre indiqué dans le
Tableau 6 à la page 106. Vous ne pourrez pas utiliser les con-
trôles les plus avancés tant que les pilotes et les utilitaires né-
cessaires n'auront pas été correctement installés.

Système 
d’exploitation Remarque

Windows XP 
(Home Edition ou 

Professional)

Pour les informations sur le système 
d'exploitation Windows XP (consultez le 
CD-ROM Device Drivers & Utilities 
+User’s Manual).

Windows Vista 
avec Service Pack 

1 (64-bit) Home 
Basic Edition/

Home Premium 
Edition/Business 
Editon/Enterprise 
Editon/Ultimate 

Editon

Prenez soin d'installer Windows Vista 
Service Pack 1 (ou une version de Win-
dows Vista comprenant Service Pack 1), 
avant d'installer tout pilote. Consultez 
le site de Microsoft pour télécharger les 
informations détaillées, ou contactez le 
service clientèle.

Pour utiliser Windows Vista sans limita-
tions ni baisse de performances, votre 
ordinateur doit comporter au minimum 
1Go de mémoire vive (RAM).
92 -  Logiciel système
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Carte du système : Vue de face avec l’écran LCD 
ouvert (Modèles A & C)

Figure 2
 Vue du face avec 
l’écran LCD ouvert 

(Modèles A &C)

1. Caméra PC optionnelle
2. Écran LCD 
3. Haut-parleurs
4. Bouton de mise en 

marche
5. Boutons Hot-Key
6. Clavier
7. Microphone
8. Pavé tactile (TouchPad) 

et boutons
9. Lecteur d'empreintes 

digitales (optionnel 
pour Modèles C & D 
seulement)

10. Indicateurs LED

Utilisation des appareils sans 
fil à bord d'un avion

L'utilisation de tout appareil
électronique de transmission
est généralement interdite à
bord d'un avion. Assurez-vous
que les modules sans fil sont
éteints si vous utilisez l'ordi-
nateur à bord d'un avion. 

Utilisez les combinaisons de
touches pour basculer l'alimen-
tation sur les modules 3.5G/
WLAN/Bluetooth, et reportez-
vous à l'icône d'indicateur/barre
des tâches d'état pour voir si les
modules sont allumés ou pas
(voir le Tableau 3 à la page 95/
le Tableau 5 à la page 97).

2

5

1

7

8

4

6

9

33

10 10
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Carte du système : Vue de face avec l’écran LCD 
ouvert (Modèles B & D)

Figure 3
 Vue du face avec 
l’écran LCD ouvert 

(Modèles B & D)

1. Caméra PC optionnelle
2. Écran LCD 
3. Haut-parleurs
4. Bouton de mise en 

marche
5. Boutons Hot-Key
6. Clavier
7. Microphone
8. Pavé tactile (TouchPad) 

et boutons
9. Lecteur d'empreintes 

digitales (optionnel 
pour Modèles C & D 
seulement)

10. Indicateurs LED

Utilisation des appareils sans 
fil à bord d'un avion

L'utilisation de tout appareil
électronique de transmission
est généralement interdite à
bord d'un avion. Assurez-vous
que les modules sans fil sont
éteints si vous utilisez l'ordi-
nateur à bord d'un avion. 

Utilisez les combinaisons de
touches pour basculer l'alimen-
tation sur les modules 3.5G/
WLAN/Bluetooth, et reportez-
vous à l'icône d'indicateur/barre
des tâches d'état pour voir si les
modules sont allumés ou pas
(voir le Tableau 3 à la page 95/
le Tableau 5 à la page 97).
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7

8

4

6

9

33

10 10
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Indicateurs LED
Les deux ensembles de indicateurs LED (indicateurs
d’etat et indicateurs d’alimentation et de
communication) sur votre ordinateur affichent des
informations utiles sur l’état actuel de votre ordinateur.

Tableau 2 - Indicateurs d’etat

Tableau 3 - Indicateurs d’alimentation et de 
communication

Icône Couleu Description

Vert Le disque dur est en cours d'utilisation

Vert Verrouillage numérique (pavé numéri-
que) activé

Vert Verrouillage majuscule activé

Vert Verrouillage défilement activé

Icône Couleur Description

Orange L'adaptateur CA/CC est branchée

Vert L’ordinateur est allumé

Vert 
clignotant

Le système est dans le mode de 
Veille configuré

Orange La batterie est en charge

Vert La batterie est complètement char-
gée

Orange
clignotant

La batterie a atteint le niveau bas 
critique

Vert Le module LAN sans fil est allumé

Orange Le module Bluetooth est allumé
Indicateurs LED - 95
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Boutons Hot-Key & clavier
Les boutons Hot-Key donnent un accès instantané au navi-
gateur Internet par défaut et au programme de messagerie,
et vous permettent d'activer/désactiver le Mode Silencieux
d'une simple pression sur un bouton.

Tableau 4 - Boutons Hot-Key

*Quand il est activé, le Mode Silencieux diminuera le bruit
du ventilateur et permettra de consommer moins de courant.
Remarquez que cela peut diminuer les performances de l'or-
dinateur.

Le clavier est doté d'un pavé numérique intégré pour une
saisie des données numériques plus facile. Il est également
doté de touches fonction pour vous permettre de changer
instantanément de mode opérationnel (voir la Figure 4).

Figure 4 - Clavier

Bouton Hot-Key Fonction

Activer le programme d’e-mail par 
défaut

Activer le navigateur Internet par 
défaut

Passer en Mode Silencieux* (pour 
l'économie d'énergie)

Pavé numérique

Touche Fn

Touches
NumLk & ScrLk 

Touches Fonction

Activer/ Désactiver 
le module 3.5G

Caractères Spéciaux 

Certaines applications permettent que les touches du pavé
numérique soient utilisées avec Alt pour produire des carac-
tères spéciaux. Ces caractères spéciaux peuvent être pro-
duits uniquement en utilisant le pavé numérique. Les touches
normales des chiffres (sur la rangée supérieure du clavier) ne
le permettent pas. Assurez-vous que NumLk (pavé numéri-
que) soit allumé.
96 -  Boutons Hot-Key & clavier
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Touches fonction & indicateurs visuels
Les touches de fonctions (F1-F12 etc.) agiront comme touches de raccourci (hot-key) quand pressée en maintenant la
touche Fn appuyée. En plus des combinaisons des touches de fonction de base, les indicateurs visuels sont disponibles
quand le pilote de touches de raccourci (HotKey Driver) est installé (reportez-vous à “Hot-Key” à la page 107). Une fois
le pilote installé une icône  apparaîtra dans la barre des tâches.

Touches Fonction/indicateurs visuels Touches Fonction/indicateurs visuels

Fn + ~ Lecture/Pause (dans les programmes audio/vidéo) Fn + F8/F9
Diminution/Augmenta-
tion de la luminosité 
de l’écran LCD

Fn + 
Activer/Désactiver le 
module 3.5G Fn + F10 Activer/Désactiver le 

module Caméra PC

Fn + F1 Activer/Désactiver le 
TouchPad Fn + F11 Activer/Désactiver le 

module LAN sans fil

Fn + F2 Eteindre le rétroéclairage LCD (Appuyez sur une 
touche ou utilisez le TouchPad pour allumer) Fn + F12 Activer/Désactiver le 

module Bluetooth

Fn + F3 Allume/Éteind le son Fn + 
NumLk

Activer/Désactiver le verrouillage numérique 
(pavé numérique)

Fn + F4 Permutation veille Fn + ScrLk Activer/Désactiver l'arrêt défilement

Fn + F5/F6
Diminution/Augmen-
tation du volume 
sonore

Activer/Désactiver le 
Mode Silencieux

Fn + F7 Alternance d'affichage
Tableau 5 - Touches de fonctions & indicateurs vi-

suels
Boutons Hot-Key & clavier - 97
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Carte du système : Vues de face & gaucheFigure 5 
 Vues de face & gauche

1. Indicateurs LED
2. Prise d’entrée CC
3. Port moniteur externe
4. Prise réseau RJ-45
5. Ventilation
6. 2 Ports USB 2.0
7. Logement 

d'ExpressCard/54(34)
8. Lecteur de carte 7-en-1

Lecteur de carte 7-en-1

Le lecteur de carte vous permet d'utiliser certaines des cartes de stockage numériques les plus res-
sentes. 

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS 
Duo (nécessite un PC adaptateur) / Mini SD (nécessite un PC adaptateur) / RS MMC (nécessite un 

PC adaptateur)

Partie face

Gauche

1

2 54
6

3
76 8
98 -  Carte du système : Vues de face & gauche
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Carte du système : Vues droite & arrière
Figure 6

Vues droite & arrière

1. Prise de sortie S/PDIF
2. Prise d'entrée de 

microphone
3. Prise de sortie haut-

parleurs/casque
4. Port USB 2.0
5. Baie de périphérique 

optique (pour lecteur CD/
DVD)

6. Trou d’ejection d’urgence
7. Prise téléphone RJ-11
8. Fente de verrouillage de 

sécurité
9. Batterie

Changer les codes régionaux des DVD

Allez au Panneau de configuration et double-cliquez
sur Gestionnaire de périphériques (Matériel et
audio), et cliquez le + à côté de Lecteurs DVD/CD-
ROM.  Double-cliquez sur le périphérique DVD-ROM
pour afficher le menu Propriétés, et sélectionnez l'on-
glet Région du DVD pour afficher le panneau de con-
figuration pour vous permettre d'ajuster le code
régional.

La détection de codes régionaux est liée à l'appareil,
pas au système d’exploitation. Vous pouvez changer le
code régional de votre module 5 fois. La cinquième sé-
lection est permanente. Elle ne peut pas être changée
même si vous changez votre système d’exploitation ou
si vous utilisez le module dans un autre ordinateur.

Ejection d’urgence du CD

Si vous devez éjecter manuellement un
CD ou DVD (par ex. suite à une coupure
de courant) vous pouvez enfoncer l’ex-
trémité d’un trombone redressé dans le
trou d’ejection d’urgence. N’utilisez pas
la pointe d’un crayon, ou tout autre objet
similaire qui pourrait se casser et rester
coincé dans le trou.

Mise en garde média

N’essayer pas d’enlever un CD pendant
que le système est en train de la lire ou
d’y écrire. Vous pourriez faire « planter »
le système.

Côté droit

Côté gauche1 52 4

9

3 6 7 8

Côté droit

Partie arrière
Carte du système : Vues droite & arrière - 99
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Carte du système : Vue d’en dessousFigure 7 
 Vue d’en dessous

1. Batterie
2. Couvercle du module 

Bluetooth 
3. Couvercle de baie CPU/

RAM
4. Ventilation
5. Couvercle de baie de 

disque dur 
6. Emplacement de la carte 

3.5G USIM

Informations batterie

Décharger puis rechargez toujours
complètement une batterie neuve
avant de l'utiliser. Déchargez complète-
ment puis rechargez la batterie au
moins une fois tous les 30 jours ou
après environ 20 décharges partielles. 

CPU

Veuillez ne pas essayer d’ouvrir ou de
forcer le processeur UC de votre ordi-
nateur. Le fait d'accéder au CPU de
quelque manière que ce soit risque de
violer la garantie.

Surchauffe

Afin de ne pas causer une surchauffe
de votre ordinateur, verifiez que rien ne
bouche la (les) ventilation(s) quand le
systeme est allume.
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Modèles A & C 

Modèles B & D 
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Menu Démarrer & Panneau de configuration de Windows Vista 
Vous pouvez accéder à la plupart des panneaux de contrôle, utilitaires et programmes dans Windows Vista (et la plupart des
autres versions de Windows) à partir du menu Démarrer. Quand vous installez des programmes et utilitaires ils seront installés
sur votre disque dur, et un raccourci sera habituellement placé dans le menu Démarrer et/ou le bureau. Faites un clic droit sur
l'icône menu Démarrer , et sélectionnez Propriétés si vous voulez personnaliser l'apparence du menu Démarrer.

A de nombreuses reprises dans ce manuel vous verrez une instruction pour ouvrir le Panneau de configuration. Vous pou-
vez accéder au Panneau de configuration à partir du menu Démarrer. Le Panneau de configuration vous permet de con-
figurer les paramètres pour la plupart des fonctionnalités clés dans Windows (ex. alimentation, vidéo, réseau, audio etc.).
Windows Vista offre les panneaux de contrôles de base pour un grand nombre des fonctionnalités, cependant de nouveaux
panneaux de contrôles sont ajoutés (ou certains existants sont améliorés) quand vous installez les pilotes énumérés dans le
Tableau 6 à la page 106.  Pour voir tous les contrôles il peut s'avérer nécessaire de basculer vers l'affichage classique.

 

Figure 8 - Menu Démarrer & Panneau de configuration

Cliquez ici pour basculer vers
l'affichage classique
Menu Démarrer & Panneau de configuration de Windows Vista - 101
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Caractéristiques vidéo
Cet ordinateur présente deux options vidéo différentes  (soit SiS pour les modèles A & B, soit NVIDIA pour les modèles
C & D). Vous pouvez permuter les périphériques d'affichage depuis le panneau de contrôle Paramètres d'affichage dans
Windows ou le Centre de contrôle SiS VGA/Panneau de configuration NVIDIA, à partir du moment où le pilote vidéo
est installé.

Pour accéder aux Paramètres d'affichage dans Windows Vista:
1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramètres et cliquez sur Panneau de 

configuration).
2. Cliquez sur Ajuster la résolution de l'écran dan le menu Apparence et personnalisation (ou double-cliquez sur 

Personnalisation > Paramètres d'affichage).
3. Déplacez le curseur sur le paramètre préféré dans Résolution:  (voir la Figure 9 à la page 103).
4. Cliquez sur la flèche et faites défiler jusqu’au paramètre préféré dans Couleurs:  (voir la Figure 9 à la page 103).
5. Cliquez sur Paramètres avancés  pour faire apparaître les onglets Paramètres avancés (voir la Figure 9 à la page 103).

Pour accéder au Centre de contrôle SiS VGA (Modèles A & B):
1. Vous pouvez accéder au Centre de contrôle SiS VGA en cliquant avec le bouton droit de la souris sur l'icône  de la barre des 

tâches SiSTray, et en sélectionnant Centre de contrôle (ou à partir du SiS VGA Control Center (Centre de contrôle SiS VGA) 
dans le Panneau de configuration de Windows).

Pour accéder au Panneau de configuration NVIDIA (Modèles C & D):
1. Vous pouvez accéder au Panneau de configuration NVIDIA en cliquant avec le bouton droit de la souris sur le bureau, et en cli-

quant sur Panneau de configuration NVIDIA (ou à partir du Panneau de configuration NVIDIA (NVIDIA Control Panel) dans le 
Panneau de configuration de Windows).

1
2

3
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Figure 9 - Paramètres d'affichage & Centre de contrôle/Panneau de configuration 
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Caractéristiques de gestion de l’alimentation
Le panneau de configuration Options d'alimentation de votre système Windows (voir la page 101) vous permet de con-
figurer la gestion d'alimentation de votre ordinateur. Vous pouvez économiser de l'énergie à l'aide de modes de gestion de
l'alimentation et configurer les options pour le bouton d'alimentation, bouton de veille, couvercle de l'ordinateur
(lorsqu'il est fermé), mode Affichage et Veille dans le menu de gauche. Remarquez que le mode de gestion d'économie
d'énergie peut avoir un impact sur les performances de l'ordinateur.

Cliquez pour sélectionner l'un des modes existants, ou cliquez sur Créer un mode de gestion d'alimentation dans le menu gau-
che et sélectionnez les options pour créer un nouveau mode. Cliquez sur Modifier les paramètres du mode et cliquez sur Mo-
difier les paramètres d'alimentation avancés pour accéder à plus d'options  de configuration.

Figure 10 - Options d’alimentation
Remarque : Veille est l'état d'économie d'énergie par défaut dans Windows Vista  
104 -  Caractéristiques de gestion de l’alimentation



Guide Utilisateur Concis

Français
Caractéristiques Audio
Vous pouvez configurer les options audio sur votre ordinateur à partir du panneau de confi-
guration de Sons  dan Windows, ou à partir de l'icône du Gestionnaire audio DD Re-
altek /  dans la barre des tâches/panneau de configuration (cliquez avec le bouton droit
sur l'icône   de la barre des tâches pour faire apparaître un menu audio). Le volume peut
aussi être réglé à l'aide de la combinaison de touches Fn + F5/F6.

Figure 11 - Gestionnaire audio DD Realtek

Réglages du Volume 
Sonore

Le niveau du volume sono-
re est réglé à l'aide du con-
trôle de volume dans
Windows (et les touches
de fonctions de volume sur
l'ordinateur). Cliquez sur
l'icône Volume dans la
barre des tâches pour véri-
fier le réglage.

 
Cliquez avec le bou-
ton droit sur l'icône  
pour accéder au
menu ci-dessus.
Caractéristiques Audio - 105
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Installation du pilote
Le CD-ROM Device Drivers & Utilities + User’s Manual
contient les pilotes et les utilitaires nécessaires pour un bon
fonctionnement de votre ordinateur. Insérez le CD-ROM  et
cliquez sur Install Drivers (bouton) ou cliquez sur Option
Drivers (bouton) pour accéder au menu de pilote optionnel.

Installez les pilotes en respectant l'ordre indiqué dans le
Tableau 6. Après avoir installé chaque pilote il apparaîtra
en grisé (si vous devez réinstaller un pilote, cliquez sur le
bouton Unlock).

Installation manuelle du pilote
Cliquez le bouton Browse CD (Parcourir le CD) dans l'ap-
plication Drivers Installer et naviguer jusqu'au fichier exé-
cutable dans le dossier de pilote approprié.

Windows Update
Après avoir installé tous les pilotes vérifiez que vous avez
activé Windows Update afin d'obtenir toutes les dernières
mises à jour de sécurité etc. (toutes les mises à jour inclu-
ront les derniers correctifs de Microsoft).

Tableau 6 - Procédure d'Installation

Pilote (Windows Vista avec SP1) Page#

Vidéo page 107

Son page 107

Modem page 107

Réseau page 107

Pavé tactile (TouchPad) page 107

Lecteur de carte page 107

Hot-Key page 107

Caméra PC (option) page 108

LAN sans fil  (option) page 111

Module 3.5G  (option) page 113

Lecteur d'empreintes digitales (option) - pour 
les Modèles C & D seulement

page 117

Bluetooth (option)
Remarque: Pas d'installation de pilote requise (voir la 
page 119)

Activer Windows Update (voir à gauche)
106 -  Installation du pilote
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Vidéo
1. Cliquez sur 1.Install Video Driver > Oui.

Modèles A & B (SiS):
2. Cliquez sur Oui (Cliquez sur Oui je veux lire le fichier 

ReadMe).
3. Cliquez sur Oui pour redémarrer votre ordinateur.

Modèles C & D (NVIDIA):
4. Cliquez sur Suivant.
5. Cliquez sur Terminer pour redémarrer votre ordinateur.

Son
1. Cliquez sur 2.Install Audio Driver > Oui.
2. Cliquez sur Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Modem
1. Cliquez sur 3.Install Modem Driver > Oui.
2. Cliquez sur OK.
3. Le modem est prêt pour la configuration de connexion.

Réseau
1. Cliquez sur 4.Install Lan Driver > Oui.
2. Cliquez sur Suivant.
3. Cliquez sur Terminer > Terminer pour redémarrer votre 

ordinateur.
4. La carte réseau est maintenant prête à être configurée.

Pavé tactile (TouchPad)
1. Cliquez sur 5.Install Touchpad Driver > Oui.
2. Cliquez sur Suivant.
3. Cliquez sur Terminer > Redémarrer maintenant pour 

redémarrer votre ordinateur.

Lecteur de carte
1. Cliquez sur 6.Install Cardreader Driver > Oui.
2. Cliquez sur Suivant > Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Hot-Key
1. Cliquez sur 7.Install HOTKEY Driver > Oui.
2. Cliquez sur Next  > Install.
3. Cliquez sur Finish > Finish pour redémarrer votre 

ordinateur.
Installation du pilote - 107



Guide Utilisateur Concis

Fr
an

ça
is
Caméra PC
Le module caméra PC utilise l'application BisonCap pour
capturer les fichiers vidéo.

Installation du pilote de la caméra PC
1. Activez le module à l'aide de Fn + F10 (l'indicateur visuel 

 à l'écran s'affichera brièvement lors de l'activation 
du module).

2. Cliquez sur Option Drivers (bouton).
3. Cliquez sur 1.PC Camera, Web cam > Oui.
4. Choisissez la langue que vous préférez, et cliquez Suivant 

> Suivant.
5. Cliquez sur Terminer pour redémarrer votre ordinateur.
6. Exécutez le programme d'application BisonCap à partir 

du raccourci sur le bureau, ou à partir de l'élément 
BisonCam dans le menu Démarrer >Programmes/Tous 
les programmes (si le matériel est éteint utilisez la 
combinaison de touches Fn + F10 pour le rallumer).

Paramétrage audio de caméra PC
Si vous souhaitez capturer de la vidéo et du son avec votre
caméra, il est nécessaire de régler les options d'enregistre-
ment du son dans Windows.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de 
configuration (ou pointez sur Paramètres et cliquez sur 
Panneau de configuration).

2. Cliquez sur Son  (Matériel et audio).
3. Cliquez sur Enregistrement (onglet).
4. Cliquez avec le bouton droit de la souris sur Microphone 

(Realtek High Definition Audio) et vérifiez que l'élément n'est 
pas désactivé.

5. Double-cliquez sur Microphone (ou sélectionnez Propriétés 
dans le menu contextuel).

6. Cliquez sur Niveaux (onglet), et réglez les curseurs 
Microphone et Ampli microphone au niveau requis.

7. Cliquez sur OK et fermez les panneaux de contrôle.
8. Exécutez le programme d'application BisonCap à partir de 

l'élément BisonCam dans le menu Démarrer > 
Programmes/Tous les programmes.

9. Allez aux en-têtes de menu des Périphériques et 
sélectionnez Microphone (Realtek....) (il devrait y avoir une 
marque sur le côté)

10. Allez aux en-têtes de menu des Capture et sélectionnez 
Capture Audio (il devrait y avoir une marque sur le côté).

Dernières informations sur le pilote de caméra PC

Reportez-vous au disque Device Drivers & Utilities + User’s Ma-
nual, et toutes les pages insérées qui accompagnent, pour les
dernières informations de mise à jour concernant le pilote de
Caméra PC, qui peuvent remplacer les informations fournies ici.
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BisonCap
L'application BisonCap est un afficheur vidéo utile pour vi-
sualiser et tester les vidéos en général, et permet de capturer
des fichiers vidéo au format .avi..

1. Démarrez le programme BisonCap  par le menu Démarrer > 
Programmes/Tous les Programmes  > BisonCam (il est 
recommandé de Définir le fichier de capture avant la cap-
ture - voir "Définir le fichier de capture" ci-dessous).

2. Allez à l'en-tête du menu Capture (si vous désirez capturer de 
l'audio, reportez-vous à “Paramétrage audio de caméra PC” 
à la page 108) et sélectionnez Démarrer la capture.

3. Cliquez sur OK (l'emplacement du fichier s'affichera dans la 
fenêtre contextuelle) pour démarrer la capture, et appuyez sur 
Echap pour arrêter (vous pouvez visionner le fichier en 
utilisant Windows Media Player).

Définir le fichier de capture
Avant de capturer des fichiers vidéo vous pouvez sélectionner
l'option Définir le fichier de capture dans le menu Fichier et
définir le nom et l'emplacement du fichier avant de capturer
(ceci permettra d'éviter d'écraser accidentellement des fi-
chiers). Définissez le nom et l'emplacement puis cliquez sur
Ouvrir, puis définissez la "Taille du fichier de capture :" et cli-
quez sur OK. Vous pouvez alors lancer le processus de capture
comme ci-dessus.

Zoom 
Le programme BisonCap vous permet de faire un zoom
avant et arrière avec la caméra.

1. Exécutez le programme d'application BisonCap.
2. Allez à l'en-tête du menu Zoom et sélectionnez Zoom avant/ 

Zoom arrière.

Prendre des images fixes
Le programme BisonCap vous permet de prendre des ima-
ges fixes.

1. Exécutez le programme d'application BisonCap.
2. Allez à l'en-tête du menu Options et sélectionnez Prendre 

une photo.                                    
3. L'image (au format JPEG) sera placée dans le dossier 

Snapshot  sur le bureau (ne pas déplacer ni renommer 
le dossier).
Caméra PC - 109
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Eliminer le scintillement d'écran
Si vous trouvez que l'écran vidéo dans le programme Bison-
Cap scintille, vous pouvez essayer d'ajuster le paramètre
dans les options Video Capture Filter... (Filtre de capture
vidéo).

1. Exécutez le programme d'application BisonCap.
2. Allez à l'en-tête du menu Options et sélectionnez Video 

Capture Filter....
3. Cliquez sur 50Hz ou 60Hz sous Fréquence dans l’onglet  

Page de propriétés.

Réduire la taille des fichiers vidéo
Notez que la capture de fichiers vidéo à haute résolution né-
cessite un espace substantiel sur le disque  pour chaque fi-
chier. Après avoir enregistré la vidéo, vérifiez la taille du
fichier vidéo (cliquez avec le bouton droit de la souris sur le
fichier et sélectionnez Propriétés) et l'espace disponible
restant sur votre disque dur (allez à Ordinateur, cliquez
avec le bouton droit de la souris sur le disque dur, et sélec-
tionnez Propriétés). Si nécessaire, vous pouvez retirer le fi-
chier vidéo enregistré sur un support amovible ex. CD,
DVD ou mémoire Flash USB.

Notez que le système Windows Vista nécessite un minimum
de 15Go d'espace libre sur la partition système du lecteur

C:. Pour éviter tout problème système, il est recommandé
d'enregistrer le fichier vidéo capturé dans un autre emplace-
ment que le lecteur C: (reportez-vous à “Définir le fichier
de capture” à la page 109), limitez la taille du fichier de la
vidéo capturée ou réduisez la résolution vidéo.

Pour réduire la taille de sortie de la résolution vi-
déo:
1. Lancez le programme BisonCap.
2. Allez à Options et faites défiler vers le bas pour 

sélectionner Video Capture Pin... (Broche de capture 
vidéo...).

3. Cliquez sur la liste déroulante Taille de sortie et 
sélectionnez une taille de résolution inférieure afin de 
diminuer la taille du fichier capturé.
110 -  Caméra PC



Guide Utilisateur Concis

Français
LAN sans fil

Installation du pilote du LAN sans fil
1. Assurez-vous que le module est allumé.
2. Cliquez sur Option Drivers (bouton).
3. Cliquez sur 2.Wireless Lan > Oui.
4. Choisissez la langue que vous préférez, et cliquez sur  

Suivant. 
5. Cliquez sur Suivant > Installer.
6. Cliquez sur Terminer pour terminer l'installation.

Remarque: Le système d'exploitation est le paramètre par dé-
faut pour le contrôle LAN sans fil dans Windows Vista. 

Se connecter à un réseau sans fil
Assurez-vous que le module LAN sans fil est allumé.

1. Cliquez sur l'icône de  WLAN  dans la barre des tâches, et 
puis cliquez sur Connexion à  un réseau (ou cliquez avec le 
bouton droit de la souris sur l'icône , et puis cliquez sur 
Connexion à  un réseau).

2. Dans la liste Afficher, cliquez pour choisir Sans fil dans le 
menu déroulant.

3. Une liste des réseaux actuellement disponibles apparaîtra.
4. Cliquez sur un réseau, et cliquez ensuite sur Connecter.
5. Si vous ne voyez pas de réseau auquel vous voulez vous 

connecter, cliquez sur Configurer une connexion ou un 
réseau (une liste d'options apparaîtra permettant une 
recherche manuelle, et créant un nouveau réseau).

6. Déplacez le curseur sur l'icône  de la barre des tâches pour 
voir l'état de la connexion.

7. Pour vous déconnecter du réseau sans fil, vous pouvez 
cliquer sur l'icône , sans fil de la barre des tâches, et 
sélectionner ensuite Se connecter ou se déconnecter pour 
accéder au menu réseau, et cliquez sur Déconnecter (ou 
cliquez avec le bouton droit de la souris sur l'icône , et puis 
cliquez sur Déconnexion de).

Actionner l'alimentation pour le module LAN sans fil

Allumer le module LAN sans fil à l'aide de la combinaison de
touches (Fn + F11). Quand le module LAN sans fil est sous
tension, la LED  sera vert et l'indicateur visuel  à
l'écran s'affichera brièvement.
LAN sans fil - 111
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Module 3.5G
Si votre option d'achat comporte un module 3.5G option-
nel, suivez les instructions ci-dessous pour installer la carte
USIM (qui vous sera fournie par votre fournisseur de servi-
ce), et installez ensuite l'application.

1. Eteignez l'ordinateur, retournez-le et retirez la batterie.
2. Repérez le couvercle de la carte SIM et desserrez la vis  

dans la Figure 12.
3. Retirez le couvercle  dans la Figure 12.
4. Insérez la carte USIM comme vous le feriez dans votre 

téléphone mobile.
5. Faites coulisser le SIMLOCK vers la charnière (dans la 

direction opposée à celle de la flèche illustrée dans la Figure 
13) afin de libérer le verrouillage et le soulever.

Figure 12 - Retirer le couvercle de la carte SIM

6. Insérez la carte SIM comme illustré dans (Figure 13) et 
fermez le SIMLOCK.

7. Verrouillez le SIMLOCK en appuyant sur celui-ci dans la 
direction de la flèche dans la Figure 13 jusqu'à ce qu'elle se 
mette en position verrouillée en émettant un clic.

8. Replacez le couvercle, la vis et la batterie.

Figure 13 - Insérez la carte USIM & verrouillez le 
SIMLOCK

Mise en garde pour le sécurité electrique
Avant d’entreprendre des procédures de mise à niveau, assu-
rez-vous d’avoir éteint l’ordina-teur, et déconnecté tous les pé-
riphériques et câ-bles (y compris les cor-dons téléphoniques). Il
est également conseillé d’enlever la batterie afin d’éviter d’allu-
mer l’ap-pareil par mégarde.

1

2

2

1
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Application 3G Watcher
Le module 3.5G et la carte USIM (fournie par votre four-
nisseur de service) étant installés vous pouvez alors installer
l'application 3G Watcher. L'application 3G Watcher vous
permet d'accéder directement à votre service internet 3.5G
depuis l'ordinateur.

Installation de l'application 3G Watcher
1. Assurez-vous que vous avez activé l'alimenation du 

module en appuyant sur la combinaison de touches Fn + 
 (l'indicateur visuel  à l'écran, indiquera l'état 

d'alimentation du module).
2. Si l’assistant Nouveau matériel détecté apparaît, cliquez 

sur Annuler.
3. Cliquez sur Option Drivers (bouton).
4. Cliquez sur 3.3G Driver  > Oui.
5. Cliquez sur Suivant.
6. Cliquez sur le bouton J’accepte les termes de ce contrat 

de licence, puis cliquez sur Installer.
7. Quand l'écran suivant apparaît patientez environ 2 

minutes avant de cliquer sur Terminer (pour permettre 
au matériel de détecter le module 3.5G).

8. L'icône  3G Watcher  apparaît sur le bureau.
9. Vous pouvez accéder à l’application 3G Watcher depuis 

le menu Démarrer (Démarrer > Programmes/Tous les 
programmes > 3G Watcher), ou en cliquant sur l'icône 

 dans la barre des tâches.

Installer un profil de porteuse
Bien que les informations de connexion soient stockées sur
la carte USIM fournie par le fournisseur de service, vous de-
vrez installer le profil de porteuse approprié à l'aide du logi-
ciel 3G Watcher.

1. Utilisez la combinaison de touches Fn +  pour allumer le 
module 3.5G.

2. Vous pouvez accéder à l’application 3G Watcher depuis le 
menu Démarrer (Démarrer > Programmes/Tous les 
programmes > 3G Watcher), ou en cliquant sur l'icône  
dans la barre des tâches.

3. Cliquez sur Outils et sélectionnez Options.
4. Cliquez sur Profils et puis sur Ajouter un profil  (bouton) 

et sélectionnez Profil d’accès distant.

Figure 14 - Ajouter un profil WWAN
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5. Vous pouvez ensuite entrer un nouveau nom de profil ou 
choisir un profil dans la liste déroulante fournie par le logiciel.

6. Cliquez sur Appliquer > OK pour enregistrer les informations.
7. Vous pouvez choisir le profil dans le menu déroulant.

Figure 15 - Options de l'utilisateur et choix du profil

Connexion au fournisseur d'accès
1. Utilisez la combinaison de touches Fn +  pour allumer 

le module 3.5G.
2. Vous pouvez accéder à l’application 3G Watcher depuis 

le menu Démarrer (Démarrer > Programmes/Tous les 
programmes > 3G Watcher), ou en cliquant sur l'icône 

 dans la barre des tâches.
3. Le logiciel s'exécutera et affichera le nom du fournisseur 

de service (les informations de connexion sont obtenues 
depuis la carte USIM).

Figure 16 - 3G Watcher
4. Cliquez sur Se connecter pour démarrer le processus de 

connexion.
5. L'application 3G Watcher affichera alors les informations 

de connexion dans la fenêtre.

Figure 17 - Connexion

Détails du profil

Si vous avez choisi le profil dans la liste déroulante alors la
plupart des informations dans les onglets Général et Avancé
devraient être automatiquement remplies pour vous (cepen-
dant consultez votre fournisseur de service pour les dernières
informations car vous aurez besoin d'ajouter au moins votre
Nom d'utilisateur et votre Mot de passe).
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6. Quand la connexion est réussi une notification apparaîtra 
dans la barre des tâches (comme ci-dessous).

Figure 18 - Notification de connexion de la barre des 
tâches

7. Vous pouvez accéder à Internet, télécharger des e-mails 
etc. comme toute connexion Internet.

8. Quand vous êtes connecté l'icône de la barre des tâches est 
verte  (elle devient rouge  quand le programme est 
en cours d'exécution mais non connecté).

9. Pour déconnecter cliquez sur l'icône Déconnecter.

Figure 19 - 3G Watcher connecté
10. Le programme se déconnectera du fournisseur de service.
11. Le module sera toujours allumé, et vous devrez appuyer 

sur la combinaison de touches Fn + .

12. Si vous cliquez sur l'icône  de fermeture de 3G Watcher 
un message s'affichera vous demandant de cliquer sur OK 
pour confirmer de quitter le programme. 

13. Le fait de quitter le programme N'ÉTEINT PAS le module 
3.5G, et vous devrez appuyer sur la combinaison de 
touches Fn +  pour éteindre le module (faites très 
attention à cela à bord d'un avion - reportez-vous à 
“Utilisation des appareils sans fil à bord d'un avion” à la 
page 86).

14. Si le module est allumé et que l'ordinateur entre en état 
d'économie d'énergie, alors l'état d'alimentation du module 
reprenant à partir de l'état d'économie d'énergie sera 
comme indiqué au verso.
• Si le module 3.5G est allumé et que l'ordinateur est 

Eteint/et que vous Redémarrez l'ordinateur; le module 
sera éteint au démarrage de l'ordinateur.

• Si le module 3.5G est allumé et que l'ordinateur entre en 
Veille/Veille prolongée; le module sera éteint quand 
l'ordinateur sortira de la veille.

Figure 20
Avertissement pour 

Quitter
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Service de messagerie court
En plus des services internet traditionnels, vous pouvez aus-
si envoyer et recevoir des messages texte SMS à l'aide du
programme 3G Watcher.

1. L'indicateur  de message SMS dans la fenêtre princi-
pale vous informera de la réception des nouveaux messa-
ges.

2. Double-cliquez sur l'icône  ou sélectionnez Outils > 
SMS Express....

3. Sélectionnez le dossier de boîte de réception et 
sélectionnez un message pour le lire, ou sélectionnez 
Fichier > Nouveau message eléctronique ou cliquez sur 
le bouton Nouveau pour préparer un nouveau message.

Pour plus de détails sur SMS voir l'aide en ligne de 3G
Watcher dans le menu Aide > Rubriques d'aide.

Aide en ligne de 3G Watcher

Pour plus de détails sur l'application 3G Watcher vous pouvez
accéder à l'Aide en ligne depuis le menu Aide > Rubriques
d'aide.

Cliquez sur une rubrique dans la fenêtre Table des matières
pour afficher les détails.
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Lecteur d'empreintes digitales
Si votre option d'achat comporte un lecteur d'empreintes di-
gitales (En option pour les ordinateurs de Modèle C & D
seulement) vous devrez installer le pilote en vous reportant
aux instructions ci-dessous.

Vérifiez que vous avez les droits d'administrateur sur votre
ordinateur, et que vous avez un mot de passe Windows
activé pour une protection totale.

Avant de commencer le processus d'enregistrement, il est
recommandé de prendre connaissance du didacticiel d'em-
preintes digitales. Pour lancer le didacticiel cliquez sur Dé-
marrer > Programmes/Tous les programmes >
Protector Suite QL > Didacticiel de Fingerprint.

Installation du pilote du lecteur d'em-
preintes digitales
1. Insérez le CD-ROM Device Drivers & Utilities + User’s 

Manual dans le lecteur de CD/DVD.
2. Cliquez sur Option Drivers (bouton).
3. Cliquez sur 4.FingerPrint > Oui.
4. Cliquez sur Installation du logiciel.
5. Cliquez sur Suivant > Suivant > Suivant.
6. Cliquez sur Terminer > Qui pour terminer l'installation.

Enregistrement de l'utilisateur
1. Cliquez sur Démarrer > Programmes/Tous les program-

mes > Protector Suite QL > Enregistrement d’utilisateurs, 
ou double-cliquez sur l’icône  dans la barre des tâches. 

2. Lors du premier lancement du programme, vous serez invité à 
cliquer sur le bouton pour accepter la licence, et cliquer 
ensuite sur OK.

3. Cliquez sur Suivant (“Enregistrement sur le disque dur” 
sera automatiquement sélectionné) et cliquez sur Oui.

Aide & Manuel

Faites un clic droit sur l'icône  de la barre des tâches pour
faire apparaître le menu afin de sélectionner Aide.

Insérez le CD-ROM Device Drivers & Utilities + User’s Ma-
nual et cliquez sur Option Drivers (bouton). Cliquez sur Un-
lock (bouton) et puis cliquez sur 4.FingerPrint > Oui.

Cliquez sur Documentation pour ouvrir le dossier conte-
nant le manuel au format .pdf.

Pour installer le logiciel Adobe Acrobat Reader pour lire le fi-
chier, insérez le CD-ROM Device Drivers & Utilities + User's
Manual et cliquez sur User's Manual (bouton), et cliquez sur
Install Acrobat Reader (bouton).
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4. Si vous n'avez pas défini de mot de passe de Windows vous 
serez invité à le faire (remarque: Si vous n'avez pas défini de 
mot de passe, Protector Suite QL ne peut pas sécuriser 
l'accès à votre ordinateur).

5. Cliquez sur Suivant et vous serez invité à entrer votre mot de 
passe de Windows.

6. Cliquez sur Suivant > Suivant (cochez la case à cocher 
“Lancer le didacticiel interactif” pour prendre connaissance 
du didacticiel Fingerprint).

7. Cliquez sur Suivant pour chaque fenêtre du didacticiel (vous 
pouvez cliquer sur le bouton “Passer le didacticiel” à tout 
moment).

8. Cliquez sur le bouton au-dessus l'un des doigts pour lancer 
l'enregistrement de ce doigt.

9. Tapez trois fois le doigt pour enregistrer ce doigt.
10. Répétez le processus pour tous les doigts que vous voulez 

enregistrer, puis cliquez sur Suivant.
11. Cliquez sur Terminer.
12. Cliquez sur l'un des en-têtes “En savoir plus sur” pour 

obtenir plus d'informations sur tous les sujets.
13. Cliquez sur Fermer.
14. Redémarrez l'ordinateur.
15. Faites un clic droit sur l'icône  de la barre des tâches pour 

faire apparaître le menu vous permettant d'Modifier les 
empreintes digitales, Lancer le Centre de contrôle, accéder 
au menu Aide etc. Vous pouvez aussi exécuter le Centre de 
contrôle etc. à partir de l'élément Protector Suite QL dans le 
menu Démarrer > Programmes/Tous les programmes.

16. Reportez-vous à “Aide & Manuel” à la page 117 pour plus 
de détails.

17. Si vous passez votre doigt sur le lecteur, à tout moment, vous 
pouvez accéder au Biomenu pour Verrouiller l'ordinateur, 
Enregistrer des sites web, Déverrouiller Mon coffre, ouvrir 
le Centre de contrôle et accéder au menu Aide.

18. Le Centre de contrôle vous permet de modifier les 
Paramètres, enregistrement d'empreintes numériques et 
d'obtenir de l'Aide.

Figure 21 - Centre de contrôl & Biomenu

Enregistrement de l'empreinte digitalet

Il est fortement recommandé d'enregistrer plus d'un doigt
en cas de blessure etc.
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Configuration Bluetooth
Configurez votre périphérique Blue-
tooth afin que votre ordinateur le trouve
1. Allumez votre périphérique Bluetooth (ex. PDA, téléphone 

mobile etc.).
2. Rendez le périphérique détectable (pour cela consultez la 

documentation de votre périphérique).

Allumer le module Bluetooth
1. Activez le module Bluetooth à l'aide de Fn + F12. 
2. Une icône  Bluetooth apparaîtra sur la barre des tâches 

(vous devrez peut-être activer l'option à partir du panneau de 
contrôle des périphériques Bluetooth).

3. Vous pouvez alors procéder comme suit pour accéder au 
panneau de contrôle des périphériques Bluetooth.

• Double-cliquez sur l'icône  pour accéder au panneau de 
contrôle des périphériques Bluetooth.

• Cliquez sur le menu Démarrer et cliquez sur Panneau de 
configuration (ou pointez sur Paramètres et cliquez sur 
Panneau de configuration), et puis cliquez sur Périphéri-
ques Bluetooth (Matériel et audio).

• Cliquez/Cliquez avec le bouton droit de la souris sur 
l'icône  et sélectionnez une option dans le menu.

Figure 22 - Périphériques Bluetooth  et cliquer sur le Menu 
d'icône

Ajouter un périphérique Bluetooth
1. Accédez au panneau de contrôle des périphériques Bluetooth.
2. Cliquez sur Options (onglet), et assurez-vous que la case à 

cocher Autoriser les périphériques Bluetooth à se 
connecter à cet ordinateur (Connexions) est cochée.

3. Cliquez sur Périphériques (onglet), et puis cliquez sur 
Ajouter.

Transfert de données 
Bluetooth

Remarquez que le trans-
fert de données entre l'or-
dinateur et un
périphérique Bluetooth est
pris en charge dans une
direction seulement (le
transfert simultané de
données n'est pas pris
en charge).
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4. L’Assistant Ajout de périphérique Bluetooth apparaît.
5. Cliquez pour choisir “Mon périphérique est configuré et 

prêt à être détecté.”, et puis cliquez sur Suivant.

Figure 23 - Assistant Ajout de périphérique Bluetooth

6. L'Assistant recherchera alors tous les périphériques 
Bluetooth disponibles à portée.

7. Sélectionnez le périphérique avec lequel vous souhaitez 
communiquer et cliquez sur Suivant.

8. Sélectionnez une option de clé de sécurité appropriée et 
cliquez sur Suivant > Terminer.

Figure 24 - Option de clé de sécurité

Changer les paramètres du périphéri-
que Bluetooth
1. Accédez au panneau de contrôle des périphériques Bluetooth.
2. Cliquez sur le périphérique que vous voulez modifier et 

cliquez sur Propriétés pour:
• Changer le nom du périphérique (cliquez sur Général, 

tapez un nouveau nom et cliquez sur OK).
• Activer/Désactiver un service (cliquez sur Services, 

cochez/décochez la case à cocher proche du service et cli-
quez sur OK).

Pour rendre votre ordinateur détectable 
aux périphériques Bluetooth
1. Accédez au panneau de contrôle des périphériques Bluetooth.
2. Cliquez sur Options (onglet), et assurez-vous que la case à 

cocher Autoriser les périphériques Bluetooth à rechercher 
cet ordinateur (Découverte) est cochée.

3. Assurez-vous que la case à cocher M'avertir lorsqu’un 
nouveau périphérique Bluetooth souhaite se connecter 
(Connexions) est cochée, si vous voulez être averti quand un 
périphérique Bluetooth veut se connecter.

Figure 25
Périphériques 

Bluetooth -  
Options
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Dépannage
Problème Cause possible - résolution

Les modules LAN sans fil/ 
Bluetooth ne peuvent pas être 
détectés.

Le(s) module(s) est (sont) désactivé(s). Vérifiez l'indicateur LED  pour voir si le(s) module(s) 
est (sont) activé(s) ou désactivé(s). Si l'indicateur LED est désactivé, alors appuyez sur la (les) 
combinaison(s) de touches Fn + F11 (WLAN) ou Fn + F12 (Bluetooth) key combination(s)  pour 
activer le(s) module(s) (voir le Tableau 5 à la page 97).

Le module Bluetooth est 
désactivé après la reprise 
depuis Veille.

L'état par défaut du module Bluetooth sera désactivé après la reprise à partir de l'état Economie 
d'énergie de veille. Utilisez la combinaison de touches (Fn + F12) pour activer le module Bluetooth 
quand l'ordinateur reprend à partir de l'état de Veille.

Un fichier ne peut être copié 
sur/depuis un périphérique 
Bluetooth connecté.

Le transfert de données entre l'ordinateur et un périphérique Bluetooth est pris en charge dans 
une direction seulement (le transfert simultané de données n'est pas pris en charge). Si 
vous copiez un fichier depuis votre ordinateur sur un périphérique Bluetooth, vous ne pourrez pas 
copier un fichier à partir d'un périphérique Bluetooth sur votre ordinateur tant que le transfert de 
fichier depuis l'ordinateur ne sera pas terminé.

Les fichiers vidéo capturés 
depuis la Caméra PC prennent 
trop de place sur le disque.

Notez que la capture de fichiers vidéo à haute résolution nécessite un espace substantiel sur le 
disque pour chaque fichier.

Notez que le système Windows Vista nécessite un minimum de 15Go d'espace libre sur la 
partition système du lecteur C:. Il vous est recommandé d'enregistrer le fichier vidéo capturé dans 
un autre emplacement que le lecteur C:, limitez la taille du fichier de la vidéo capturée ou réduisez 
la résolution vidéo (Options > Video Capture Pin... > Taille de sortie). Reportez-vous à 
“Réduire la taille des fichiers vidéo” à la page 115.
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Spécifications

Caractéristique Spécification

Types de 
processeurs

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T8100/ T8300

(45nm) Procédé de gravure en 45 nm
Cache L2 3Mo & Bus principal à 800MHz 
2,1/ 2,4 GHz

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T9300/ T9500

(45nm) Procédé de gravure en 45 nm
Cache L2 6Mo & Bus principal à 800MHz 
2,5/ 2,6 GHz

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T7100/ T7250

(65nm) Procédé de gravure en 65 nm
Cache L2 2Mo & Bus principal à 800MHz 
1,8/ 2,0 GHz

Processeur Intel Core 2 Duo
Micro-FCPGA package (478-broches)
T7300/ T7500/ T7700/ T7800

(65nm) Procédé de gravure en 65 nm
Cache L2 4Mo & Bus principal à 800MHz 
2,0/ 2,2/ 2,4/ 2,6 GHz

Dernières informations de spécification

Les spécifications énumérées dans cet Appendice sont correctes à l'heure de la mise sous presse. Certains éléments (parti-
culièrement les types de processeur/vitesse unique) peuvent être modifiés ou mis à niveau en fonction du calendrier des pa-
rutions du fabricant. Voyez auprès de votre service clientèle pour les détails.
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Processeur Intel Celeron M
Micro-FCPGA package (478-broches)
530/ 540/ 550/ 560

(65nm) Procédé de gravure en 65 nm
Cache L2 1Mo & Bus principal à 533MHz 
1,73/ 1,86/ 2,0/ 2,13 GHz

Core logic Modèles A & B
Chipset SiS M672 + SiS968

Modèles C & D
Chipset SiS M671DX + SiS968

Options d’écrans 
LCD

Modèles A & C
14,1" - WXGA/ WXGA+ Type Ecran Plat TFT Reflet

Modèles B & D
15,4" - WXGA/ WXGA+/ WSXGA+ Type Ecran Plat 
TFT Reflet

Affichage Modèles A & B
Vidéo intégrée SiS M672 (Interne sur puce)

Accélérateur graphique 2D/3D de haute 
performance
Architecture de mémoire partagée (jusqu'à 
256Mo de mémoire vidéo partagée attribuée 
dynamiquement à partir de la mémoire système 
quand nécessaire)
Prend totalement en charge DirectX® 9
Supporte Vertex Shader 2.0 et Pixel Shader 2.0

Modèles C & D
Vidéo discrète NVIDIA GeForce 9300M GS 
(Externe sur carte)

RAM Vidéo interne GDDR2 256Mo
TurboCache™ supportant la mémoire 
graphique totale jusqu'à 512Mo (selon la 
mémoire système)
Prend totalement en charge DirectX® 10

Mémoire Deux emplacement SODIMM, supportant la mémoire DDRII 667
Mémoire extensible jusqu’à 4Go

Sécurité Fente de verrouillage de sécurité (type Kensington)
Lecteur d'empreintes digitales (Option d’usine -
Modèles C & D)

Mot de Passe du BIOS

Caractéristique Spécification
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BIOS Phoenix BIOS (SPI Flash ROM de 8Mo) Phoenix™ BIOS

Stockage de 
données

Un lecteur de type unité optique (CD/DVD) 12,7mm(h) remplaçable  (reportez-vous à “Options” à la 
page 126 pour les options de lecteur)
Une disque dur SATA facilement échangeable de 2,5" 9,5 mm (H)

Son Interface conforme Intel HDA (Son Haute Définition)
Conforme à Microsoft UAA (Universal Audio 
Architecture)
Compatible avec Direct Sound 3D

Sortie numérique S/PDIF
2 haut-parleurs intégrés
Microphone intégré

Clavier Clavier “Win Key” 

Dispositif de 
pointage

TouchPad intégré (avec fonction de défilement)

Lecteur de carte Lecteur de carte 7-en-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Remarque: Cartes MS Duo/ Mini SD/ RS MMC nécessitent un PC adaptateur

Interface Trois ports USB 2.0
Une prise de sortie haut-parleurs/casque
Une prise d'entrée de microphone
Une prise de sortie S/PDIF

Une prise RJ-11 pour modem
Une prise RJ-45 pour réseau
Une prise d’entrée en CC
Un port moniteur externe

Logement 
d'ExpressCard

Logement d'ExpressCard/54(34)

Caractéristique Spécification
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Communication

*Remarque : Les Modu-
les optionnels Blue-
tooth et 3.5G. ne
peuvent coexister. Si vo-
tre option d'achat com-
prend l'une des options
d'usine, alors l'autre est
non disponible.

56K Plug & Play Fax/Modem (conforme V.90 & V.92)
LAN 10Mo/100Mo Ethernet
Module 802.11b/g USB WLAN (Option)
1,3M ou 2,0M pixel caméra PC USB (Option d’usine)
*Module Bluetooth 2.0 + EDR USB (Option d’usine)
ou
*Module 3.5G basé sur UMTS/HSPDA avec Mini interface de carte 
(Option d’usine)
    Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
    UMTS WCDMA FDD (2100 MHz)

Gestion de 
l’alimentation

Supporte ACPI v3.0

Mise en marche Modèles A & B
Adaptateur CA/CC pleine bande 
Entrée c.a.: 100-240V, 50-60Hz 
Sortie c.c.: 19V, 3,42A Ou 18,5V, 3,5A (65W)

Modèles C & D
Adaptateur CA/CC pleine bande 
Entrée c.a.: 100-240V, 50-60Hz 
Sortie c.c.: 19V, 4,74A (90W)

Batterie Smart Lithium-Ion à 6 éléments, 4000mAH Ou 4400mAH
Batterie Smart Lithium-Ion à 9 éléments, 7200mAH (Option)

Spécifications 
environnementales

Température
En fonction : 5°C- 35°C 
Eteint : -20°C - 60°C

Humidité relative
En fonction : 20% - 80%
Eteint : 10% - 90%

Caractéristique Spécification

Modes UMTS

Remarquez que les mo-
des UMTS NE PEUVENT
PAS être utilisés en Amé-
rique du Nord.
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Dimensions 
physiques & Poids

Modèles A & C
336 (l) x 250 (p) x 24,8 - 35,7 (h) mm
2,2 kg avec batterie à 6 éléments

Modèles B & D
359 (l) x 268 (p) x 24,8 - 37 (h) mm
2,5 kg avec batterie à 6 éléments

Options

*Remarque : Les Modu-
les optionnels Blue-
tooth et 3.5G. ne
peuvent coexister. Si vo-
tre option d'achat com-
prend l'une des options
d'usine, alors l'autre est
non disponible.

Options de module de lecteur optique :
Lecteur combo
Lecteur DVD-Dual (Super Multi)

Module 802.11b/g USB WLAN

Batterie Smart Lithium-Ion à 9 éléments, 7200mAH

1,3M ou 2,0M pixel caméra PC USB (Option 
d’usine)

Lecteur d'empreintes digitales (Option d’usine - 
Modèles C & D)

*Module Bluetooth 2.0 + EDR USB (Option 
d’usine)
ou
*Module 3.5G basé sur UMTS/HSPDA avec Mini 
interface de carte (Option d’usine)
Quad-band GSM/GPRS (850 MHz, 900 MHz,   
1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Caractéristique Spécification

Modes UMTS

Remarquez que les modes UMTS NE PEUVENT
PAS être utilisés en Amérique du Nord.
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Aviso
La compañía se reserva el derecho a revisar esta publicación o cambiar su contenido sin previo aviso. La información
contenida aquí sirve sólo como referencia y no constituye ninguna obligación por parte del fabricante o cualquier vendedor.
No se asume responsabilidad o compromiso por cualquier error o inexactitud que pueda aparecer en esta publicación ni nos
hacemos responsables de cualquier pérdida o daño como resultado del uso (o mal uso) de esta publicación.
Esta publicación y cualquier software que la acompañe no puede, en parte o en su totalidad, ser reproducida, traducida,
transmitida o reducida a cualquier forma legible sin el previo consentimiento del vendedor, fabricante o creadores de esta
publicación, excepto para copias de seguridad guardadas por el propio usuario.
Los nombres de productos y marcas mencionados en esta publicación pueden ser o no marcas con derechos de copia y/o
marcas registradas de sus respectivas compañías. Se mencionan aquí sólo para propósitos de identificación y no como
apoyo a ese producto o su fabricante.

© Marzo de 2008

Marcas registradas
Este producto incorpora tecnología de protección de derechos de autor amparada por las exigencias de ciertas patentes de
EE.UU. y otros derechos de propiedad intelectual pertenecientes a Macrovision Corporation y otros propietarios de
derechos. El uso de esta tecnología de protección de derechos de copia debe ser autorizado por Macrovision Corporation
y está limitado a uso exclusivo doméstico u otros usos de visualización limitados a menos que exista autorización previa
de Macrovision Corporation. Quedan prohibidas las modificaciones o el desmontaje.
Intel, Celeron e Intel Core son marcas/marcas registradas de Intel Corporation.
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Acerca de esta Guía del Usuario Concisa
Esta guía rápida es una breve introducción para poner su sistema en funcionamiento. Es un suplemento y no un sustituto
del Manual del usuario completo en inglés en formato Adobe Acrobat del CD-ROM Device Drivers & Utilities + User's
Manual suministrado con el ordenador. En este CD-ROM también se encuentran los controladores y utilitarios necesarios
para utilizar el ordenador correctamente. 

Algunas o todas las características del ordenador pueden haberse configurado de antemano. Si no lo están, o si desea
reconfigurar (o reinstalar) partes del sistema, consulte el Manual del usuario completo. El CD-ROM Device Drivers &
Utilities + User’s Manual no contiene un sistema operativo.

Información de regulación
Las notas de regulación e información están contenidas en el Manual del usuario completo en el CD-ROM Device Drivers
& Utilities + User’s Manual.

Uso de dispositivos inalámbricos a bordo de un avión

Normalmente se prohibe el uso de cualquier dispositivo de transmisión electrónica a bordo de
un avión. Compruebe que los módulos inalámbricos estén DESCONECTADOS si va a
utilizar el ordenador en el avión.
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Instrucciones para el cuidado y funcionamiento
El ordenador portátil es muy robusto, pero puede dañarse. Para evitar esto, siga estas sugerencias:

• No lo deje caer ni lo exponga a golpes fuertes. Si el ordenador se cae, la carcasa y los componentes podrían dañarse.
• Manténgalo seco y no lo sobrecaliente. Mantenga el ordenador y fuente de alimentación alejados de cualquier tipo 

de fuente de calor. Esto es un aparato eléctrico. Si se derrama agua u otro líquido en su interior, el ordenador podría 
dañarse seriamente.

• Evite las interferencias. Mantenga el ordenador alejado de transformadores de alta capacidad, motores eléctricos y 
otros campos magnéticos fuertes. Éstos pueden dificultar el correcto funcionamiento y dañar los datos.

• Siga las instrucciones apropiadas de manejo del ordenador. Apague el ordenador correctamente y no olvide 
guardar su trabajo. Recuerde guardar periódicamente sus datos, pues los datos pueden perderse si la batería se 
descarga.

• Tenga cuidado cuando utilice dispositivos periféricos.

Servicio
No intente arreglar el ordenador por su cuenta. Si lo hace, puede violar la garantía y exponerse usted y el ordenador a
descarga eléctrica. Encargue las reparaciones a personal técnico autorizado. Desenchufe el ordenador de la fuente de
alimentación. Encargue las reparaciones a personal cualificado en los siguientes casos:

• Cuando el cable de alimentación esté dañado o pelado.
• Si el ordenador ha estado expuesto a la lluvia u otros líquidos.
• Si el ordenador no funciona con normalidad tras seguir las instrucciones de uso.
• Si el ordenador se ha caído o dañado (no toque el líquido venenoso si el panel LCD se rompe).
• Si hay un olor fuera de lo normal, calor o humo que sale del ordenador.
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Seguridad sobre la alimentación
El ordenador tiene unos requisitos de alimentación específicos:
• Utilice solamente un adaptador de alimentación aprobado para su uso con este ordenador.
• Su adaptador de CA/CC puede estar diseñado para viajes internacionales, pero puede que necesite una fuente de alimentación 

continuada. Si no está seguro de las especificaciones de alimentación locales, consulte con el servicio de asistencia o compañía de 
electricidad del lugar.

• El adaptador de alimentación puede tener un enchufe de 2 dientes o un enchufe con tierra de 3 dientes. El tercer diente es una característica 
de seguridad; no lo elimine. Si no tiene acceso a un enchufe de pared compatible, haga que un electricista cualificado instale uno.

• Cuando desee desenchufar el cable de alimentación, asegúrese de desconectarlo por la cabeza del enchufe, no por su cable.
• Compruebe que la toma y cualquier alargadera que utilice puedan soportar la carga de corriente total de todos los dispositivos 

conectados.
• Antes de limpiar el ordenador, asegúrese de que esté desconectado de cualquier fuente de alimentación externa.

Limpieza
• No aplique limpiador directamente en el ordenador, utilice un trapo suave y limpio. 
• No utilice limpiadores volátiles (derivados del petróleo) o limpiadores abrasivos en ningún lugar del ordenador.

Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de actualización, asegúrese de haber apagado la alimentación y desconectado todos
los periféricos y cables (incluyendo las líneas telefónicas). También es aconsejable quitar su batería para evitar que la máquina se
encienda por accidente.

Apáguelo antes de viajar

Compruebe que su portátil esté completamente apagado antes de introducirlo en una bolsa de viaje (o en cualquier funda). Si introduce
un portátil encendido en una bolsa de viaje, puede que la(s) rejilla(s) se bloquee(n). Para evitar que el ordenador se sobrecaliente,
asegúrese de que nada bloquea la(s) rejilla(s) con el ordenador encendido.
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Precauciones con la batería
• Utilice sólo baterías diseñadas para este ordenador. Una batería inadecuada podría explotar, perder o dañar el equipo.
• Nunca utilice una batería que se haya caído o que parezca dañada (p. ej. doblada o retorcida). Incluso si el ordenador 

sigue funcionando con una batería dañada, puede provocar daños en el circuito que podrían causar fuego.
• Recargue la batería con el sistema del ordenador. Una recarga incorrecta puede hacer que la batería explote.
• No intente reparar baterías. Solicite la reparación o la sustitución a su representante de servicio o a personal de 

servicio cualificado.
• Mantenga las baterías dañadas fuera del alcance de los niños y deséchelas inmediatamente. La eliminación de baterías 

debe efectuarse con cuidado. Las baterías pueden explotar o perder si se exponen al fuego o si se manipulan o 
desechan de manera inadecuada.

• Mantenga las baterías lejos de elementos metálicos.
• Cubra los contactos de la batería con cinta adhesiva antes de desecharla.
• No toque los contactos de la batería con las manos o con objetos metálicos.

Eliminación de la batería & Cuidado

El producto que usted ha comprado contiene una batería recargable. La batería es reciclable Terminada su vida útil, según las
leyes locales y estatales, puede ser ilegal desecharla junto con los residuos ordinarios. Verifique con las autoridades locales
responsables de los desechos sólidos cuáles son las opciones de eliminación y reciclado existentes en su zona.

Peligro de explosión si la batería está mal colocada. Sustitúyala con un tipo de batería igual o equivalente al recomendado por
el fabricante. Elimine la batería usada de conformidad con las instrucciones del fabricante.
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Diferencias de modelos
Esta serie de portátiles incluye cuatro tipos de modelos distintos (cada modelo incluye estilos de diseño diferentes). La
apariencia externa exacta y algunos de los botones Hot-Key pueden diferir ligeramente de las ilustraciones en este manual;
sin embargo, todos los puertos, componentes, funciones, etc. son los mismos para cada estilo de diseño. Los modelos di-
fieren según se indica en la siguiente tabla.

Tabla 1 - Diferencias de modelos

Característica Modelo A Modelo B Modelo C Modelo D

Núcleo logic SiS M672 + SiS968 SiS M671DX + SiS968

Adaptador de vídeo Vídeo Integrado SiS (Chip Interno) Vídeo discreto NVIDIA (Externo Incorporado)

Adaptador de CA/CC 65W (Salida CC 19V, 3,42A o 18,5V, 3,5A) 90W (Salida CC 19V, 4,74A)

Tipo de LCD 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 
WSXGA+ 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 

WSXGA+

Lector de huellas 
digitales No No opción opción
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Guía rápida para empezar
1. Quite todos los materiales del embalaje.
2. Coloque el ordenador en una superficie estable.
3. Conecte en los puertos correspondientes los periféricos que desee utilizar con el ordenador portátil (p. ej. teclado y ratón).
4. Conecte el adaptador de CA/CC al conector de entrada de CC que está del lado izquierdo del ordenador, y luego conecte el cable 

de alimentación CA en un eschufe y al adaptador.
5. Utilice una mano para levantar con cuidado la tapa/LCD a un ángulo de visión cómodo (no exceder 130 grados), mientras utiliza la 

otra mano (como se muestra en la Figura 1 siguiente) para sostener la base del ordenador (Nota: Nunca levante el ordenador por 
la tapa/LCD).

6. Presione el botón de encendido para “encender”.

Figura  1 - Abrir la tapa/LCD/ordenador con el adaptador AC/DC enchufado

Apagar

Por favor, tenga en cuenta que debería siempre apagar el ordenador eligiendo la opción Apagar desde el menú del
botón Bloquear en Windows Vista. Esto le ayudará a evitar problemas con el disco duro o el sistema. 
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Software de sistema
Puede ser que su ordenador tenga instalado un software de
sistema. Si no es el caso, o si desea reconfigurarlo con otro
sistema, este manual se refiere a  Microsoft Windows Vista.
Si desea más información sobre cómo instalar controlado-
res y utilitarios consulte los capítulos 4 y 7 del Manual del
usuario completo, que se encuentra en el CD-ROM Device
Drivers & Utilities + User’s Manual.

Sistemas operativos suportados 

No incluido
Sistemas operativos (p. ej. Windows Vista/Windows XP)
tienen sus propios manuales, al igual que las aplicaciones
(p. ej. procesadores de texto, planillas de cálculo y bases de
datos), por favor, consulte los manuales apropiados.

Controladores

Si va a instalar o reinstalar un nuevo sistema, necesitará ins-
talar los controladores apropiados. Los controladores son pro-
gramas que actúan como una interfaz entre el ordenador y un
componente hardware, p. ej. un módulo de red inalámbrico. Es
muy importante que instale los controladores en el orden lista-
do en la Tabla 6 en la página 148. No puede utilizar los con-
troles más avanzados hasta que tenga instalados los
controladores y utilidades apropiadas.

Sistema operativo Nota

Windows XP (Home 
Edition o Professional)

Para información sobre el SO Win-
dows XP  (consulte el CD-ROM 
Device Drivers & Utilities + User’s 
Manual).

Windows Vista con 
Service Pack 1 (64-bit)  

Home Basic Editon/
Home Premium Editon/

Business Editon/
Enterprise Editon/

Ultimate Editon

Asegúrese de haber instalado el Ser-
vice Pack 1 para Windows Vista (o 
una versión de Windows Vista que 
incluya el Service Pack 1), antes de 
instalar cualquier controlador.  
Vaya al sitio web de Microsoft para 
descargar los detalles o contacte con 
su centro de servicios.

Para ejecutar Windows Vista sin 
limitaciones ni menor rendimiento, su 
ordenador necesita un mínimo de 
1GB de memoria del sistema (RAM).
134 -  Software de sistema
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Mapa del sistema: Vista frontal con panel LCD 
abierto (Modelos A & C)

Figura 2
Vista frontal con panel 

LCD abierto
(Modelos A & C)

1. Cámara PC (opcional)
2. Panel LCD
3. Altavoces incorporados
4. Botón de encendido
5. Botones Hot-Key
6. Teclado
7. Micrófono incorporado
8. TouchPad (almohadilla 

táctil) y botones
9. Lector de huellas 

digitales (opcional sólo 
para Modelos C & D)

10. Indicadores LED

Uso de dispositivos 
inalámbricos a bordo

El uso de dispositivos electrónicos
portátiles a bordo de un avión
suele estar prohibido. Compruebe
que los módulos inalámbricos
estén DESCONECTADOS si va a
utilizar el ordenador en el avión. 
 
Utilice las combinaciones de teclas
para cambiar la alimentación entre
los módulos WLAN/Bluetooth/3.5G
y haga compruebe el icono
indicador de estado/barra de
tareas para ver si los módulos
están encendidos o no (ver la
Tabla 3 en la página 137/ la
Tabla 5 en la página 139).
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Mapa del sistema: Vista frontal con panel LCD 
abierto (Modelos B & D)

Figura 3
Vista frontal con panel 

LCD abierto
(Modelos B & D)

1. Cámara PC (opcional)
2. Panel LCD
3. Altavoces incorporados
4. Botón de encendido
5. Botones Hot-Key
6. Teclado
7. Micrófono incorporado
8. TouchPad (almohadilla 

táctil) y botones
9. Lector de huellas 

digitales (opcional sólo 
para Modelos C & D)

10. Indicadores LED

Uso de dispositivos 
inalámbricos a bordo

El uso de dispositivos electrónicos
portátiles a bordo de un avión
suele estar prohibido. Compruebe
que los módulos inalámbricos
estén DESCONECTADOS si va a
utilizar el ordenador en el avión. 
 
Utilice las combinaciones de teclas
para cambiar la alimentación entre
los módulos WLAN/Bluetooth/3.5G
y haga compruebe el icono
indicador de estado/barra de
tareas para ver si los módulos
están encendidos o no (ver la
Tabla 3 en la página 137/ la
Tabla 5 en la página 139).
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Indicadores LED
Los dos conjuntos de indicadores LED (Indicadores LED
de estado e Indicadores LED de encendido y
comunicación) en su ordenador muestran una valiosa
información sobre el estado actual del ordenador.

Tabla 2 - Indicadores LED de estado

Tabla 3 - Indicadores LED de encendido y
comunicación

Icono Color Descripción

Verde El disco duro está en uso

Verde El teclado numérico (NumLk) está acti-
vado

Verde El bloqueo de mayúsculas está activado

Verde El bloqueo de desplazamiento está acti-
vado

Icono Color Descripción

Naranja El adaptador de CA/CC está 
conectado

Verde El ordenador está encendido

Verde 
parpadeante

El ordenador está en modo Sus-
pensión

Naranja La batería se está cargando

Verde La batería está completamente 
cargada

Naranja 
parpadeante

La batería ha alcanzado el estado 
crítico de poca energía

Verde El módulo LAN Wireless (opcio-
nal) está activado

Naranja El módulo Bluetooth (opcional) 
está activado
Indicadores LED - 137
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Botones Hot-Key & teclado
Los botones Hot-Key ofrecen acceso instantáneo al
explorador de Internet y al programa de correo electrónico
predeterminado y le permiten activar o desactivar el Modo
silencio con una pulsación de botón.

Tabla 4 - Botones Hot-Key

*Cuando se activa, el Modo silencio reduce el ruido del
ventilador y ahorra energía. Tenga en cuenta que esto puede
reducir el rendimiento del ordenador.

El teclado tiene un teclado numérico para una entrada fácil
de datos numéricos. También incluye las teclas de función
para permitirle cambiar las características operacionales al
instante (ver la Figura 4).

Figura 4 - Teclado

Botón Hot-Key Función

Activar el programa de correo electró-
nico predeterminado

Activar el buscador de Internet predeter-
minado

Cambiar Modo silencio* (para ahorro de 
batería)

Activar/desactivar 

Teclado numérico

Tecla Fn

Teclas de función

Teclas NumLk y ScrLkmódulo 3.5G

Caracteres especiales

Algunas aplicaciones de software le permiten usar las teclas
numéricas con Alt para producir caracteres especiales. Es-
tos caracteres especiales sólo pueden producirse utilizando
el teclado numérico. Las teclas numéricas normales (en la
fila superior del teclado) no funcionarán. Asegúrese de que
el teclado numérico (NumLk) esté activado.
138 -  Botones Hot-Key & teclado
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Teclas de función & indicadores visuales
Las teclas de función (F1 - F12 etc.) actuarán como teclas directas (Hot-Key) cuando se pulsan junto con la tecla Fn.
Además de las combinaciones de teclas de función básicas los indicadores visuales están disponibles cuando el controlador
de teclas directas (HotKey Driver) está instalado (consulte “Hot-Key” en la página 149). Después de instalar el controlador
aparecerá un icono  en la barra de tareas.

Teclas Función/indicadores visuales Teclas Función/indicadores visuales

Fn + ~ Reproducir/Pausar (en los programas Audio/Vídeo) Fn + F8/F9 Reducción/Aumento 
brillo LCD

Fn +  
Activar/desactivar el 
módulo 3.5G Fn + F10 Activar/desactivar el 

módulo Cámara PC

Fn + F1 Activar/desactivar el 
TouchPad Fn + F11 Activar/desactivar el 

módulo LAN Wireless

Fn + F2 
Apagar luz de fondo del LCD 
(presione una tecla o utilice el TouchPad para 
encenderlo)

Fn + F12 Activar/desactivar el 
módulo Bluetooth

Fn + F3 Conmutación mudo Fn + 
NumLk Activar/disactivar el teclado numérico (NumLk) 

Fn + F4 Conmutación dormir Fn + ScrLk Cambia el bloqueo de desplazamiento

Fn + F5/
F6 

Reducción/Aumento 
volumen de sonido

Cambiar modo silen-
cio

Fn + F7 Conmutación pantalla Tabla 5 - Teclas de función & indicadores visuales
Botones Hot-Key & teclado - 139
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Mapa del sistema: Vistas frontal y izquierda
Figura 5

 Vistas frontal y izquier-
da

1. Indicadores LED
2. Conector de entrada de 

CC
3. Puerto para monitor 

externo
4. Conector LAN RJ-45
5. Rejilla
6. 2 Puertos USB 2.0
7. Ranura ExpressCard/

54(34)
8. Lector de tarjetas 7 en 1

1

2 54
6

3
76 8

Lector de tarjetas 7 en 1

El lector de tarjetas le permite usar algunas de las últimas tarjetas de almacenamiento digital. 

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) 
/ MS Duo (requiere PC adaptador) / Mini SD (requiere PC adaptador) / RS MMC (requiere PC 

adaptador)

Parte frontal

Lateral izquierdo
140 -  Mapa del sistema: Vistas frontal y izquierda
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Mapa del sistema: Vistas derecha y posterior Figura 6
 Vistas derecha y 

posterior

1. Conector de salida S/
PDIF

2. Conector  de entrada 
para micrófono

3. Conector de salida de 
auriculares

4. Puerto USB 2.0
5. Bahía de dispositivo 

óptico
6. Orificio de expulsión de 

emergencia
7. Conector de teléfono RJ-

11
8. Ranura del cierre de 

seguridad
9. Batería

Cambiar los códigos regionales para DVD

Vaya al Panel de control y haga doble clic en Ad-
ministrador de dispositivos (Hardware y soni-
do), luego en + junto a Unidades de DVD/CD-
ROM. Haga doble clic en el dispositivo de DVD-
ROM para abrir el menú Propiedades y seleccio-
ne la Región DVD (ficha) para abrir el panel de
control y permitirle ajustar el código regional.

La detección del código regional de DVD depende
del dispositivo y no del sistema operativo. Es po-
sible seleccionar el código regional 5 veces. La
quinta selección es permanente. No se puede al-
terar por más que se cambie de sistema operativo
o el módulo se utilice en otro ordenador.

Expulsión de emergencia de CD

Si necesita expulsar un CD/DVD
manualmente (p. ej. por un corte de
corriente inesperado) puede introducir la
punta de un clip en el orificio de expulsión
de emergencia. No utilice la punta de un
lápiz u otros objetos que puedan romperse
y quedar atrapados en el orificio.

Advertencia sobre soportes extraíbles

No intente extraer un disquete o CD
mientras el sistema esté accediendo al
mismo. Esto puede causar un fallo.

Lateral izquierdo

Lateral derecho

1 52 4

9

3 6 7 8

Parte posterior

Lateral derecho
Mapa del sistema: Vistas derecha y posterior - 141
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Mapa del sistema: Vista inferiorFigura 7 
Vista inferior

1. Batería
2. Tapa del módulo 

Bluetooth
3. Tapa de la bahía para 

CPU/RAM
4. Rejilla
5. Tapa de la bahía para el 

disco duro
6. Ubicación de la tarjeta 

3.5G USIM

Información de la batería

Siempre complete la descarga de
una batería nueva y luego cárguela
por completo antes de usarla. Des-
cárguela por completo y vuelva a
cargarla al menos una vez cada 30
días o tras unas 20 descargas par-
ciales.  

CPU

El usuario no debe manipular la
CPU. El acceso a la CPU de
cualquier modo puede anular su
garantía.

Recalentamiento

Para evitar que su ordenador se
recaliente compruebe que nada
bloquea la(s) rejilla(s) con el equipo
encendido.

2

3

1

4

4

5
6

2

3

1

4

4

5
6

Modelos A & C 

Modelos B & D 
142 -  Mapa del sistema: Vista inferior



Guía del Usuario Concisa

Español
Menú Inicio y Panel de control de Windows Vista
La mayoría de paneles de control, utilidades y programas en Windows Vista (y la mayoría de versiones de Windows)
pueden accederse a través del menú Inicio. Cuando instala programas y utilidades, se instalarán en su unidad de disco duro
y normalmente aparecerá un acceso directo en el menú Inicio y/o escritorio. Haga clic con el botón derecho en el icono del
menú Inicio , luego seleccione Propiedades si desea personalizar la apariencia del menú Inicio.

En muchos ejemplos a lo largo de este manual verá una ilustración para abrir Panel de control. El Panel de control se
accede desde el menú Inicio. El Panel de control le permite establecer la configuración de la mayoría de características
principales en Windows (p. ej. energía, vídeo, redes, audio, etc.). Windows Vista ofrece paneles de control básicos para
muchas de las características, sin embargo, se añaden muchos paneles de control nuevos (o mejoran los existentes) cuando
instale los controladores listados en la Tabla 6 en la página 148. Para ver todos los controles puede que sea necesario
activar la vista Clásica.

Figura 8 - Menú Inicio y Panel de control

Haga clic aquí para cambiar a la
vista clásica
Menú Inicio y Panel de control de Windows Vista - 143
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Parámetros de vídeo
Este ordenador incluye dos opciones de vídeo diferentes (SiS para los Modelos A & B o NVIDIA para los Modelos C &
D). Puede cambiar los dispositivos de pantalla y configurar las opciones de pantalla desde el panel de control
Configuración de Pantalla (en Personalización) en Windows Vista o desde el Centro de control SiS VGA/Panel de
control de NVIDIA.

Para acceder a la Configuración de pantalla en Windows Vista:
1. Haga clic en Inicio (menú),  y haga clic en Panel de control (o vaya a Configuración y haga clic en Panel de control).
2. Haga clic en Ajustar resolución de pantalla en el menú Apariencia y personalización (o  haga doble clic en Personalización > 

Configuración de pantalla).
3. En Resolución, mueva el control deslizante a la configuración preferida para resolución  (ver la Figura 9 en la página 145).
4. En Calidad de color, haga clic en la flecha y desplace hasta la configuración preferida para la profundidad del color  (ver la 

Figura 9 en la página 145).
5. Haga clic en Configuración avanzada... (botón)  (ver la Figura 9 en la página 145) para abrir las fichas de Configuración 

avanzada.

Para acceder al Centro de control SiS VGA (Modelos A & B):
1. Puede acceder al Centro de control SiS VGA haciendo clic con el botón derecho en el icono SiSTray  de la barra de tareas y 

seleccionar Centro de control (o en SiS VGA Control Center en el Panel de control de Windows).

Para acceder al Panel de control de NVIDIA (Modelos C & D):
1. Puede acceder al Panel de control de NVIDIA haciendo clic con el botón derecho en el escritorio y haciendo clic en Panel de 

control de NVIDIA (o en NVIDIA Control Panel en el Panel de control de Windows).

1
2

3

144 -  Parámetros de vídeo
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Figura 9 - Configuración de Pantalla & Centro de control/Panel de control 

21
3

21
3
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Funciones de administración de energía
El panel de control de las opciones de energía (menú Hardware y sonido) de Windows (ver la página 143) permite
configurar las funciones de administración de energía del ordenador. Puede ahorrar energía con los planes de energía y
configurar las opciones para el botón de encendido, botón de suspensión, tapa del ordenador (al cerrarla), pantalla y
modo de suspensión en el menú de la izquierda. Tenga en cuenta que el plan economizador puede afectar al rendimiento
del ordenador.

Haga clic para seleccionar uno de los planes existentes o haga clic en Crear un plan de energía en el menú izquierdo y
seleccione las opciones para crear un plan nuevo. Haga clic en Cambiar la configuración del plan y haga clic en Cambiar
la configuración avanzada de energía para acceder a más opciones de configuración.

Figura 10 - Opciones de energía

Nota: Suspensión es el estado de ahorro de energía predeterminado en Windows Vista  
146 -  Funciones de administración de energía



Guía del Usuario Concisa

Español
Características de audio
Puede configurar las opciones de audio de su ordenador en el panel de control de Sonido ,
o desde el icono de Administrador de sonido Realtek HD /  en la barra de tareas
o en el panel de control (haga clic en el icono de la barra de tareas  para abrir el menú de
audio). El volumen también puede ajustarse con la combinación de teclas Fn + F5/F6.

Figura 11 - Administrador de sonido Realtek HD

Ajuste del volumen del 
sonido

El nivel del volumen del so-
nido se ajusta utilizando el
control dentro de Windows
(y las teclas de función del
volumen en el ordenador).
Haga clic en el icono del
Volumen de la barra de ta-
reas para comprobar la
configuración.

Haga clic con el botón
derecho en el icono
para acceder al menú
de arriba.
Características de audio - 147
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Instalación de controladores
El CD-ROM Device Drivers & Utilities + User’s Manual
contiene los controladores y utilitarios necesarios para
utilizar el ordenador correctamente. Inserte el CD-ROM y
haga clic en Install Drivers (botón), u Option Drivers
(botón) para acceder al menú de controladores opcional.

Instale los controladores en el orden indicado en la Tabla 6.
Tras instalar cada controlador, quedará en gris (si necesita
volver a instalar un controlador, haga clic en el botón
Unlock).
 
Instalación manual del controlador
Haga clic en el botón Browse CD en la aplicación Drivers
Installer y busque el archivo ejecutable en la carpeta de
controladores apropiada

Windows Update
Tras instalar todos los controladores asegúrese de haber
habilitado Windows Update para obtener las últimas
actualizaciones de seguridad, etc. (todas las actualizaciones
incluirán los últimos parches de Microsoft).

Tabla 6 - Procedimiento de instalación

Controlador (Windows Vista con SP1) Página#

Vídeo página 149

Sonido página 149

Módem página 149

Red (LAN) página 149

TouchPad (almohadilla táctil) página 149

Lector de tarjetas página 149

Hot-Key página 149

Cámara PC (opción) página 150

LAN Wireless (opción) página 153

3.5G (opción) página 155

Lector de huellas digitales (opción) - sólo para 
ordenadores Modelos C y D página 159

Bluetooth (opción)
Nota: No se requiere instalación de controladores (vea la 
página 161)

Activar Windows Update (ver a la izquierda)
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Vídeo
1. Haga clic en 1.Install Video Driver > Sí.

Modelos A & B (SiS):
2. Haga clic en Sí (haga clic en Sí si desea ver el archivo 

ReadMe).
3. Haga clic en Sí para reiniciar el sistema.

Modelos C & D (NVIDIA):
4. Haga clic en Siguiente.
5. Haga clic en Finalizar para reiniciar el sistema.

Sonido
1. Haga clic en 2.Install Audio Driver > Sí.
2. Haga clic en Siguiente.
3. Haga clic en Finalizar para reiniciar el sistema.

Modem
1. Haga clic en 3.Install Modem Driver > Sí.
2. Haga clic en Aceptar.
3. El módem está listo para la configuración del acceso 

telefónico.

Red (LAN)
1. Haga clic en 4.Install Lan Driver > Sí.
2. Haga clic en  Siguiente.
3. Haga clic en Finalizar > Finalizar para reiniciar el 

sistema.
4. Ahora se pueden configurar los parámetros de red. 

TouchPad
1. Haga clic en 5.Install Touchpad Driver > Sí.
2. Haga clic en Siguiente.
3. Haga clic en Finalizar  > Reinicar ahora para reiniciar el 

sistema

Lector de tarjetas
1. Haga clic en 6.Install Cardreader Driver > Sí.
2. Haga clic en Siguiente > Siguiente.
3. Haga clic en Terminar para reiniciar el sistema.

Hot-Key
1. Haga clic en 7.Install HOTKEY Driver > Sí.
2. Haga clic en Next > Install.
3. Haga clic en Finish > Finish para reiniciar el sistema.
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Cámara PC
El módulo cámara PC utiliza la aplicación BisonCap para
capturar archivos de vídeo. 

Instalación del controlador de la 
cámara PC
1. Encienda el módulo utilizando Fn + F10 (el indicador 

visual en pantalla  aparecerá brevemente cuando se 
encienda el módulo).

2. Haga clic en Option Drivers (botón).
3. Haga clic en 1.PC Camera, Web cam > Sí.
4. Elija el idioma que prefiera y haga clic en Siguiente > 

Siguiente.
5. Haga clic en Finalizar  para reiniciar el sistema.
6. Ejecute el programa de la aplicación BisonCap desde el 

acceso directo (BisonCam) en el escritorio o desde la 
opción BisonCam en el menú Inicio > Programas/Todos 

los programas (si el hardware está apagado utilice la 
combinación de teclas Fn + F10 para volver a 
encenderlo).

Configuración del audio de la cámara 
PC
Configure las opciones de grabación de audio en Windows
para capturar vídeo & audio con su cámara.
1. Haga clic en Inicio (menú), y haga clic en Panel de control 

(o vaya a Configuración y haga clic en Panel de control).
2. Haga clic en Sonido  (Hardware y sonido).
3. Haga clic en Grabar (ficha).
4. Haga clic con el botón derecho en Micrófono (Realtek High 

Definition Audio) y compruebe que el ítem esté deshabilitado.
5. Haga doble clic en Micrófono (o seleccione Propiedades en 

el menú contextual).
6. Haga clic en Niveles (ficha) y ajuste los controles deslizantes 

de Micrófono y Amplificación de micrófono hasta el nivel 
deseado.

7. Haga clic en Aceptar y cierre los paneles de control.
8. Ejecute el programa BisonCap en el menú Inicio > 

Programas/Todos los programas > BisonCam.
9. Vaya al menú Devices (Dispositivos) y seleccione Micrófono 

(Realtek....) (debería tener una marca al lado).
10. Vaya al menú Capture (Capturar) y seleccione Capture 

Audio (debería tener una marca al lado).

Última información del controlador de la cámara PC

Compruebe el disco Device Drivers & Utilities + User’s Manual
y las páginas insertadas que lo acompañen para la información
actualizada del controlador de la cámara PC, que puede
sustituir a la información ofrecida aquí.
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BisonCap
La aplicación BisonCap es un visor de vídeo útil para el
propósito general de visualización y comprobación de
vídeo y puede capturar archivos de vídeo en formato .avi.

1. Ejecute el programa BisonCap en el menú Inicio > 
Programas/Todos los programas > BisonCam (se 
recomienda que Ajuste el archivo de captura antes del 
proceso de captura - ver “Ajustar archivo de captura” a 
continuación).

2. Vaya al menú de Capture (Capturar) (si desea capturar audio 
cconsulte “Configuración del audio de la cámara PC” en la 
página 150) y seleccione Start Capture (Iniciar captura).

3. Haga clic en OK (Aceptar) (la ubicación del archivo aparecerá 
en el cuadro emergente) para iniciar la captura y pulse Esc 
para detenerla  (puede ver el archivo usando Windows 
Media Player).

Ajustar archivo de captura
Antes de capturar archivos de vídeo puede seleccionar la
opción Set Capture File... (Ajustar archivo de captura...) en el
menú File (Archivo) y ajuste el nombre del archivo y la
ubicación antes de capturar (esto ayudará a evitar sobrescribir
archivos accidentalmente). Ajuste el nombre y la ubicación y
luego haga clic en Abrir, luego ajuste el "Tamaño del archivo
de captura": y haga clic en OK (Aceptar). Luego podrá iniciar
el proceso de captura como arriba.

Zoom 
El programa BisonCap le permite acercar y alejar con la
cámara.

1. Ejecute el programa BisonCap.
2. Vaya al menú de Zoom y seleccione ZoomOut/Zoom In.

Tomar imágenes instantáneas
El programa BisonCap le permite tomar fotos instantáneas.

1. Ejecute el programa BisonCap.                                                                                                    
2. Vaya al menú de Options y seleccione Take Picture.
3. La imagen (en formato JPEG) será colocada en la carpeta 

Snapshot  en el escritorio (no mueva ni cambie el 
nombre de la carpeta).
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Eliminar el parpadeo de pantalla
Si la pantalla de vídeo del programa BisonCap parpadea,
puede intentar ajustar la configuración en las opciones
Video Capture Filter.

1. Ejecute el programa BisonCap.
2. Vaya al menú de Options y seleccione Video Capture 

Filter....
3. Haga clic en 50Hz o 60Hz bajo Frecuencia en Página de 

propiedades (ficha).

Reducir el tamaño de archivo de vídeo
Tenga en cuenta que la captura de archivos de vídeo a alta
resolución necesita una cantidad considerable de espacio en
el disco para cada archivo. Tras grabar el vídeo, compruebe
el tamaño del archivo de vídeo (haga clic en el archivo y
seleccione Propiedades) y el espacio libre en su disco duro
(vaya a Equipo, haga clic con el botón derecho en el disco
duro y seleccione Propiedades). Si lo necesita, puede pasar
el archivo de vídeo grabado a un medio extraíble, como CD,
DVD o unidad USB Flash.

Tenga en cuenta que el sistema Windows Vista necesita un
mínimo de 15GB de espacio libre en la unidad C: para la
partición del sistema. Para evitar problemas en el sistema,
se recomienda que guarde el archivo de vídeo capturado en

una ubicación distinta a la unidad C: (consulte “Ajustar
archivo de captura” en la página 151), limite el tamaño de
archivo del vídeo capturado o reduzca la resolución del
vídeo.

Para reducir el tamaño de salida de la resolución 
del vídeo:
1. Ejecute el programa BisonCap.
2. Vaya a Opciones y seleccione Video Capture Pin....
3. Haga clic en el cuadro desplegable Tamaño de salida y 

seleccione un tamaño de resolución menor para reducir el 
tamaño del archivo capturado.
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LAN Wireless

Instalación del controlador del módulo 
WLAN
1. Compruebe que el módulo esté activado.
2. Haga clic en Option Drivers (botón).
3. Haga clic en 2.Wireless Lan > Sí.
4. Elija el idioma que prefiera y haga clic en Siguiente.
5. Haga clic en  Siguiente > Instalar.
6. Haga clic en Finalizar para completar la instalación.

Nota: El sistema operativo es la configuración
predeterminada para el control de LAN inalámbrica en
Windows Vista.

Conectar a una red inalámbrica
Compruebe que el módulo WLAN esté activado.

1. Haga clic en el icono WLAN  en la barra de tareas, y luego 
haga clic en Conectarse a una red (o haga clic con el botón 
derecho en el icono , y luego haga clic en Conectarse a 
una red).

2. En la lista Mostrar, haga clic en Inalámbrico en el menú 
desplegable.

3. Aparecerá una lista con las redes disponibles.
4. Haga clic en una red y luego en Conectar.
5. Si no ve la red a la que quiere conectarse, haga clic en 

Configurar una conexión o red (aparecerá una lista con 
opciones permitiendo la búsqueda manual y creando una 
nueva red).

6. Mueva el cursor sobre el icono  de la barra de tareas para 
ver el estado de la conexión.

7. Para desconectarse de la red inalámbrica puede hacer clic en el 
icono  inalámbrico de la barra de tareas y luego seleccionar 
Conectar o desconectar para acceder al menú de la red y 
hacer clic en Desconectar (o haga clic con el botón derecho 
en el icono , y luego haga clic en Desconectar de).

Botón de encendido para el módulo WLAN

Active la alimentación al módulo WLAN utilizando la combina-
ción de teclas (Fn + F11). Cuando el módulo WLAN está encen-
dido, el LED  estará en verde y el indicador visual en
pantalla  aparecerá brevemente.
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Módulo 3.5G
Si ha incluido un módulo opcional 3.5G en su opción de
compra, siga las instrucciones siguientes para instalar la
tarjeta USIM (suministrada por su proveedor de servicios)
y luego instale la aplicación.

1. Apague el ordenador y gírelo para quitar la batería.
2. Localice la tapa de la tarjeta SIM y afloje el tornillo  de la 

Figura 12.
3. Quite la tapa de la tarjeta SIM  como en la Figura 12.
4. Inserte la tarjeta USIM como lo haría en un teléfono móvil.
5. Deslice SIMLOCK hacia la bisagra (en la dirección opuesta a 

la flecha ilustrada en la Figura 13) para soltar el bloqueo y 
levantarlo.

Figura 12 - Quitar la tapa de la tarjeta SIM

6. Inserte la tarjeta USIM como aparece en (la Figura 13) y 
cierre SIMLOCK

7. Bloquee SIMLOCK presionando en la dirección de la flecha 
de la Figura 13 hasta que encaje en su posición de bloqueo.

8. Vuelva a colocar la tapa, el tornillo y la batería.

Figura 13 - Insertar la tarjeta USIM & bloquear 
SIMLOCK

Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de
actualización, asegúrese de haber apagado la alimentación y
desconectado todos los periféricos y cables (incluyendo las
líneas telefónicas). También es aconsejable quitar su batería
para evitar que la máquina se encienda por accidente.

1

2

2

1
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Aplicación 3G Watcher
Con el módulo 3.5G y la tarjeta USIM (suministrados por
su proveedor de servicios) ya instalados, podrá instalar la
aplicación 3G Watcher. La aplicación 3G Watcher le
permite acceder directamente a su servicio de internet 3.5G
desde el ordenador.

Instalación de la aplicación 3G Watcher
1. Asegúrese de activar la alimentación del módulo 

presionando la combinación de teclas Fn +  (el 
indicador visual en pantalla  indicará el estado de 
corriente del módulo).

2. Si aparece el asistente Nuevo hardware encontrado haga 
clic en Cancelar.

3. Haga clic en Option Drivers (botón).
4. Haga clic en 3.3G Driver > Sí.
5. Haga clic en  Siguiente.
6. Haga clic en el botón Acepto los términos del contrato 

de licencia, luego haga clic en Instalar.
7. Cuando aparezca la siguiente pantalla, espere unos 2 

minutos antes de hacer clic en Finalizar (para que el 
hardware detecte el módulo 3.5G).

8. El icono de 3G Watcher   aparecerá en el escritorio.
9. Podrá acceder a la aplicación 3G Watcher en el menú 

Inicio (Inicio > Programas/Todos los programas > 

Sierra Wireless > 3G Watcher), o haciendo clic en el 
icono  en la barra de tareas.

Configurar un perfil de portador
Aunque la información de conexión está almacenada en la
tarjeta USIM suministrada por el proveedor de servicios,
deberá configurar un perfil de portador desde el software
3G Watcher.

1. Utilice la combinación (Fn + ) para activar el módulo 3.5G.
2. Podrá acceder a la aplicación 3G Watcher en el menú Inicio 

(Inicio > Programas/Todos los programas > Sierra 
Wireless > 3G Watcher), o haciendo clic en el icono  en la 
barra de tareas.

3. Haga clic en Herram... y seleccione Opciones.
4. Haga clic en Perfiles y luego en Agregar perfil nuevo   

(botón), y seleccione Perfil WWAN.

Figura 14 - Agregar perfil WWAN
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5. Entonces podrá introducir un nuevo nombre de perfil o elegir 
un perfil de la lista desplegable del programa.

6. Haga clic en Aplicar > Aceptar para guardar la información.
7. Puede elegir el perfil del menú desplegable.

Figura 15 - Opciones de usuario y seleccionar perfil

Conectar con el proveedor de servicios
1. Utilice la combinación (Fn + ) para activar el módulo 3.5G.
2. Podrá acceder a la aplicación 3G Watcher en el menú Inicio 

(Inicio > Programas/Todos los programas > Sierra 
Wireless > 3G Watcher), o haciendo clic en el icono  en la 
barra de tareas.

3. El software se ejecutará y mostrará el nombre del proveedor 
de servicios (la información de la conexión se obtiene desde 
la tarjeta USIM).

Figura 16 - 3G Watcher
4. Haga clic en Conectar para iniciar el proceso de conexión.
5. La aplicación 3G Watcher mostrará entonces la información 

de conexión en la ventana.

Figura 17 - Conectando

Detalles del perfil

Si ha elegido el perfil de la lista desplegable la mayor parte
de la información de las fichas General y Avanzada debería
estar rellanada automáticamente (sin embargo, compruebe
con su proveedor de servicios la última información pues
puede que necesite al menos agregar su Nombre de usua-
rio y Contraseña)
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6. Cuando la conexión tiene éxito aparecerá una notificación en 
la barra de tareas (como abajo).

Figura 18 - Notificación de conexión en la barra de ta-
reas

7. Puede acceder a internet, descargar correo electrónico, etc. 
igual que con cualquier conexión a internet.

8. Mientras esté conectado el icono de la barra de tareas estará 
en verde  (estará en rojo  cuando el programa se esté 
ejecutando pero sin conexión).

9. Para desconectar haga clic en el icono Desconectar.

Figura 19 - 3G Watcher conectado

10. El programa desconectará del proveedor de servicios.
11. El módulo continuará activado y deberá pulsar la combinación 

de teclas Fn + .

12. Si hace clic en el icono para cerrar 3G Watcher  aparecerá 
un mensaje pidiéndole que haga clic en OK para confirmar 
salir del programa. 

13. Al salir del programa NO se apagará el módulo 3.5G, deberá 
pulsar la combinación de teclas Fn +  para apagar el 
módulo (tenga especial cuidado cuando esté en un avión) - 
consulte “Uso de dispositivos inalámbricos a bordo de un 
avión” en la página 128).

14. Si el módulo está encendido y el ordenador entra en modo 
ahorro de energía, el estado de energía del módulo al reanu-
dar del estado de ahorro de energía será el indicado al dorso:

• Si el módulo 3.5G está encendido y el ordenador está 
apagado/reinicia el ordenador; el módulo estará 
apagado cuando el ordenador se inicie.

• Si el módulo 3.5G está encendido y el ordenador entra 
en modo de suspensión/en modo de hibernación; el 
módulo estará apagado cuando el ordenador se reanude 
desde la suspensión.

Figura 20 
Aviso para salir
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Servicio de mensajería corta
Además de los servicios estándar de internet también podrá
enviar y recibir mensajes de texto SMS utilizando la
aplicación 3G Watcher.

1. El indicador de mensajes SMS  de la ventana principal le 
notificará sobre los nuevos mensajes recibidos.

2. Haga doble clic en el icono  o seleccione Herram... > 
SMS Express....

3. Seleccione la carpeta de entrada y cualquier mensaje para 
leerlo o seleccione Archivo > Nuevo mensaje de correo o 
haga clic en el botón Nuevo para preparar un mensaje nuevo.

Para más detalles sobre SMS consulte la Ayuda en línea de
3GWatcher en el menú Ayuda > Temas de ayuda.

Ayuda en línea 3G Watcher

Para más detalles sobre la aplicación 3G Watcher puede acce-
der a la Ayuda en línea desde el menú Ayuda > Temas de ayu-
da.

Haga clic en cualquier tema en la ventana Contenidos para
mostrar los detalles.
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Lector de huellas digitales
Si su opción de compra incluye un lector de huellas digita-
les (opcional sólo para ordenadores Modelos C y D) nece-
sitará instalar el controlador como se indica a continuación.

Asegúrese de tener derechos de administrador en su ordena-
dor y de tener una contraseña Windows habilitada para una
protección de seguridad completa.

Antes de comenzar el proceso de inscripción, se
recomienda que siga el tutorial de huellas digitales. Para
ejecutar el tutorial, haga clic en Inicio > Programas/Todos
los programas > Protector Suite QL > Tutorial de
huellas digitales.

Instalación del controlador para 
huellas digitales
1. Inserte el CD-ROM Device Drivers & Utilities + User’s 

Manual en la unidad de CD/DVD.
2. Haga clic en Option Drivers (button).
3. Haga clic en 4.FingerPrint > Sí.
4. Haga clic en Instalación del software.
5. Haga clic en Siguiente > Siguiente > Siguiente.
6. Haga clic en Finalizar > Sí para reiniciar el sistema.

Inclusión de usuarios
1. Haga clic en Inicio > Programas/Todos los programas > 

Protector Suite QL > Inclusión de usuario, o haga doble 
clic en el icono  en la barra de tareas.

2. La primera vez que ejecute el programa se le pedirá que haga 
clic en el botón para aceptar la licencia, luego haga clic en 
Aceptar.

3. Haga clic en Siguiente (“Registro en el disco duro” será 
elegido automáticamente) y haga clic en Finalizar.

Ayuda & Manual

Haga clic con el botón derecho en el icono de la barra de tareas
 para abrir el menú y seleccionar Ayuda.

Inserte el CD-ROM Device Drivers & Utilities + User’s Manual y
haga clic en Option Drivers (botón).  Haga clic en Unlock (bo-
tón) y luego haga clic en 4.FingerPrint > Sí.

Haga clic en Documentación para abrir la carpeta que contie-
ne el manual en formato .pdf.

Para instalar el Adobe Acrobat Reader para leer el archivo, inserte
el CD-ROM Device Drivers & Utilities + User’s Manual y haga
clic en User’s Manual (botón) y haga clic en Install Acrobat
Reader (botón).
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4. Si no ha configurado una contraseña de Windows se le 
pedirá que lo haga (nota: Si no ha configurado una 
contraseña Protector Suite QL no puede asegurar el acceso 
a su ordenador).

5. Haga clic en Siguiente y se le pedirá que escriba su 
contraseña de Windows.

6. Haga clic en Siguiente > Siguiente (puntee en el cuadro 
“Ejecute el tutorial interactivo” para ejecutar el Tutorial de 
huellas digitales).

7. Haga clic en Siguiente en cada ventana del tutorial (puede 
hacer clic en el botón “Omitir el tutorial” en cualquier 
momento).

8. Haga clic en el botón sobre cualquiera de las huellas digitales 
para iniciar el proceso de inclusión de ese dedo.

9. Coloque el dedo tres veces para incluirlo.
10. Repita el proceso para todos los dedos que desee incluir, y 

luego haga clic en Siguiente.
11. Haga clic en Finalizar.
12. Haga clic en cualquiera de los títulos en “Obtener más 

información:” para obtener más información sobre un tema.
13. Haga clic en Cerrar.
14. Reinicie el ordenador.
15. Haga clic con el botón derecho en el icono  de la barra de 

tareas para abrir el menú que le permitirá Editar huellas 
digitales, iniciar el Centro de control, acceder al menú 
Ayuda, etc. También puede ejecutar el Centro de control 
etc. desde la opción Protector Suite QL en el menú Inicio > 
Programas/Todos los programas.

16. Consulte “Ayuda & Manual” en la página 159 para más 
detallas.

17. Si coloca su dedo sobre el lector en cualquier momento, 
podrá acceder al Biomenú para bloquear el ordenador, 
registrar sitios de la web, Desbloquear Mi seguridad, abrir 
el Centro de control y acceder al menú Ayuda.

18. El Centro de control le permite cambiar la Configuración, 
registrar huellas digitales y obtener Ayuda.

Figura 21 - Centro de control & Biomenú 

Inclusión de huellas digitales

Tenga en cuenta que se recomienda encarecidamente que
incluya más de un dedo en caso de lesión, etc.
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Configuración de Bluetooth
Configurar su dispositivo Bluetooth para 
que el ordenador pueda encontrarlo
1. Encienda su dispositivo Bluetooth (p. ej. PDA, teléfono móvil, 

etc.).
2. Deje al dispositivo accesible (para hacerlo consulte la 

documentación del dispositivo).

Para encender el módulo Bluetooth
1. Utilice la combinación Fn + F12 para activar el módulo 

Bluetooth. 
2. Aparecerá un icono de Bluetooth  en la barra de tareas 

(puede que necesite activar la opción del panel de control 
Dispositivos Bluetooth).

3. Luego podrá hacer lo siguiente para acceder al panel de 
control Dispositivos Bluetooth.

• Haga doble clic en el icono  para acceder al panel de 
control Dispositivos Bluetooth.

• Haga clic en Inicio (menú) y haga clic en Panel de control 
(o vaya a Configuración y haga clic en Panel de control), 
y luego haga clic en Dispositivos Bluetooth (Hardware y 
sonido).

• Haga clic en/Haga clic con el botón derecho en el icono  
y elija una opción desde el menú.

Figura 22 - Dispositivos Bluetooth y menú contextual 
del icono

Para agregar un dispositivo Bluetooth
1. Acceda al panel de control Dispositivos Bluetooth.
2. Haga clic en Opciones (ficha), y asegúrese de que la casilla 

de verificación Permitir que los dispositivos Bluetooth se 
conecten a este equipo (Conexiones) está marcada.

3. Haga clic en Dispositivos (ficha), luego haga clic en Agregar.
4. El Asistente para agregar dispositivos Bluetooth aparecerá.

Transferencia de datos 
Bluetooth

Tenga en cuenta que la
transferencia de datos
entre el ordenador y un
dispositivo con Bluetoo-
th se realiza sólo en una
dirección (no soporta
la transferencia de da-
tos simultánea).
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5. Haga clic para seleccionar “Mi dispositivo está configurado 
y listo para ser detectado”, luego haga clic en Siguiente.

Figura 23 - Asistente para agregar dispositivos Blue-
tooth

6. El Asistente buscará los dispositivos Bluetooth dentro del 
alcance.

7. Seleccione la unidad con la que se desea comunicar y haga 
clic en Siguiente.

8. Seleccione una opción de clave de paso apropiada y haga clic 
en Siguiente > Finalizar.

Figura 24 - Opciones de clave de paso

Para cambiar la configuración del 
dispositivo Bluetooth
1. Acceda al panel de control Dispositivos Bluetooth.
2. Haga clic en el dispositivo que desea cambiar y haga clic en 

Propiedades para:

• Cambie el nombre del dispositivo (haga clic en General, 
escriba un nuevo nombre y haga clic en Aceptar).

• Activar/desactivar un servicio (haga clic en Servicios, 
marque/quite la casilla de verificación junto al servicio y 
haga clic en Aceptar).

Para hacer su ordenador accesible a 
dispositivos Bluetooth
1. Acceda al panel de control Dispositivos Bluetooth.
2. Haga clic en Opciones (ficha), y asegúrese de que la casilla 

de verificación Permitir que los dispositivos Bluetooth 
encuentren este equipo (Descubrimiento) está marcada.

3. Asegúrese de que la casilla de verificación Alertarme 
cuando un nuevo dispositivo Bluetooth desee conectarse 
(Conexiones) está marcada si desea que se le avise cuando 
un dispositivo Bluetooth quiera conectarse.

Figura 25
Dispositivos 
Bluetooth - 
Opciones
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Solución de problemas
Problema Posible causa - Solución

Los módulos WLAN y 
Bluetooth no pueden 
detectarse.

El (Los) módulo(s) está(n) desactivado(s). Compruebe el indicador LED  para ver si el módulo 
está activado o desactivado. Si el indicador LED está apagado, entonces pulse la(s) combinación(es) 
Fn + F11 (WLAN) o  Fn + F12 (Bluetooth) para activar el módulo(s) (vea la Tabla 5 en la 
página 139).

El módulo Bluetooth está 
apagado tras reanudar 
desde la Suspensión.

El estado predeterminado del módulo Bluetooth será apagado tras reanudar desde el estado de 
ahorro de energía Suspensión. Utilice la combinación de teclas (Fn + F12) para encender el módulo 
Bluetooth tras reanudar el ordenador desde Suspensión.

Un archivo no puede 
copiarse a o desde un 
dispositivo conectado con 
Bluetooth.

La transferencia de datos entre el ordenador y un dispositivo con Bluetooth se realiza sólo en una 
dirección (no soporta la transferencia de datos simultánea). Si copia un archivo de su ordenador a un 
dispositivo con Bluetooth, no podrá copiar un archivo del dispositivo Bluetooth a su ordenador hasta 
que se haya completado el proceso de transferencia del ordenador.

Los archivos de vídeo 
capturados de la Cámara PC 
ocupan demasiado espacio 
en el disco.

Tenga en cuenta que capturar archivos de vídeo de alta resolución requiere una cantidad sustancial 
de espacio en el disco para cada archivo.

Tenga en cuenta que el sistema Windows Vista requiere un mínimo de 15GB de espacio libre en la 
partición del sistema unidad C:. Se recomienda que guarde el archivo de vídeo capturado en una 
ubicación distinta a la unidad C:, limite el tamaño de archivo del vídeo capturado o reduzca la 
resolución del vídeo (Options > Video Capture Pin... > Tamaño de salida). Vea “Reducir el 
tamaño de archivo de vídeo” en la página 159.
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Especificaciones

Característica Especificación

Tipos de 
procesadores

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T8100 / T8300

(45nm) tecnología de proceso de 45 nm
Caché de nivel 2 de 3MB & bus de sistema de 800MHz 
2,1/ 2,4 GHz

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T9300/ T9500

(45nm) tecnología de proceso de 45 nm
Caché de nivel 2 de 6MB & bus de sistema de 800MHz 
2,5/ 2,6 GHz

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T7100/ T7250

(65nm) tecnología de proceso de 65 nm
Caché de nivel 2 de 2MB & bus de sistema de 800MHz 
1,8/ 2,0 GHz

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos)
T7300/ T7500/ T7700/ T7800

(65nm) tecnología de proceso de 65 nm
Caché de nivel 2 de 4MB & bus de sistema de 800MHz 
2,0/ 2,2/ 2,4/ 2,6 GHz

Información actualizada de especificaciones

Las especificaciones listadas en este Apéndice son correctas en el momento de publicación. Ciertas opciones (particularmente tipos/
velocidades de procesadores) pueden cambiar o actualizarse según la fecha de lanzamiento del fabricante. Diríjase a su centro de
servicios para más detalles.
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Procesador Intel Celeron M
Micro-FCPGA package (478 contactos)
530/ 540/ 550/ 560

(65nm) tecnología de proceso de 65 nm
Caché de nivel 2 de 1MB & bus de sistema de 533MHz 
1,73/ 1,86/  2,2/ 2,13 GHz

Núcleo logic Modelos A & B
Chipset SiS M672 + SiS968

Modelos C & D
Chipset SiS M671DX + SiS968

Opciones del LCD Modelos A & C
Pantalla plana TFT tipo brillo, 14,1" - WXGA/
WXGA+

Modelos B & D
Pantalla plana TFT tipo brillo, 15,4" - WXGA/WXGA+/
WSXGA+

Adaptador de 
vídeo

Modelos A & B
Vídeo Integrado SiS M672 (Chip Interno)

Acelerador gráfico 2D/3D de alto rendimiento
Arquitectura de memoria compartida (hasta 
256MB de memoria de vídeo compartida diná-
micamente asignada desde la memoria del sis-
tema cuando se necesita)
Soporta DirectX 9.0 de Microsoft
Soporta Vertex Shader 2.0 y Pixel Shader 2.0

Modelos C & D
Vídeo discreto NVIDIA GeForce 9300M GS (Externo 
Incorporado)

256MB de RAM de vídeo GDDR2
Memoria gráfica total con soporte TurboCache™ 
hasta 512MB (dependiendo de la memoria del sis-
tema)
Soporta DirectX 10.0 de Microsoft

Memoria Dos zócalos de 200 pins SODIMM, para memoria DDRII (DDR2) 667
Memoria expansible hasta 4GB

Seguridad Ranura para cierre de seguridad (tipo Kensington®)
Módulo lector de huellas digitales (opción de 
fábrica - Modelos C & D)

Contraseña de BIOS

Característica Especificación
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BIOS Phoenix BIOS (SPI Flash ROM de 8Mb)

Dispositivos de 
almacenamiento

Una unidad de dispositivo óptico (CD/DVD) de 12,7mm(h) intercambiable (consulte “Opciones” en la 
página 168 para las opciones del módulo de unidad óptica)
Un HDD SATA fácil de cambiar de 2,5" 9,5 mm (h)

Audio Interfaz compatible Intel HDA (Sonido Intel de alta 
definición)
Compatible con Microsoft UAA (Universal Audio 
Architecture)
Compatible con Direct Sound 3D

S/PDIF salida digital
2 altavoces incorporados 
Micrófono incorporado

Teclado Teclado “Win Key” 

Dispositivo 
puntero

TouchPad incorporado (funcionalidad de tecla de desplazamiento integrada)

Lector de tarjetas Módulo lector de tarjetas 7 en 1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Tarjetas MS Duo/ Mini SD/ RS MMC requieren PC adaptador

Interfaz Tres puertos USB 2.0
Un conector de salida de altavoces/auriculares
Un conector de entrada para micrófono
Un conector de salida S/PDIF

Un puerto para monitor externo
Un conector RJ-11 para módem
Un conector RJ-45 para LAN
Un conector de entrada de CC

Ranura 
ExpressCard

Ranura ExpressCard/54(34)

Característica Especificación
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Comunicaciones

*Nota: Los módulos
opcionales Bluetoo-
th y 3.5G no pueden
coexistir. Si una de las
opciones de fábrica
está incluida en su op-
ción de compra, la
otra no estará dispo-
nible.

Fax/Módem de 56K Plug & Play (compatible con V.90 y V.92)
LAN Ethernet de 10Mb/100Mb
Módulo WLAN USB 802.11b/g (opción)
Módulo cámara PC USB de1,3M o 2,0M píxeles (opción de fábrica)
*Módulo Bluetooth USB + EDR  - V2.0 (opción de fábrica)
O
*Módulo UMTS/HSPDA-based 3.5G con interfaz Mini Card (opción de 
fábrica) 
     Quad-banda GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
     UMTS WCDMA FDD (2100 MHz)

Administración de 
energía

Soporta ACPI v3.0 

Alimentación Modelos A & B
Adaptador de CA/CC autodetector de corriente
Entrada CA: 100-240V, 50-60Hz
Salida CC: 19V, 3,42A O 18,5V, 3,5A (65W)

Modelos C & D
Adaptador de CA/CC autodetector de corriente
Entrada CA: 100-240V, 50-60Hz
Salida CC: 19V, 4,74A (90W)

Batería Batería de Litio-Ion inteligente de 6 elementos, 4000mAH O 4400mAH
Batería de Litio-Ion inteligente de 9 elementos, 7200mAH (opción)

Especificaciones 
del ambiente

Temperatura
En funcionamiento: 5°C - 35°C 
Apagado: -20°C - 60°C

Humedad relativa
En funcionamiento: 20% - 80%
Apagado: 10% - 90%

Característica Especificación

Modos UMTS

Tenga en cuenta que los
modos UMTS NO PUEDEN
usarse en Norteamérica.
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Dimensiones y 
Peso

Modelos A & C
336 (a) x 250 (l) x 24,8 - 35,7 (h) mm
2,2 kgs con batería de 6 elementos

Modelos B & D
359 (a) x 268 (l) x 24,8 - 37 (h) mm
2,5 kgs con batería de 6 elementos

Opciones

*Nota: Los módulos
opcionales Bluetoo-
th y 3.5G no pueden
coexistir. Si una de las
opciones de fábrica
está incluida en su op-
ción de compra, la
otra no estará dispo-
nible.

Opciones del módulo de unidad óptica:
Unidad combinada
Unidad de DVD-Dual (Super Multi) 

Módulo WLAN USB 802.11b/g

Batería de Litio-Ion inteligente de 9 elementos, 
7200mAH

Módulo cámara PC USB de1,3M o 2,0M píxeles 
(opción de fábrica)

Módulo lector de huellas digitales (opción de 
fábrica - Modelos C & D)

*Módulo Bluetooth USB + EDR  - V2.0 (opción de 
fábrica)
O
*Módulo UMTS/HSPDA-based 3.5G con interfaz Mini 
Card (opción de fábrica)
Quad-banda GSM/GPRS (850 MHz, 900 MHz,   1800 
MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Característica Especificación

Modos UMTS

Tenga en cuenta que los modos UMTS NO
PUEDEN usarse en Norteamérica.
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Avviso
La società si riserva il diritto di revisionare la presente pubblicazione o di modificarne il contenuto senza preavviso. Le
informazioni qui contenute sono per solo riferimento e non costituiscono obbligo sulle parti del produttore o di qualsiasi
venditore successivo. Essi non si assumono alcuna responsabilità o obbligo per qualsiasi errore o imprecisione presente in
questa pubblicazione, né sono responsabili per qualsiasi perdita o danno risultante dall'uso (o cattivo uso) della presente
pubblicazione.
Questa pubblicazione e ogni software fornito a corredo non può, in parte o per intero, essere riprodotta, tradotta, trasmessa
o ridotta in una forma leggibile da macchine senza previo consenso dei venditori, produttori e creatori della pubblicazione
stessa, eccetto per le copie tenute dall'utente a scopo di backup.
I marchi e i nomi dei prodotti menzionati in questa pubblicazione possono o meno costituire copyright e/o marchi registrati
delle rispettive società. Essi sono menzionati per solo scopo identificativo e non sono intesi come avallo di tale prodotto o
del suo produttore.

© Marzo del 2008

Marchi registrati
Il presente prodotto incorpora una tecnologia di protezione di copyright protetta dalle rivendicazioni di metodo di alcuni
brevetti degli Stati Uniti o di altri diritti di proprietà intellettuale posseduti da Macrovision Corporation e altri possessori
di diritti. L'uso di questa tecnologia di protezione di copyright deve essere autorizzata da Macrovision Corporation, ed è
intesa per l'uso domestico o altri usi di visualizzazione limitata solo se non diversamente autorizzato da Macrovision
Corporation. La decodifica, la decompilazione e il disassemblaggio sono proibiti.

Intel, Celeron ed Intel Core sono marchi/marchi registrati della Intel Corporation.
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Informazioni sulla Guida Rapida per l'Utente
Questo manuale rappresenta un’introduzione rapida all’avvio del sistema. Si tratta di un supplemento e non di una
sostituzione del Manuale per l'utente completo in lingua inglese nel formato Adobe Acrobat, memorizzato sul CD-ROM
Device Drivers & Utilities + User's Manual fornito a corredo del computer. Inoltre, questo CD-ROM contiene i driver e
le utilità necessari per il corretto uso del computer.

È possibile che alcune o tutte le funzionalità del computer siano già state configurate. In caso contrario, o se si sta
pianificando di riconfigurare (o reinstallare) componenti del sistema, fare riferimento al Manuale utente completo. Il CD-
ROM Device Drivers & Utilities + User’s Manual non contiene il sistema operativo.

Informazioni di regolamentazione
Le informazioni e le comunicazioni di regolamentazione sono contenute nel Manuale utente completo memorizzato sul
CD-ROM Device Drivers & Utilities + User’s Manual.

Funzionamento delle periferiche Wireless in aereo

In genere, l'utilizzo di dispositivi di trasmissione elettronici portatili è proibito a bordo degli aerei.
Accertarsi che i moduli WLAN/Bluetooth/3.5G siano spenti quando si utilizza il computer in
aereo.
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Istruzioni per la custodia e il funzionamento
Il computer notebook è abbastanza rigido, ma è possibile che possa essere danneggiato. Per evitare qualsiasi danno,
attenersi ai seguenti suggerimenti:

• Non lasciarlo cadere ed evitare urti. Se il computer cade, è possibile che il telaio e i componenti possano esserne 
danneggiati.

• Tenerlo all'asciutto e non provocarne il surriscaldamento. Tenere il computer e l'alimentazione lontani da ogni tipo di 
impianto di riscaldamento. Si tratta di un apparato elettrico. Se acqua o altri liquidi dovessero penetrarvi, esso potrebbe 
risultarne seriamente danneggiato.

• Evitare le interferenze. Tenere il computer lontano da trasformatori ad alta capacità, motori elettrici e altri intensi campi 
magnetici. Ciò ne può impedire il corretto funzionamento e danneggiare i dati.

• Attenersi alle corrette procedure di lavoro con il computer. Spegnere il computer correttamente e non dimenticare di 
salvare il proprio lavoro. Ricordare di salvare frequentemente i propri dati poiché essi potrebbero essere persi nel caso in cui 
la batteria si esaurisse.

• Porre particolare cura nell'utilizzo delle periferiche.

Assistenza
Non provare a riparare il computer da soli. Una tale azione invaliderebbe la garanzia ed esporrebbe l'utente del computer
al pericolo di una scossa elettrica. Fare riferimento al personale dell'assistenza autorizzata. Scollegare il computer
dall'alimentazione. Fare riferimento all'assistenza di personale qualificato nei seguenti casi:

• Quando il cavo di alimentazione è danneggiato o logorato.
• Se il computer è stato esposto alla pioggia o ad altri liquidi.
• Se il computer non funziona normalmente dopo aver seguito correttamente le istruzioni operative.
• Se il computer è caduto o si è danneggiato (non toccare il liquido velenoso in caso di rottura dello schermo LCD).
• Se c'è un odore non usuale, calore o fumo che fuoriesce dal computer.
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Sicurezza relativa all'alimentazione
Il computer presenta specifici requisiti di alimentazione:
• Utilizzare esclusivamente un adattatore approvato per l'utilizzo di questo computer.
• L'adattatore CA/CC potrebbe essere stato progettato per viaggi all'estero, ma richiede ugualmente un'alimentazione stabile e 

continua. Se non si è certi delle specifiche elettriche locali, consultare l'assistenza tecnica o la società locale di fornitura elettrica.
• L'adattatore di alimentazione deve avere una spina dotata di messa a terra a due o tre poli. Il terzo polo costituisce un'importante 

funzionalità di sicurezza. Non rinunciare al suo impiego. Se non è disponibile una presa compatibile, farne installare una da un 
elettricista qualificato.

• Quando si desidera scollegare il cavo dell'alimentazione, accertarsi di scollegarlo toccando la testa della spina, non il suo cavo.
• Accertarsi che la presa e ogni prolunga utilizzata siano in grado di supportare il carico di corrente totale risultante da tutte le 

periferiche collegate.
• Prima di pulire il computer, assicurarsi di scollegarlo da qualsiasi sorgente di alimentazione esterna.

Pulizia
Non applicare alcun detergente direttamente sul computer, utilizzare solo un panno morbido e pulito. Non utilizzare
detergenti volatili (distillati di petrolio) o abrasivi su qualsiasi parte del computer.

Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento, accertarsi di aver spento il computer e di aver scollegato tutti i cavi e le
periferiche (incluse le linee telefoniche). È inoltre consigliabile rimuovere la batteria al fine di evitare l'accensione accidentale del
computer.

Spegnimento prima di un viaggio

Assicurarsi che il notebook sia completamente spento prima di inserirlo in una borsa da viaggio (o in un contenitore simile). Inserendo
un computer ancora acceso in una borsa da viaggio, la (le) ventola (ventole) ne saranno ostruite. Per evitare il surriscaldamento del
computer, accertarsi di non ostruire la (le) ventola (ventole) quando il computer è in uso.
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Precauzioni relative alla batteria
• Utilizza unicamente batterie progettate per questo computer. Un tipo di batteria errato potrebbe esplodere, avere perdite o 

danneggiare il computer.
• Non continuare a usare in alcun modo una batteria che sia caduta in terra o che sembri danneggiata (es. piegata o torta). 

Anche se il computer continua a funzionare con una batteria danneggiata, questa può provocare danni ai circuiti risultanti in 
pericolo di incendio.

• Ricaricare le batterie utilizzando il sistema del notebook. Un'operazione di ricarica non corretta può far esplodere la 
batteria.

• Non provare a riparare il pacco batteria. Fare riferimento sempre all'assistenza tecnica o a personale qualificato per la 
riparazione o la sostituzione del pacco batteria.

• Tenere i bambini lontani da una batteria danneggiata e provvedere tempestivamente al suo smaltimento. Smaltire sempre 
con cura le batterie. Le batterie possono esplodere o presentare perdite se esposte a fuoco oppure se manipolate o smaltite 
impropriamente.

• Tenere la batteria lontana da qualsiasi apparecchio di metallo.
• Apporre del nastro adesivo sui contatti della batteria prima di smaltirla.
• Non toccare i contatti della batteria con le mani o con oggetti metallici.

Smaltimento della batteria & Attenzione

Il prodotto acquistato contiene una batteria ricaricabile. La batteria è riciclabile. Al termine della durata di uso, in base alle diverse
leggi locali e statali, può essere illegale smaltire questa batteria insieme ai rifiuti comuni. Controllare i requisiti previsti nella propria
zona consultando i funzionari locali addetti allo smaltimento dei rifiuti solidi per le opzioni di riciclo o lo smaltimento corretto.

Pericolo di esplosione in caso sostituzione errata della batteria. Sostituire solamente con lo stesso tipo o con uno analogo
raccomandato dal produttore. Eliminare la batteria usata seguendo le istruzioni del produttore.
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Differenze dei modelli
Questa serie di notebook comprende quattro tipi di modelli differenti (ciascun modello comprende diversi stili di design).
L'aspetto esteriore definitivo e alcuni pulsanti Hot-Key possono apparire leggermente diversi da quelli illustrati in questo
manuale. Tuttavia tutte le porte, i componenti, le funzioni e così via sono le stesse per tutti gli stili di design. Le differenze
tra i modelli sono riportate nella tabella seguente.

Tabella 1 - Differenze dei modelli

Funzionalità Modello A Modello B Modello C Modello D

Logica del core SiS M672 + SiS968 SiS M671DX + SiS968

Scheda Video Video integrato SiS (interno sul chip) Video discreto NVIDIA (esterno su scheda)

Adattatore CA/CC 65W (Uscita CC 19V, 3,42A o 18,5V, 3,5A) 90W (Uscita CC 19V, 4,74A)

Tipo di schermo 
LCD 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 

WSXGA+ 14,1" WXGA/ WXGA+ 15,4" WXGA/ WXGA+/ 
WSXGA+

Lettore d’impronte 
digitali No No opzione opzione
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Guida di avvio rapido
1. Eliminare tutti i materiali di imballo.
2. Appoggiare il computer su una superficie stabile.
3. Collegare bene le periferiche che si desidera usare con il notebook (per esempio tastiera e mouse) alle porte corrispondenti.
4. Collegare l'adattatore CA/CC al jack di ingresso CC situato alla sinistra del computer, quindi inserire il cavo di alimentazione CA in 

una presa e collegare il cavo di alimentazione CA all'adattatore CA/CC.
5. Con una mano sollevare con cautela il coperchio/LCD fino a un angolo di visione comodo (non superare i 130 gradi), mentre con 

l'altra mano (come illustrato nella seguente Figura 1) si mantiene la base del computer (nota: non sollevare mai il computer 
tenendolo dal coperchio/LCD).

6. Premere il pulsante di alimentazione per accendere.

Figura 1 - Apertura del coperchio/LCD/Computer con alimentatore AC/DC collegato

Spegnimento

È importante tenere presente che è sempre necessario spegnere il computer scegliendo il comando Arresta il sistema di-
sponibile dal menu del pulsante Blocca di Windows Vista. In questo modo si evitano problemi al sistema o al disco rigido. 
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Software del sistema
È possibile che il software sia già pre-installato sul
computer. In caso contrario, oppure in casi di
riconfigurazione del computer per un sistema diverso,
questo manuale si riferisce al sistema operativo Microsoft
Windows Vista. Ulteriori informazioni sull’installazione di
driver e utilità sono disponibili nei Capitoli 4 & 7 del
Manuale per l’utente esteso oppure nel CD-ROM Device
Drivers & Utilities + User’s Manual.

Sistemi operativi supportati

Non incluso
I sistemi operativi (per esempio Windows Vista/Windows
XP) sono dotati di manuali propri, come pure le
applicazioni (per esempio, programmi di elaborazione
testo, fogli di calcolo e database), quindi consultare i
manuali specifici.

Driver

Se si sta installando/disinstallando un nuovo software di siste-
ma, sarà necessario installare i driver appropriati. I driver sono
programmi che agiscono da interfaccia tra il computer e il com-
ponente hardware (ad es. il modulo di rete wireless). È molto
importante installare i driver nell'ordine elencato nella
Tabella 6 a pagina 190. Non sarà possibile utilizzare la mag-
gior parte dei controlli avanzati finché i driver e le utilità neces-
sarie non sono state correttamente installate.

Sistema 
operativo Nota

Windows XP 
(Home Edition o 

Professional)

Per informazioni sul SO Windows XP 
(consultare il CD-ROM Device Drivers & 
Utilities + User’s Manual).

Windows Vista con 
Service Pack 1 
(64-bit) Home 
Basic Editon/ 

Home Premium 
Editon/Business 

Editon
/Enterprise Editon/

Ultimate Editon

Accertarsi di installare il Service Pack 1 
di Windows Vista (o una versione di 
Windows Vista che include il Service 
Pack 1) prima di installare qualsiasi 
driver. Andare al sito web della Micro-
soft per i dettagli relativi al download, o 
rivolgersi al proprio centro servizi.

Per avviare Windows Vista senza limi-
tazioni o prestazioni inferiori, è necessa-
rio che il computer disponga di almeno 
1GB di memoria di sistema (RAM).
176 -  Software del sistema
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Descrizione del sistema: Vista anteriore con 
pannello LCD aperto (Modelli A & C)

Figura 2
Vista anteriore con pan-

nello LCD aperto
(Modelli A & C)

1. Camera PC opzionale
2. Schermo LCD
3. Altoparlanti incorporati
4. Pulsante di 

alimentazione
5. Pulsanti Hot-Key
6. Tastiera
7. Microfono incorporato
8. TouchPad e pulsanti
9. Lettore d’impronte 

digitali (opzionale solo 
per il Modelli C & D)

10. Indicatori LED

Funzionamento del dispositivo 
senza fili a bordo di un aereo

Solitamente l’uso di qualsiasi
dispositivo di trasmissione
elettronica è proibito a bordo di un
aereo. Accertarsi che i moduli
wireless siano spenti quando
si utilizza il computer in aereo.
 
Utilizzare la combinazione di tasti
appropriata per disattivare i moduli
WLAN/Bluetooth/3.5G e verificare
l'indicatore di stato e l'icona
nell'area di notifica per accertarsi
che i moduli siano spenti  (vedere
la Tabella 3 a pagina 179/ la
Tabella 5 a pagina 181).

2

5

1

7

8

4

6

9

33

10 10
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Descrizione del sistema: Vista anteriore con 
pannello LCD aperto (Modelli B & D)

Figura 3
Vista anteriore con pan-

nello LCD aperto
(Modelli B & D)

1. Camera PC opzionale
2. Schermo LCD
3. Altoparlanti incorporati
4. Pulsante di 

alimentazione
5. Pulsanti Hot-Key
6. Tastiera
7. Microfono incorporato
8. TouchPad e pulsanti
9. Lettore d’impronte 

digitali (opzionale solo 
per il Modelli C & D)

10. Indicatori LED

Funzionamento del dispositivo 
senza fili a bordo di un aereo

Solitamente l’uso di qualsiasi
dispositivo di trasmissione
elettronica è proibito a bordo di un
aereo. Accertarsi che i moduli
wireless siano spenti quando
si utilizza il computer in aereo.
 
Utilizzare la combinazione di tasti
appropriata per disattivare i moduli
WLAN/Bluetooth/3.5G e verificare
l'indicatore di stato e l'icona
nell'area di notifica per accertarsi
che i moduli siano spenti  (vedere
la Tabella 3 a pagina 179/ la
Tabella 5 a pagina 181).
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1

7

8

4

6

9

33

10 10
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Indicatori LED
I due gruppi di indicatori LED (Indicatori LED di stato e
Indicatori LED alimentazione e comunicazione) sul
computer segnalano importanti informazioni relative allo
stato corrente del computer.

Tabella 2 - Indicatori LED di stato

Tabella 3 - Indicatori LED alimentazione e 
comunicazione

Icona Colore Descrizione

Verde Il disco rigido è in uso

Verde La funzione blocco numerico (tastierino 
numerico) è attivata

Verde Bloc Maiusc è attivato

Verde Bloc Scorr è attivato

Icona Colore Descrizione

Arancione L'alimentatore è collegato

Verde Il computer è acceso

Verde lampeg-
giante

Il computer è in modalità Sospen-
sione

Arancione La batteria è in carica

Verde Batteria completamente carica

Arancione 
lampeggiante

La batteria ha raggiunto lo stato 
critico di carica bassa

Verde Il modulo LAN Wireless è attivo

Arancione Il modulo Bluetooth è attivo
Indicatori LED - 179
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Pulsanti Hot-Key & tastiera
I pulsanti Hot-Key forniscono accesso immediato al
browser Internet predefinito e al programma di posta
elettronica. Inoltre consentono di attivare/disattivare la
Modalità silenziosa con la pressione di un pulsante quick.

Tabella 4 - Pulsanti Hot-Key

*Quando attivata, la Modalità silenziosa riduce il rumore
della ventola e consente di ridurre il consumo energetico.
Tuttavia è possibile che le prestazioni del computer
subiscano un calo.

Nella tastiera è stato integrato un tastierino numerico per un
facile inserimento dei numeri. Dispone anche di tasti
funzione che consentono di cambiare istantaneamente le
funzionalità operative (vedere la Figura 4).

Figura 4  - Tastiera

Pulsante 
Hot-Key Funzione

Attivare il programma di posta elettronica 
predefinito

Attivare il browser Internet predefinito

Attivazione/disattivazione modalità silen-
ziosa* (per risparmio energetico)

Tastierino numerico

Tasti funzione

Tasti Bloc Num & Bloc Scorr 
Attiva/disattiva
modulo 3.5G

Tasto Fn

Caratteri speciali

Alcune applicazioni software consentono di utilizzare i tasti
numerici insieme al tasto Alt per produrre caratteri speciali.
Tali caratteri speciali possono essere riprodotti solo utiliz-
zando il tastierino numerico. I tasti numerici regolari (nella
riga superiore della tastiera) non funzionano. Accertarsi che
sia attivo il Bloc Num (tastierino numerico).
180 -  Pulsanti Hot-Key & tastiera
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Tasti funzione/indicatori visivi
I tasti funzione (da F1 a F12) agiscono come Hot-Key quando premuti tenendo premuto il tasto Fn. In aggiunta alle
combinazioni di tasti funzione base, quando è installato il driver hot key (HotKey Driver) sono disponibili gli indicatori
visivi (vedere “Hot-Key” a pagina 191). Dopo aver installato il driver, nella barra delle applicazioni appare l'icona .

Tasti Funzione/indicatori visivi Tasti Funzione/indicatori visivi

Fn + ~ Play/pausa (nei programmi Audio/Video) Fn + F8/F9 Riduzione/Aumento 
luminosità LCD

Fn + 
Attiva/disattiva 
modulo 3.5G Fn + F10 Attiva/disattiva 

Camera PC

Fn + F1 Attiva/disattiva Tou-
chPad Fn + F11 Attiva/disattiva LAN 

Wireless

Fn + F2
Spegne la retroilluminazione dello schermo LCD 
(premere un tasto o utilizzare il TouchPad per 
ripristinare lo schermo)

Fn + F12 Attiva/disattiva 
Bluetooth

Fn + F3 Commutazione 
Mute

Fn + Bloc 
Num

Attiva/disattiva blocco numerico (tastierino nume-
rico) 

Fn + F4 Commutazione Sospendi Fn + Bloc 
Scorr Attiva/disattiva il blocco dello scorrimento

Fn + F5/
F6

Riduzione/Aumento 
volume audio

Attiva/disattiva la 
modalità silenziosa

Fn + F7 Commutazione Display Tabella 5 - Tasti funzione e indicatori visivi
Pulsanti Hot-Key & tastiera - 181
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Descrizione del sistema: Vista anteriore e 
sinistra

Figura 5
Vista anteriore e sinistra

1. Indicatori LED
2. Jack uscita delle cuffie
3. Porta per monitor 

esterno 
4. Jack di rete tipo RJ-45
5. Ventola
6. 2 Porte USB 2.0 
7. Slot ExpressCard/54(34)
8. Lettore di schede 7-in-1

Lettore di schede 7-in-1

Il lettore di schede consente di utilizzare alcune tra le più recenti schede di memoria digitali.
 

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (richiede PC adattatore) /

Mini SD (richiede PC adattatore) / RS MMC (richiede PC adattatore)

Lato anteriore

Lato sinistro

1

2 54
6

3
76 8
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Descrizione del sistema: Vista destra e posteriore
Figura 6

Vista destra e 
posteriore

1. Jack uscita S/PDIF 
2. Jack ingresso del 

microfono
3. Jack uscita delle cuffie
4. Porta USB 2.0 
5. Bay unità ottica (per 

periferiche CD/ DVD)
6. Foro di espulsione di 

emergenza
7. Jack telefonico tipo RJ-

11
8. Slot blocco di sicurezza
9. Batteria

Modifica dei Codici Regionali dei DVD

Aprire il Pannello di controllo, fare doppio clic su
Gestione dispositivi (Hardware e suoni), quindi
fare clic sul segno + accanto a Unità DVD/CD-
ROM. Fare doppio clic sulla periferica DVD-ROM
per visualizzare il menu Proprietà, quindi selezio-
nare la scheda Regione DVD per avviare il pannel-
lo che consente di selezionare il codice regionale.

La rilevazione regionale DVD dipende dal disposi-
tivo e non dal sistema operativo. È possibile sele-
zionare il codice regionale del modulo 5 volte. La
quinta selezione è permanente. Non può essere
modificata anche cambiando il proprio sistema
operativo, oppure usando il modulo in un altro com-
puter.

Espulsione di emergenza CD

Se si desidera estrarre manualmente un CD/
DVD (per esempio a causa di un'inaspettata
interruzione dell'alimentazione) è possibile
spingere l'estremità di una graffetta per
carta raddrizzata nel foro di espulsione di
emergenza. Non usare una matita appuntita
o un oggetto analogo che potrebbe rompersi
oppure rimanere incastrato nel foro.

Avvertenza supporti

Non cercare di estrarre un disco floppy/CD
durante l’accesso del sistema. Ciò può
provocare un arresto del sistema.

Côté droit

Côté gauche1 52 4

9

3 6 7 8

Lato destro

Lato posteriore
Descrizione del sistema: Vista destra e posteriore - 183
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Model A - Left
Descrizione del sistema: Vista inferioreFigura 7
 Vista inferiore

1. Batteria
2. Coperchio modulo 

Bluetooth
3. Coperchio bay CPU/

RAM
4. Ventola
5. Coperchio bay disco 

rigido 
6. Posizione scheda 

USIM 3.5G

Informazioni sulla batteria

Prima di utilizzare una batteria nuova,
scaricarla prima completamente, quindi
caricarla al massimo. Scaricare comple-
tamente e caricare la batteria almeno
una volta ogni 30 giorni oppure dopo una
ventina di cariche parziali.

CPU

La CPU non è un componente che
necessita assistenza da parte
dell’utente. Accedere alla CPU in
qualsiasi modo implica una violazione
della garanzia.

Surriscaldamento

Per prevenire il surriscaldamento del
computer, accertarsi che non vi sia nulla
che ostruisca la (le) ventola (ventole)
durante l’uso del computer.

2

3

1

4

4

5
6

2

3

1

4

4

5
6

Modelli A & C 

Modelli B & D 
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Menu Start e Pannello di controllo di Windows Vista
La maggior parte dei pannelli di controllo, utilità e programmi che compongono Windows Vista (e la maggior parte delle
versioni di Windows) sono accessibili tramite il menu Start. Quando si installano programmi e utilità, essi vengono
installati sul disco rigido, mentre un collegamentoche punta ad essi viene inserito nel menu Start e/o sul desktop. Fare clic
con il tasto destro sull'icona  , del menu Start quindi selezionare Proprietà per personalizzare l'aspetto del Menu Start.

In molte sezioni del presente manuale l'utente avrà modo di notare riferimenti al Pannello di controllo. Al Pannello di
controllo è possibile accedere attraverso il menu Start. Il Pannello di controllo consente di configurare le impostazioni
per la maggior parte delle funzionalità principali presenti in Windows (ad es. alimentazione, video, rete, audio, ecc.). Win-
dows Vista fornisce pannelli di controllo di base per molte delle funzionalità, tuttavia molti altri pannelli di controlli ven-
gono aggiunti (o quelli esistenti migliorati) quando si installano i driver elencati nella Tabella 6 a pagina 190. Per
visualizzare tutti i controlli potrebbe essere necessario attivare la visualizzazione classica.

Figura 8 - Menu Start & Pannello di controllo

 Fare clic qui per passare alla Visua-
lizzazione classica
Menu Start e Pannello di controllo di Windows Vista - 185
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Funzioni video
Questo computer presenta due opzioni video differenti (SiS per Modelli A & B o NVIDIA per Modelli C & D). È
possibile modificare le Impostazioni di visualizzazione dal pannello di controllo Impostazioni schermo (in
Personalizzazione) in ambiente Windows Vista o dal Centro di controllo SiS VGA/Pannello di controllo NVIDIA.

Per accedere alle Impostazioni schermo in Window Vista:

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo). 
2. Fare clic su Modifica risoluzione dello schermo nel menu Aspetto e personalizzazione menu (o fare doppio clic  

personalizzazione > Impostazioni schermo).
3. Scorrere l'indicatore nella posizione desiderata in  Risoluzione  (vedere la Figura 9 a pagina 187).
4. Fare clic sulla freccia e selezionare l'impostazione desiderata in Colori  (vedere la Figura 9 a pagina 187).
5. Fare clic su Impostazioni avanzate...  (vedere la Figura 9 a pagina 187) per visualizzare le schede delle Impostazioni 

avanzate.

Per accedere al Centro di controllo SiS VGA (Modelli A & B):
1. È possibile accedere al Centro di controllo SiS VGA facendo clic con il pulsante destro del mouse sull'icona dell'area di notifica 

SiSTray , e selezionando Centro di controllo (oppure da SiS VGA Control Center nel Pannello di controllo di Windows).

Per accedere al Pannello di controllo NVIDIA (Modelli C & D):
1. È possibile accedere al Pannello di controllo NVIDIA facendo clic con il pulsante destro del mouse sul desktop e scegliendo 

Pannello di controllo NVIDIA (oppure da NVIDIA Control Panel nel Pannello di controllo di Windows).

1
2

3

186 -  Funzioni video
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Figura 9 - Impostazioni schermo & Centro di controllo/Pannello di controllo 

21

3

21

3
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Funzioni di risparmio energetico
Il pannello di controllo delle Opzioni risparmio energia (menu Hardware e suoni) di Windows (vedere la pagina 185)
consente la configurazione delle funzioni di risparmio energetico del computer. Selezionando Risparmio di energia è
possibile attivare questa funzione e configurare le opzioni relative al pulsante di alimentazione, pulsante di sospensione,
coperchio del computer (chiuso), schermo e modalità sospensione. Nota: la funzione Risparmio di energia può influire
sulle prestazioni del computer.

Fare clic su una delle combinazioni esistenti o su Crea combinazione per il risparmio di energia sul menu di sinistra e
personalizzarla per creare una nuova combinazione. Fare clic su Modifica impostazioni combinazione, quindi su Cambia
impostazioni avanzate risparmio energia per accedere a ulteriori opzioni di configurazione.

Figura 10 - Opzioni risparmio energia

Nota: Sospensione è lo stato di risparmio di energia predefinito per Window Vista
188 -  Funzioni di risparmio energetico
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Funzionalità audio
È possibile configurare le opzioni audio del computer dal pannello di controllo Audio  di
Windows, oppure dall'icona Gestione Audio Realtek HD /  nell'area di notifica/
pannello di controllo (fare clic con il pulsante destro del mouse sull'icona   per aprire un
menu audio). Il volume può essere regolato anche con la combinazione di tasti Fn + F5/F6.

Figura 11 - Gestione Audio Realtek HD

Regolazione del volume 
audio

Il livello del volume del suo-
no viene impostato utiliz-
zando il comando di
regolazione volume di Win-
dows (e i tasti funzione vo-
lume sul computer). Fare
clic sull'icona Volume nella
barra delle applicazioni per
controllare l'impostazione.

Fare clic con il 
pulsante destro del 
mouse sull'icona  
per accedere al 
menu sopra.
Funzionalità audio - 189
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Installazione driver
Il CD-ROM Device Drivers & Utilities + User’s Manual
contiene i driver e le utilità necessari per il corretto
funzionamento del computer. Inserire il CD-ROM e fare
clic su Install Drivers (pulsante), oppure il pulsante
Option Drivers per accedere al menu del driver opzionale.

Installare i driver attenendosi all'ordine indicato nella
Tabella 6. Dopo l'installazione di ciascun driver, lo stesso
viene oscurato (se occorre reinstallare uno dei driver, fare
clic sul pulsante Unlock).

Installazione manuale dei driver
Fare clic sul pulsante Browse CD (Sfoglia CD)
nell'applicazione Drivers Installer e selezionare il file
eseguibile nella cartella del driver corrispondente.

Windows Update
Dopo l'installazione di tutti i driver assicurarsi di aver
attivato Window update per ottenere tutti i recenti
aggiornamenti di sicurezza ecc. (tutti gli aggiornamenti
includeranno i più recenti hotfixes di Microsoft).

Tabella 6 - Procedura di installazione

Driver (Windows Vista con SP1) Pagina#

Video pagina 191

Audio pagina 191

Modem pagina 191

Rete (LAN) pagina 191

TouchPad pagina 191

Lettore di schede pagina 191

Hot-Key pagina 191

Camera PC (opzione) pagina 192

LAN Wireless (opzione) pagina 195

3.5G (opzione) pagina 197

Lettore d’impronte digitali (opzione) - solo per 
i Modelli C e D pagina 201

Bluetooth (opzione)
Nota: Non è necessaria nessuna installazione i driver (vedere 
la pagina 203)

Attivare Window update (vedere a sinistra)
190 -  Installazione driver
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Video
1. Fare clic su 1.Install Video Driver > Sì.

Modelli A & B (SiS):
2. Fare clic su Sì (scegliere Sì per visualizzare il file 

ReadMe).
3. Fare clic su Sì per riavviare il computer.

Modelli C & D (NVIDIA):
4. Fare clic su Avanti.
5. Fare clic su Fine per riavviare il computer.

Audio
1. Fare clic su 2.Install Audio Driver > Sì.
2. Fare clic su Avanti.
3. Fare clic su Fine per riavviare il computer.

Modem
1. Fare clic su 3.Install Modem Driver > Sì.
2. Fare clic su OK.
3. Il modem è pronto per la configurazione della 

connessione.

Rete (LAN)
1. Fare clic su 4.Install Lan Driver > Sì.
2. Fare clic su Avanti.
3. Fare clic su Fine > Fine per riavviare il computer.
4. Ora è possibile configurare le impostazioni di rete.

TouchPad
1. Fare clic su 5.Install Touchpad Driver > Sì.
2. Fare clic su Avanti.
3. Fare clic su Fine > Riavvia ora per riavviare il computer.

Lettore di schede
1. Fare clic su 6.Install Cardreader Driver > Sì.
2. Fare clic su Avanti > Avanti.
3. Fare clic su Fine per riavviare il computer.

Hot-Key
1. Fare clic su 7.Install HOTKEY Driver > Sì.
2. Fare clic su Next > Install.
3. Fare clic su Finish > Finish per riavviare il computer.
Installazione driver - 191
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Camera PC
Il modulo camera PC utilizza l'applicazione BisonCap per
catturare i file video.

Installazione del driver della camera PC
1. Accendere il modulo con la combinazione Fn + F10 

(l'indicatore visivo  viene visualizzato per breve 
tempo quando il modulo è acceso).

2. Fare clic su Option Drivers (pulsante).
3. Fare clic su 1.PC Camera, Web cam > Sì.
4. Scegliere la lingua desiderata e fare clic su  Avanti.
5. Fare clic su Avanti > Fine per riavviare il computer.
6. Eseguire l'applicazione BisonCap dal collegamento sul 

desktop oppure dalla voce BisonCam del menu Start > 
Programmi/Tutti i programmi (se l'hardware è spento, 
utilizzare la combinazione di tasti Fn + F10 per 
riaccenderlo).

Configurazione audio della camera PC
Configurare le opzioni di registrazione audio in Windows
per catturare video e audio con la camera.

1. Fare clic su Start, e fare clic su Pannello di controllo 
(oppure scegliere Impostazioni e fare clic su Pannello di 
controllo). 

2. Fare clic Audio  (Hardware e suoni).
3. Fare clic Registrazione (scheda).
4. Fare clic con il pulsante destro del mouse su Microfono 

(Realtek High Definition Audio) et accertarsi che la voce non 
sia disabilitata.

5. Fare doppio clic su Microfono (o selezionare Proprietà dal 
menu di scelta rapida ottenuto con il tasto destro del mouse).

6. Scegliere Livelli (scheda) e regolare i cursori Microfono e 
Preamplificazione microfono) per ottenere il livello richiesto.

7. Fare clic su OK, quindi chiudere i pannelli di controllo.
8. Avviare il programma BisonCap dal menu Start > 

Programmi/Tutti i programmi > BisonCam.
9. Aprire il menu Dispositivi e selezionare Microfono (Realtek, 

ecc.) (accanto ad esso dovrebbe essere presente un segno di 
spunta).

10. Aprire il menu Cattura e selezionare Audio cattura (accanto 
ad esso dovrebbe essere presente un segno di spunta).

Informazioni piu recenti sui driver della camera PC

Verificare sul disco Device Drivers & Utilities + User’s Manual, e
su qualsiasi inserto a corredo, la presenza di informazioni
recenti relative al driver della camera PC che potrebbero
differire da quelle fornite in questo documento in quanto più
aggiornate.
192 -  Camera PC
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BisonCap
L’applicazione BisonCap è un utile visualizzatore video
per la visualizzazione e il test di video generali, ed è inoltre
in grado di catturare file video in formato .avi.

1. Avviare il programma BisonCap dal menu Start > 
Programmi/Tutti i programmi > BisonCam (si consiglia di 
Impostare Cattura File prima del processo di cattura - vedere 
"Imposta cattura file" di seguito).

2. Aprire il menu Cattura (se si desidera catturare file di audio 
vedere “Configurazione audio della camera PC” a 
pagina 202) e selezionare Avvia cattura.

3. Fare clic su OK (la collocazione del file verrà visualizzata nella 
casella a scomparsa), per avviare la cattura, quindi premere 
Esc per interromperla (è possibile visualizzare il file 
utilizzando Windows Media Player).

Imposta cattura file
Prima di effettuare la cattura dei file di video si può selezionare
l'opzione Imposta file di cattur nel menu File e impostare il
nome del file e la collocazione prima della cattura (questo
contribuirà a evitare la sovrascrittura dei file). Impostare il
nome e la collocazione poi cliccare Apri, quindi impostare la
"dimensione del file di cattura:" e cliccare "OK". Quindi  è
possibile avviare il processo di cattura di cui sopra.

Zoom 
Il programmi BisonCap consente di ingrandire e ridurre
con la camera.

1. Avviare il programma BisonCap.
2. Aprire il menu Zoom e selezionare Nagyítás/Kicsinyítés.

Prendere immagini fisse
Il programmi BisonCap consente di prendere immagine
fisse.

1. Avviare il programma BisonCap.                                                                                   
2. Aprire il menu Opzioni e selezionare Scatta foto.
3. La fotografia (in formato JPEG) viene inserita nella cartella 

Snapshot  del desktop (non rimuovere o rinominare la 
cartella).
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Eliminazione dello sfarfallio dello schermo
Se la schermata del video nel programma BisonCap ha uno
sfarfallio, è possibile provare a regolare l'impostazione
nelle opzioni Video Capture Filter (filtro di cattura
video).

1. Avviare il programma BisonCap.
2. Aprire il menu Options e selezionare Video Capture Filter....
3. Scegliere 50Hz oppure 60Hz sotto Frequenza nella scheda 

Pagina delle proprietà.

Riduzione delle dimensioni dei file video
Si noti che la cattura di file video ad alta risoluzione
richiede una grande quantità di spazio sul disco rigido per
ogni file. Dopo aver registrato il video, controllare le
dimensioni del file video (fare clic con il pulsante destro del
mouse sul file e scegliere Proprietà) e lo spazio libero
rimanente sul disco rigido (aprire Computer, fare clic con
il pulsante destro del mouse sul disco rigido e scegliere
Proprietà). Se necessario è possibile spostare il file video
registrato su un supporto rimovibile, ad esempio CD, DVD
o unità flash USB.

Si noti che il sistema operativo Windows Vista richiede
almeno 15GB di spazio libero sulla partizione di sistema
dell'unità C:. Per evitare problemi al sistema si consiglia di

salvare il file del video in una posizione diversa dall'unità
C: (vedere “Imposta cattura file” a pagina 193), limitare
le dimensioni dei file del video catturato o ridurre la
risoluzione del video.

Per ridurre le dimensioni della risoluzione di ou-
tput del video
1. Eseguire il programma BisonCap.
2. Aprire Opzioni e scorrere in giù per selezionare Video 

Capture Pin....
3. Scegliere l'elenco Dimensioni output e selezionare una 

risoluzione inferiore per ridurre le dimensioni del file 
catturato.
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LAN Wireless

Installazione del driver del modulo LAN 
Wireless
1. Accertarsi che il modulo sia acceso.
2. Fare clic su Option Drivers (pulsante).
3. Fare clic su 2.Wireless Lan > Sì.
4. Scegliere la lingua desiderata e fare clic su Avanti.
5. Fare clic su Avanti > Installa.
6. Fare clic su Fine per completare l'installazione.

Nota: Il sistema operativo è l'impostazione predefinita per
il controllo LAN wireless in Window Vista.

Connessione a una rete wireless
Accertarsi che il modulo LAN Wireless sia acceso.

1. Fare clic sull'icona della WLAN  nella barra delle 
applicazioni, e quindi fare clic su Connessione a una rete  (o 
fare clic con il pulsante destro del mouse sull'icona , e 
quindi fare clic su Connessione a una rete).

2. Nell'elenco Mostra, scegliere Wireless dal menu a tendina.
3. Verrà visualizzato un elenco delle reti disponibili al momento.
4. Fare clic su una rete e quindi su Connetti.
5. In caso non venisse visualizzata una rete alla quale si 

desidera connettersi, fare clic su Configura una 
connessione o una rete (verrà visualizzato un elenco di 
opzioni che consente la ricerca manuale e la creazione di una 
nuova rete).

6. Spostare il cursore sull'icona  della barra delle applicazioni 
per visualizzare lo stato della connessione.

7. Per disconnettersi dalla rete wireless è possibile fare clic 
sull'icona , della barra delle applicazioni e selezionare 
Connetti o disconnetti... per accedere al menu della rete, 
quindi fare clic su Disconnetti (o fare clic con il pulsante 
destro del mouse sull'icona , e quindi fare clic su 
Disconnetti da).

Accensione/spegnimento del modulo LAN Wireless 

Attivare l'alimentazione al modulo LAN Wireless utilizzando la
combinazione di tasti (Fn + F11). Quando il modulo LAN Wire-
less è acceso, il LED  è di colore verde e l'indicatore visivo

 viene visualizzato per breve tempo.
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Modulo 3.5G
Se nell'opzione di acquisto è stato incluso un modulo 3.5G
opzionale, seguire le istruzioni sotto per installare la carta
USIM (presumibilmente fornita dal proprio operatore),
quindi installare l'applicazione.

1. Spegnere il computer, girarlo e rimuovere la batteria.
2. Individuare il coperchio della carta SIM e svitare la vite  in 

Figura 12.
3. Rimuovere il coperchio della carta SIM  in Figura 12.
4. Inserire la carta USIM nel cellulare, come si farebbe per il 

proprio cellulare.
5. Far scorrere il BLOCCO DELLA SIM verso il perno (in 

direzione opposta alla freccia raffigurata in Figura 13) per 
rilasciare il blocco e sollevare.

Figura 12 - Rimozione del coperchio della carta SIM
6. Inserire la carta USIM come illustrato nella (Figura 13) e 

chiudere il FERMO DELLA SIM.
7. Chiudere il FERMO DELLA SIM premendolo nella direzione 

della freccia in Figura 13 fino a farlo scattare in posizione di 
blocco.

8. Sostituire il coperchio, la vite e la batteria.

Figura 13 - Inserimento della carta USIM & blocco del 
FERMO DELLA SIM

Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento,
accertarsi di aver spento il computer e di aver scollegato tutti i
cavi e le periferiche (incluse le linee telefoniche). È inoltre
consigliabile rimuovere la batteria al fine di evitare l'accensione
accidentale del computer.

1

2

2

1
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Applicazione 3G Watcher
Una volta installati il modulo 3.5G e la carta USIM (forniti
dal proprio operatore) è possibile installare l'applicazione
3G Watcher. L'applicazione 3G Watcher consente di
accedere direttamente al servizio Internet 3.5G dal
computer.

Installazione dell'applicazione 3G Watcher 
1. Accertarsi che il modulo sia acceso premendo la 

combinazione di tasti Fn +  (l'indicatore visivo  
indica lo stato di alimentazione del modulo).

2. Se compare l’installazione guidata ‘Trovato nuovo 
hardware’, fare clic su Annulla.

3. Fare clic su Option Drivers (pulsante).
4. Fare clic su 3.3G Driver  > Sì.
5. Fare clic su Avanti.
6. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Installa.
7. Alla visualizzazione della schermata successiva attente 

circa 2 minuti prima di scegliere Fine (al fine di 
consentire all'hardware di rilevare la presenza del modulo 
3.5G).

8. L'icona 3G Watcher  comparirà sul desktop.
9. È possibile accedere all'applicazione 3G Watcher dal 

menu Start (Start > Programmi/ Tutti i programmi > 
Sierra Wireless > 3G Watcher), oppure facendo clic 
sull'icona  nella barra delle applicazioni.

Configurazione di un profilo carrier
Sebbene le informazioni di connessione siano memorizzate
sulla carta USIM fornita dal proprio service provider, sarà
necessario configurare il profilo carrier appropriato per il
software 3G Watcher.

1. Utilizzare la combinazione di tasti Fn +  per accendere il 
modulo 3.5G.

2. È possibile accedere all'applicazione 3G Watcher dal menu 
Start (Start > Programmi/ Tutti i programmi > Sierra 
Wireless > 3G Watcher), oppure facendo clic sull'icona  
nella barra delle applicazioni.

3. Fare clic su Strume... e selezionare Opzioni.
4. Fare clic su Profili e quindi su Aggiungi nuovo profilo  

(pulsante), e selezionare Profilo WWAN.

Figura 14 - Aggiungi profilo WWAN
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5. È quindi possibile inserire un nuovo nome di profilo oppure 
scegliere un profilo dall'elenco a discesa visualizzato dal 
software.

6. Sceglier Applica > OK per salvare le informazioni.
7. È possibile scegliere il profilo dal menu a discesa.

Figura 15 - Opzioni utente e selezione del profilo

Connessione al Service Provider
1. Utilizzare la combinazione di tasti Fn +  per accendere il 

modulo 3.5G.
2. È possibile accedere all'applicazione 3G Watcher dal menu 

Start (Start > Programmi/ Tutti i programmi > Sierra 
Wireless > 3G Watcher), oppure facendo clic sull'icona  
nella barra delle applicazioni.

3. Il software si avvia e visualizza il nome del service provider (le 
informazioni di connessione vengono lette dalla carta USIM).

Figura 16 - 3G Watcher

4. Scegliere Connetti per iniziare il processo di connessione.
5. L'applicazione 3G Watcher visualizza quindi nella finestra le 

informazioni di connessione.

Figura 17 - Connessione

Opzioni utente e selezione del profilo

Se si è selezionato il profilo dall'elenco a discesa, la maggior
parte delle informazioni nelle schede Generale e Avanzate
sono state inserite automaticamente (è comunque opportuno
controllare con il service provider quali sono le informazioni
più recenti poiché potrebbe essere necessario immettere
Nome utente e Password).
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6. Una volta stabilita la connessione, viene visualizzata una 
notifica nella barra delle applicazioni (vedere la figura sotto).

Figura 18 - Notifica di connessione nell'area di notifica
7. A questo punto è possibile accedere a internet, scaricare e-

mail e così via, come per qualsiasi altra connessione a 
Internet.

8. Una volta connessi, l'icona nell'area di notifica diventa verde 
 (è rossa  quando il programma è in esecuzione ma 

non c'è connessione).
9. Per disconnettere, scegliere l'icona Disconnetti.

Figura 19 - 3G Watcher connesso
10. Il programma disconnette dal service provider.
11. Il modulo resta acceso e occorre premere la combinazione di 

tasti Fn + .

12. Facendo clic sull'icona di chiusura 3G Watcher , viene 
visualizzato un messaggio che chiede di scegliere OK per 
confermare l'uscita dal programma. 

Figura 20 - Avviso chiusura
13. La chiusura del programma NON spegne il modulo 3.5G, 

quindi occorre premere la combinazione di tasti Fn +  per 
spegnere il modulo (fare particolare attenzione a questo 
aspetto quando si è in aereo) - vedere “Funzionamento 
delle periferiche Wireless in aereo” a pagina 170).

14. Se il modulo è acceso e il computer entra in uno stato di 
risparmio energetico, lo stato di alimentazione del modulo alla 
ripresa dallo stato di risparmio energetico è indicato nella 
pagina successiva:

• Se il modulo 3.5G è acceso e il computer è Spento/ e si 
riavvia il computer, il modulo viene spento all'accensione 
del computer.

• Se il modulo 3.5G è acceso e il computer entra in modalità 
Sospensione/e il computer entra in Ibernazione, il modulo 
viene spento quando il computer esce dalla sospensione.
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Messaggistica SMS
Oltre ai servizi Internet standard è anche possibile inviare e
ricevere messaggi SMS tramite il programma 3G Watcher.

1. L'indicatore dei messaggi SMS  nella finestra 
principale avvisa della ricezione di nuovi messaggi.

2. Fare doppio clic sull'icona  o selezionare Strume... > 
SMS Express....

3. Selezionare la cartella della posta in arrivo e scegliere un 
messaggio da leggere, oppure selezionare File > Nuovo 
messaggio di posta oppure scegliere Nuovo per creare un 
messaggio nuovo.

Per ulteriori dettagli sugli SMS, vedere 3GWatcher Online
Help (guida in linea) dal menu ? (Guida) > Argomenti
della guida.

Guida in linea di 3G Watcher

Per ulteriori dettagli sull'applicazione 3G Watcher è possibile
accedere alla guida in linea dal menu ? (Guida) > Argomenti
della guida.

Scegliere un argomento dalla finestra Sommario (Contents)
per visualizzare i dettagli.
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Lettore d’impronte digitali
Se nell'opzione di acquisto è stato incluso il lettore di
impronte digitali (Opzionale solo per i computer Modelli C
e D) sarà necessario installare il driver secondo le istruzioni
riportate sotto. 

Assicurarsi di avere i diritti amministratore sul proprio
computer, e avere attivato una password di Windows  per
una protezione totale. 

Prima di avviare il processo di registrazione si raccomanda
di seguire l'esercitazione per il lettore d’impronte digitali.
Per avviare l'esercitazione fare clic su Start > Programmi/
Tutti i programmi > Protector Suite QL > Esercitazione
Fingerprint.

Installazione del driver per l'impronta 
digitale
1. Inserire il CD-ROM Device Drivers & Utilities + User’s 

Manual nell’unità CD/DVD.
2. Fare clic su Option Drivers (pulsante).
3. Fare clic su 4.FingerPrint > Sì.
4. Fare clic su Installazione software.
5. Fare clic su Avanti > Avanti > Avanti.
6. Fare clic su Fine > Sì per riavviare il computer.

Registrazione utente
1. Fare clic su Start > Programmi/ Tutti i programmi > 

Protector Suite QL > Registrazione utente, o fare doppio 
clic sull'icona  nella barra delle applicazioni.

2. Al primo avvio del programma viene richiesto di fare clic sul 
pulsante di accettazione della licenza, quindi su OK.

3. Fare clic su Avanti (viene selezionato automaticamente 
"Registrazione nel disco rigido") e fare clic su Fine.

Guida & Manuale

Clic destro sull'icona  della barra delle applicazioni per atti-
vare il menu dove selezionare Guida.

Inserire il CD-ROM Device Drivers & Utilities + User’s Manual
e fare clic su Option Drivers (pulsante). Fare clic su Unlock
(pulsante) et quindi fare clic su 4.FingerPrint > Sì.

Cliccare Documentazione per aprire la cartella dove si trova
il manuale in formato .pdf.

Per installare Adobe Acrobat Reader per leggere il file, inserire
il CD-ROM Device Drivers & Utilities + User’s Manual e fare
clic su User’s Manual (pulsante), e fare clic su Install Acro-
bat Reader (pulsante).
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4. Nel caso non si sia impostata la password Windows apparirà 
l'invito per farlo (nota: Nel caso non sia stata impostata la 
password Protector Suite QL non potrà garantire la 
sicurezza all'accesso al proprio computer).

5. Fare clic su Avanti e quindi si viene invitato a inserire la 
propria password Windows.

6. Fare clic su Avanti > Avanti (attivare la cassella "Lancia l' 
esercitazione interattiva" per lanciare l'esercitazione 
Fingerprint).

7. Fare clic su Avanti ad ogni finestra dell'esercitazione (si può 
premere il pulsante "Salta esercitazione" in qualsiasi 
momento).

8. Premere il pulsante per ogni impronta per avviare il processo 
di registrazione di quell'importa.

9. Passare l'impronta tre volte per registrare la stessa.
10. Ripetere l'operazione per tutte le impronte che si desiderano 

registrare, quindi fare clic su Avanti.
11. Fare clic su Fine.
12. Fare clic su una delle intestazioni sotto "Informazioni su:" per 

visualizzare ulteriori informazioni relative a un argomento.
13. Fare clic su Chiudi.
14. Riavviare il computer.
15. Clic destroy sull'icona  della barra di applicazioni per 

attivare il menu che permette la Modifica impronte, lanciare 
Control Center, accedere al menu Guida ecc. Si può inoltre 
eseguire il Control Center ecc. dalla voce Protector Suite QL 
del menu Start > Programmi/Tutti i programmi.

16. Consultare “Guida & Manuale” a pagina 201 per altri 
dettagli.

17. Se si fa passare il ditto sul lettore ogni volt ache si può 
accedere al  Biomenu per bloccare il computer, registrare 
siti web, aprire il Control Center e accedere il menu Guida.

18. Control Center consente di cambiare le Impostazioni, le 
Impronte digitali e di visualizzare la Guida.

Figura 21 - Control Center & Biomenu 

Registrazione Impronta

Si osservi che viene raccomandato di registrare più di una
impronta in caso di ferita ecc.
202 -  Lettore d’impronte digitali



Guida Rapida per l'Utente

Italiano
Configurazione Bluetooth
Impostare il proprio dispositivo Bluetooth 
in modo che il computer possa trovarlo
1. Accendere il proprio dispositivo Bluetooth (PDA, cellulare 

ecc.).
2. Rendere da trovare il dispositivo (per questo si veda la 

documentazione che accompagna il proprio dispositivo).

Per accendere il Modulo Bluetooth
1. Utilizzare la combinazione di tasti Fn + F12 per accendere il 

modulo Bluetooth. 
2. Un'icona Bluetooth  apparirà nella barra di applicazioni (può 

essere necessario attivare l'opzione dal pannello di controllo 
Dispositivi Bluetooth).

3. Quindi è possibile effettuare una qualsiasi delle azioni 
seguenti per accedere al pannello di controllo Dispositivi 
Bluetooth.

• Fare doppio clic sull'icona  per accedere al pannello di 
controllo Dispositivi Bluetooth.

• Fare clic su Start e fare clic su Pannello di controllo 
(oppure scegliere Impostazioni e fare clic su Pannello di 
controllo), e quindi fare clic su Dispositivi Bluetooth 
(Hardware e suoni).

• Fare clic/Fare clic con il pulsante destro del mouse 
sull'icona  e selezionare un’opzione dal menu.

Figura 22 - Dispositivi Bluetooth e cliccare l'icona Menu

Per aggiungere un dispositivo Bluetooth
1. Accedere al pannello di controllo Dispositivi Bluetooth.
2. Fare clic Opzioni (scheda), e accertarsi che la casella di 

controllo Consenti ai dispositivi Bluetooth di connettersi 
al computer abbia Connessioni sia selezionata.

3. Fare clic Dispositivi (scheda), quindi su Aggiungi.
4. L'Aggiunta guidata dispositivo Bluetooth comparirà.

Trasferimento dati via 
Bluetooth

Si noti che il trasferimen-
to di dati tra il computer
e un dispositivo Blueto-
oth è supportato solo in
una direzione (il trasfe-
rimento dati simulta-
neo non è supportato).
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5. Fare clic per selezionare “Il dispositivo è configurato ed è 
pronto per il rilevamento”, e quindi fare clic su Avanti.

Figura 23 - Aggiunta guidata dispositivo Bluetooth
6. L'assistente procederà alla ricerca per qualsiasi dispositivo 

Bluetooth nel range.
7. Selezionare il dispositivo con il quale si vuole comunicare e 

Cliccare Avanti.
8. Selezionare l'opzione passkey appropriata e cliccare Avanti > 

Fine.

Figura 24 - Opzione passkey

Per cambiare le impostazioni per il 
dispositivo Bluetooth
1. Accedere al pannello di controllo Dispositivi Bluetooth.
2. Cliccare sul dispositivo che si vuole modificare e Cliccare 

Proprietà a:

• Modificare il nome del dispositivo (Cliccare Generale, 
digitare un nuovo nome e cliccare OK).

• Attivare/Disattivare un servizio (cliccare Servizi, seleziona/eli-
mina la casella di controllo accanto al servizio e cliccare OK).

Per rendere da trovare il proprio 
computer Ai dispositivo Bluetooth
1. Accedere al pannello di controllo Dispositivi Bluetooth.
2. Fare clic Opzioni (scheda), e accertarsi che la casella di 

controllo Consenti ai dispositivi Bluetooth di individuare il 
computer abbia Individuazione sia selezionata.

3. Assicurarsi che la casella di controllo Avvisa quando un 
nuovo dispositivo Bluetooth tenta di connettersi abbia 
Connessioni selezionata, se si desidera essere notificati 
quando un dispositivo Bluetooth vuole connettersi.

Figura 25
Dispositivi 
Bluetooth - 

Opzioni
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Risoluzione dei problemi
Problema Possibile causa - Soluzione

Non è possibile rilevare i 
moduli LAN Wireless e 
Bluetooth.

II/I modulo/i è/sono disattivato/i.  Controllare il LED indicatore  per verificare se il/i modulo/i è/sono 
attivato/i o disattivato/i. Se il LED indicatore è spento, quindi premere la combinazione di tasti Fn + F11 
(WLAN) oppure Fn + F12 (Bluetooth) al fine di attivare i moduli (vedere la Tabella 5 a pagina 181).

Il modulo Bluetooth viene 
spento dopo aver ripreso 
dalla modalità 
Sospensione.

Il modulo Bluetooth è spento dopo aver ripreso dalla Sospensione. Lo stato predefinito del modulo 
Bluetooth sarà spento dopo aver ripreso dallo stato di risparmio energetico Sospensione. Utilizzare la 
combinazione di tasti (Fn + F12) per accendere il modulo Bluetooth dopo che il computer ha ripreso da 
Sospensione.

Non è possibile copiare un 
file da/verso un dispositivo 
Bluetooth connesso.

Il trasferimento di dati tra il computer e un dispositivo Bluetooth è supportato solo in una direzione (il 
trasferimento dati simultaneo non è supportato). Se si sta copiando un file dal computer a un 
dispositivo Bluetooth, non sarà possibile copiare un file dal dispositivo Bluetooth al computer finché il 
processo di trasferimento che parte dal computer non è terminato.

I file video catturati dalla 
Camera PC prendono 
troppo spazio sul disco.

Nota catturare file di video ad altra risoluzione molto spazio disco disponibile per ogni file.

Nota Window Vista richiede un minimo di 15GB di spazio disco libero sulla partizione del disco C:. Si 
consiglia di salvare la cattura del file video in un'ubicazione diversa dal disco C:, limitare la dimensione 
del file del video catturato o ridurne la risoluzione (Options/Opzioni > Video Capture Pin... > 
Dimensioni output). Vedere “Riduzione delle dimensioni dei file video” a pagina 203.
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Specifiche tecniche

Funzionalità Specifiche tecniche

Tipi di 
processore

Processore Intel Core 2 Duo 
478 pin Micro-FCPGA package
T8100/ T8300

(45nm) tecnologia di processo a 45 nm
Cache L2 da 3MB & FSB a 800MHz 
- 2,1/ 2,4 GHz

Processore Intel Core 2 Duo  
478 pin Micro-FCPGA package
T9300/ T9500

(45nm) tecnologia di processo a 45 nm
Cache L2 da 6MB & FSB a 800MHz 
- 2,5/ 2,6 GHz

Processore Intel Core 2 Duo  
478 pin Micro-FCPGA package
T7100/ T7250

(65nm) tecnologia di processo a 65 nm
Cache L2 da 2MB & FSB a 800MHz 
- 1,8/ 2,0 GHz

Processore Intel Core 2 Duo  
478 pin Micro-FCPGA package
T7300/ T7500/ T7700/ T7800

(65nm) tecnologia di processo a 65 nm
Cache L2 da 4MB & FSB a 800MHz 
- 2,0/ 2,2/ 2,4/ 2,6 GHz

Ultimi aggiornamenti delle specifiche tecniche

Le specifiche tecniche elencate in questa appendice sono corrette al momento di andare in stampa. Alcuni elementi (in particolare
tipi di processore e velocità) possono essere modificati o aggiornati causa la programmazione del produttore. Per dettagli rivol-
gersi al proprio centro di assistenza.
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Processore Intel Celeron M  
478 pin Micro-FCPGA package
530/ 540/ 550/ 560

(65nm) tecnologia di processo a 65 nm
Cache L2 da 1MB & FSB a 533MHz 
- 1,73/ 1,86/ 2,0/ 2,13 GHz

Logica del 
core

Modelli A & B
Chipset SiS M672 + SiS968

Modelli C & D
Chipset SiS M671DX + SiS968

Opzioni di 
LCD

Modelli A & C
Schermo piatto TFT tipo Glare, 14,1" - WXGA / WXGA+

Modelli B & D
Schermo piatto TFT tipo Glare, 15,4" - WXGA / 
WXGA+ / WSXGA+

Visualizza-
zione

Modelli A & B
SiS M672 video integrato (interno sul chip)

Acceleratore grafico 2D / 3D ad alte prestazioni
Architettura di memoria condivisa (fino a 256MB di 
memoria video condivisa, assegnata 
dinamicamente dalla memoria del sistema quando 
necessario)
Supporto per DirectX 9
Supporto per  Vertex Shader 2.0 & Pixel Shader 2.0

Modelli C & D
NVIDIA GeForce 9300M GS video discreto (esterno 
su scheda)

256MB GDDR2 Video RAM On Board
TurboCache™ con supporto per memoria grafica 
totale fino a 512MB (a seconda della memoria di 
sistema)
Supporto per DirectX 10

Memoria Due prese SODIMM 200 pin, dotata di supporto per la memoria DDRII (DDR2) 667
Memoria espandibile fino a 4GB

Sicurezza Slot blocco di sicurezza (tipo Kensington®)
Modulo lettore d’impronte digitali (opzione di fabbrica - 
Modelli C & D)

Password del BIOS

BIOS Phoenix BIOS (SPI Flash ROM da 8Mb)

Funzionalità Specifiche tecniche
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Periferiche di 
memorizza-
zione

Una unità di tipo ottico (CD/DVD) da 12,7 mm (altezza) - vedere “Opzioni” a pagina 210 per le opzioni dell'unità
Un disco rigido SATA facilmente sostituibile da 2,5" di 9,5 mm (altezza)

Audio Interfaccia conforme Intel High Definition Audio
Conforme a Microsoft UAA (Universal Audio 
Architecture) 
Compatibile con Direct Sound 3D

Emissione digitale S/PDIF
2 altoparlanti incorporati 
Microfono incorporato

Tastiera Tastiera "Win Key" 

Periferica di 
puntamento TouchPad incorporato (funzionalità tasto di scorrimento integrata)

Interfaccia Tre porte USB 2.0
Un jack uscita delle cuffie
Un jack ingresso del microfono
Un jack uscita S/PDIF

Un jack RJ-11 per modem
Un jack RJ-45 per LAN
Un jack di ingresso CC
Una porta per monitor esterno

Lettore di 
schede

Modulo lettore di schede 7-in-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Schede MS Duo/ Mini SD/ RS MMC richiedono PC adattatore

Slot 
ExpressCard Slot ExpressCard/54(34)

Funzionalità Specifiche tecniche
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Italiano
Comunica-
zione

*Nota: i moduli
opzionali Blueto-
oth e 3.5G non
possono coesiste-
re. Se nell'opzio-
ne di acquisto è
presente una del-
le due opzioni di
fabbrica, l'altra
non è disponibi-
le.

Fax/Modem Plug & Play da 56K conforme V.90 & V.92 
LAN 10Mb/100Mb Ethernet
Modulo WLAN USB 802.11b/g (opzione)
Modulo di camera PC USB da 1,3M o 2,0 M pixel (opzione di fabbrica)
*Modulo Bluetooth 2.0 + EDR USB (opzione di fabbrica)
O
*Modulo 3.5G basato su UMTS/HSPDA con interfaccia Mini Card 
(opzione di fabbrica)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Risparmio 
energia Supporta ACPI v3.0 

Alimentazione Modelli A & B
Adattatore CA/CC a pieno campo
Ingresso CA: 100-240V, 50-60Hz
Uscita CC: 19V, 3,42A o 18,5V, 3,5A (65W)

Modelli C & D
Adattatore CA/CC a pieno campo
Ingresso CA: 100-240V, 50-60Hz
Uscita CC: 19V, 4,74A (90W)

Pacco batteria Smart agli ioni di Litio a 6 celle, 4000mAH o 4400mAH
Pacco batteria Smart agli ioni di Litio a 9 celle, 7200mAH (opzione)

Requisiti 
ambientali

Temperatura
In esercizio: 5°C - 35°C 
Non in esercizio: -20°C - 60°C

Umidità relativa
In esercizio: 20% - 80%
Non in esercizio: 10% - 90%

Funzionalità Specifiche tecniche

Modalità UMTS

Si noti che NON È POSSIBILE
utilizzare le modalità UMTS in
Nord America.
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Dimensioni 
fisiche & Peso

Modelli A & C
336 (larghezza) x 250 (profondità) x 24,8 - 35,7  
(altezza) mm (min)
2,2 kg con batteria da 6 celle 

Modelli B & D
359 (larghezza) x 268 (profondità) x 24,8 - 37 
(altezza) mm (min)
2,5 kg con batteria da 6 celle 

Opzioni

*Nota: i moduli
opzionali Blueto-
oth e 3.5G non
possono coesiste-
re. Se nell'opzio-
ne di acquisto è
presente una del-
le due opzioni di
fabbrica, l'altra
non è disponibi-
le.

Opzioni modulo unità ottica:
Unità Combo 
Unità DVD-Dual (Super Multi) 

Pacco batteria Smart agli ioni di Litio a 9 celle, 
7200mAH

Modulo WLAN USB 802.11b/g

Modulo di camera PC USB da 1,3M o 2,0 M pixel 
(opzione di fabbrica)

Modulo lettore d’impronte digitali (opzione di fabbrica - 
Modelli C & D)

*Modulo Bluetooth 2.0 + EDR USB (opzione di 
fabbrica)
O
*Modulo 3.5G basato su UMTS/HSPDA con interfac-
cia Mini Card (opzione di fabbrica)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 
MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Funzionalità Specifiche tecniche

Modalità UMTS

Si noti che NON È POSSIBILE utilizzare le
modalità UMTS in Nord America.
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